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If you’ve been photographing digitally for any length of time, you have prob-
ably been seduced by the easy way you can continue pressing the shutter
release and seeing your work pop up on your camera’s view screen. All goes
well as you download memory card after memory card into your computer.
After a number of months or even years go by, your hard drive fills up, and it
becomes harder and harder to find a particular image that you are looking for.
You spend more and more time in front of the computer monitor first look-
ing for your images, then selecting them, and finally processing them. Your
workflow gets more and more complex with additional pieces of software that
you have to add in. First you have to use one piece of software to choose your
favorites and mark them somehow. Then you have to open each one in
Photoshop or Photoshop Elements to make small adjustments before you can
show them to your clients (if you are a professional photographer) or your
family and friends (if your photography is done simply for pleasure). Each
time you go through this process, you generate more copies of
your images in various sizes and formats. These copies are float-
ing around all over your hard drive. Now you have to do the final
adjustments on the images and create still more copies, either to
have prints made or to make the prints yourself. Every step seems
to take longer each time you do it. It is turning into a real mess.

Don’t be discouraged! Adobe comes to your rescue with
Photoshop Lightroom. It is one of the first of a new generation
of workflow applications designed to help you find and process
your images quickly and efficiently. With Lightroom and this
book, you will be able to spend much less time in front of your
computer, protect your images by storing them in an organized
manner, and produce the images you need for showing, for
slideshows, for Web sites, and for easy printing.

Introduction



Introduction xiii

Here are some of the things that Adobe Photoshop Lightroom can do for you:

■ Help you to import your images from your camera or media card.

■ Import images that you have already taken and have on your computer.

■ Utilize your existing file structure or create a new one automatically.

■ Organize images by folder.

■ Add keywords (or tags), as well as copyright and other metadata information
as you import your images.

■ Add keywords later to enable you to easily find an image, even among many
thousands.

■ Sort images into five categories to select your favorites.

■ Build collections of images to make it easier to find them later.

■ Adjust the colors, white balance, exposure, brightness, saturation, tonal curve,
and many more things to make your images look their best.



■ Recover lost detail in highlights and shadows.

■ Work with raw images from most camera formats, JPEGs, and TIFFs.

■ Crop and straighten your images in standard and custom manners.

■ Do dust spotting and simple cloning of artifacts with the Remove Spots tool.

■ Remove red-eye with the Red Eye tool.

■ Copy settings from one image and paste into another image or group of
images.

■ Work on the metadata.

■ Sharpen your images.

■ Remove the noise from images.

■ Make lens corrections, such as reducing fringing and vignetting.

■ Easily create black-and-white images from your color originals with a large
amount of tonal control.

■ Leave your original images untouched so it is always easy to start over.

■ Calibrate images imported into Lightroom, based on the camera type.

■ Make and export slideshows.

■ Utilize a very powerful print module designed to quickly print your images
the way you want them.

■ Export images to an external image editor, such as Photoshop, when you need
to do detailed image processing, and then automatically import the retouched
image back into Lightroom.

■ Produce Web galleries with a wide variety of customization options.

■ Export your finished images in various color spaces (Adobe 1998, sRGB, or
ProPhoto) and formats (JPEG, PSD, TIFF, or DNG).

This book is designed for photographers who want to spend less time processing
their images and more time photographing. Originally, Adobe developed this soft-
ware for professional photographers who do a high volume of work, but now semi-
pro and amateur photographers also can benefit from this software. The software
caters to those with a wide range of experience and skill. All you need is a desire
to do things faster and easier and the willingness to learn a new way of working
that is more efficient and more fun.
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Throughout this book, the figures and screen shots are taken from the Macintosh
version of Lightroom. The behavior, function, and look should be similar on a PC
computer. The key commands that differ between the two systems are the fol-
lowing: 

■ Alt key on PC = Option key on Mac

■ Control (Ctrl) key on PC = Command (Cmd or Open Apple) key on Mac 

How to Use This Book
Adobe Photoshop Lightroom is a very intuitive program. You will often be able
to figure out what to do by simply looking at the menus and trying things out.
Although some might prefer it, you don’t need to start at the beginning of this
book and read it from cover to cover. Instead, you can use the detailed Table of
Contents or the Index to find what you need and read each section as you need it
to figure something out. The book is broken down into chapters that correspond
to the various sections of the software to make it fast and easy to find answers to
your questions as a problem pops up. 

And now on with the book! Good luck with your journey. Feel free to contact me
at www.johngblair.com if you have any questions or suggestions along the way.

www.johngblair.com




The first question to answer is whether Adobe Photoshop Lightroom will work
for you. No piece of software will be a perfect fit, and Adobe Lightroom is no
exception. No matter what kind of photographer you are, you will wish that it
had just “one more feature” in it. Not every application or workflow will work for
every photographer. If you have been working in digital photography for any
length of time, you will find that you will have to make changes in your current
workflow both to accommodate Lightroom’s new features as well as to work
around its limitations. In the long run, for most photographers, this effort will
have a big payoff.

To help you decide if Lightroom will be a good fit for the way you like to work,
look at the following two lists and see which list applies to you. Neither list will
exactly describe you, but the more things that apply in one list than the other, 
the more likely you are to have a good idea about your satisfaction with the
“Lightroom experience.”

1
Is Lightroom
Right for You?



The more the following factors apply to you, the more it will mean that you are
likely to have a positive experience with Lightroom:

■ You use a digital SLR to create your images.

■ You tend to create a number of images at one time.

■ You photograph in raw format.

■ You own a fairly recent computer [Mac: G4, G5, or Intel Core, Mac Pro, Mac
Book, Mac Book Pro, older Macs upgraded to a G4 or better processor
(although they may tend to be slow especially with larger libraries); PC:
Pentium 4 processor].

■ You have plenty of RAM memory in your computer (768 MB or more).

■ You are running a current operating system (Mac: 10.4.0 or higher; 
PC: Windows XP SP2 or better).

■ You have plenty of hard drive space (1 GB or more).

■ You have a monitor with a screen resolution of 1024 x 768 or greater.

■ You want to spend less time in front of the computer and more time behind
the camera.
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You can easily handle large
numbers of images with Adobe
Photoshop Lightroom tools.



■ Most of your images need just a little adjustment in Photoshop.

■ You find that most of the time you rarely need all of the power of Photoshop.

■ You create a lot of digital black-and-white images and don’t always like the
results you get.

■ Your workflow is flexible, and you change it from time to time as you find
better ways of doing things.

■ You need a better way to keep track of your images than the folder and sub-
folder technique you are using now.

■ It sometimes seems to take forever to find that image you are looking for.

■ You need to create Web galleries to show your clients.

■ You use digital slide presentations to show your work.

■ You do your own printing.

■ You are an adaptable person and can learn new and faster ways of doing
things, even if it takes a bit of time to get used to them.

■ You would prefer to use a single piece of software for most of your work 
if you can.
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With Adobe Photoshop
Lightroom, you can create
black-and-white images with 
a lot of tonal control and see
before and after views.



If a number of the following factors apply to you, then you may not find Lightroom
as useful:

■ You shoot on film and scan just a few of your best images, basically editing
before scanning.

■ You usually only create a couple of images at a time.

■ You primarily photograph in JPEG format.

■ You have an older computer (Mac: G3 or G3 iBook; PC: Pentium 3 or earlier).*

■ You are using older system software (Mac: 10.3 or earlier; PC: Windows 2000
or earlier) and don’t want to upgrade.*

■ You have less than 768 MB of RAM memory.*

■ You have less than 1 GB of space left on your hard drive.*

■ You love working on the computer and would rather do that than go out and
photograph more with your camera.

■ You love working in Photoshop and enjoy its challenges.

■ Your images are heavily retouched and adjusted in Photoshop, and you spend
hours working on a single image.

■ You create really large images, such as panoramas, that have a long dimension
greater than 10,000 pixels.*

■ You use lots of plug-ins and special effects filters in Photoshop on many 
of your images.

■ You like the workflow that you have set up and rarely want to change it very
much.

■ The folder and subfolder technique works just fine for you to be able to find
your images.

■ You can quickly find any image in your collection.

■ You don’t create Web galleries for your clients and have no plans to do so.

■ You rarely need to put together a digital slide presentation.

■ You rarely print your own work.

■ You are pretty much set in your ways and don’t enjoy change.

■ You like using three or four or even more different pieces of software to 
complete your image workflow, and you can keep up with their changes as
you upgrade.

* Note that if any factors marked with an asterisk (*) apply to your situation,
Adobe Photoshop Lightroom will not work for you at all.
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Generally, the more powerful and faster your computer, the better experience you
will have. Although Lightroom was created to be as “lightweight” as possible, all
of the computing it does creates a load on your computer. It is much better to
have your computer doing all of the work instead of you, of course.
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Lightroom allows you to create nice looking Web galleries to promote yourself on your Web site or to show your clients.





Workflow, or “work slow” as some photographers have started to call it, has
become a concern as digital photographers create more and more images and the
images get larger. Several companies decided to try to solve these problems for
photographers with a software application that would allow quick selection of
images, fast correction of basic tonal qualities, and export to various retouching
programs if needed. Because this area is so new and because photographers have
developed such a hodgepodge of different workflows, Adobe decided to publicly
test an early version of the program in their beta release. In software terminology,
alpha testing is done by a small group of users as the program is developed to give
the software engineers feedback on the feature set of their software. Once this
alpha test is done and the feature set is pretty much completed, a beta release is
done to a larger group to test for bugs or problems under a wide variety of differ-
ent computers and operating styles. In the case of Adobe Photoshop Lightroom,
the first beta release was really not feature-complete, so it was more like a wide-
release alpha test. In any case, it was a gutsy move on the part of Adobe to put
their baby out there freely for user comment and feedback when it really wasn’t
complete yet. As a result of all of this feedback, Adobe made major changes to
what the software could do and how it was displayed before version 1.0 even came
out. Lightroom has a very complete feature set, especially for the first released version
of a new type of software. Adobe is already planning enhancements for version 2.

2
Background



The actual beginning of Lightroom occurred in October 2002 when Mark
Hamburg, formerly part of Adobe’s Photoshop engineering team, put together a
simple and fun little application called PixelToy. He had been working in Adobe’s
Digital Media Lab exploring the development of new tools for digital photogra-
phers. Within a few months, a number of people gave Mark suggestions on what
to include and what to change in PixelToy, including Thomas Knoll, the original
developer of Photoshop, and Jeff Schewe, a well-known commercial photographer
who often works closely with Adobe on photography-related projects. There were
also familiar names like Troy and Melissa Gaul, Grace Kim, Andrei Herasimchuk,
George Jardin, Phil Clevenger, and many more involved on the Adobe side to cre-
ate this application. Take a look at Lightroom’s splash page for a more complete
list. This lead to the creation of Shadowland, the code name for the project to
develop what became known as Adobe Photoshop Lightroom.

On January 9, 2006, Lightroom was announced to the world and its first public
software beta release, Adobe Lightroom Beta 1, was sent out into the world to
gather feedback to help the development team make the software as useful as pos-
sible. At first, it was just available for Macintosh computers. Eventually, there would
be three more beta releases, and a Windows-compatible version came out with
Beta 3. There was also a group of dedicated alpha testers working with Adobe behind
the scenes with photographers such as John Beardsworth, Michael Tapes, Kyoe

Adobe Photoshop Lightroom: Photographers’ Guide8

This is how the Library
Module of Lightroom 
looked in the Beta 1 version.



Nagel, Meeno Peluce, John Hollenberg, Uwe Steinmueller, Dan Sroka, Karl Lang,
Seth Resnick, Andrew Rodney, Jeff Schewe, Peter Krogh, Jerry Courvoisier, Katrin
Eismann, Bob Rose, and Martin Evening, among others, taking part in the dis-
cussions. This entire process took nearly a year from the time the first beta version
was publicly released to bring Adobe Photoshop Lightroom to the version 1.0 it
is today.

The program increased in size as engineers added even more features. Lightroom
Beta 1 began as a program only 10.1 MB in size. Beta 2 was 14.6 MB. Beta 3 was
22.2 MB. Beta 4 was about 35 MB. The pre-release of version 1.0 was 44.8 MB
(Mac versions). Users are clamoring for still more features, so Lightroom will con-
tinue to grow in the future.

The basic idea that a professional software application could be designed for use
by photographers to speed up their workflow substantially was proven with the
introduction of the first beta release of Adobe Lightroom. Later revisions refined
that concept to make it even more powerful. Already there is talk about what did
not make it into version 1.0 and will need to be added and improved upon in ver-
sion 2.0. This is an exciting time to be a photographer.
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Not too much change in the
look of the Library Module 
in the Beta 2 version.
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Lots of changes are shown 
here in the Beta 3 version.

This is how Lightroom 
looked in the first of several
Beta 4 versions.
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The entire look and many features of Lightroom were changed by the time version 1.0 was released more than a year after Beta 1
came out.





3
Workflow Design

What Is a Workflow?
This is a key part of understanding the purpose of Adobe Photoshop Lightroom.
It is not just a program to fine-tune the exposure of your images. It is designed to
handle all aspects of your images after they are created. Your workflow is every-
thing that you do to your image from the time you have pressed the shutter until
you have delivered the image in its final form. It seems like each photographer has
his own way of doing things, as everyone struggles to find the optimal way to get
from here to there (see Figure 3.1).

Figure 3.1

Typical file folder structure 
for a wedding and portrait
photographer.
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A typical workflow might involve the following:

■ Downloading the images from the camera into the computer.

■ Using Photoshop or Photoshop Elements to rename the images (see Figure 3.2).

■ Backing up a copy of the images onto a CD or DVD.

■ Setting up a file folder structure such as year/client/date.

■ Using Photoshop or a similar program to quickly scan through the images
and identify the best ones.

■ Creating a new copy of the best ones so the originals will not be affected by
changes.

■ Adjusting levels, curves, brightness, contrast, and other items for each image
individually in Photoshop.

■ Using actions to make smaller copies of the images (proofs).

■ Setting up a new folder for these smaller proof copies.

■ Using the smaller proof copies to make contact sheets, a slideshow, or a Web
gallery to show clients or friends.

Figure 3.2

Renaming the images in 
the Browser in Photoshop.



■ Once the favorite images are chosen, using Photoshop at 100 percent on the
original images to clone out dust spots (dust on the sensor) or hot pixels
(bright red or green dots).

■ Fine-tuning the adjustments with Photoshop (see Figure 3.3).

■ Doing any major retouching if needed.

■ Saving a copy with all of the layers available (often in PSD format).

■ Assigning keywords to the image.

■ Filling in the metadata (items such as photographer’s name and contact infor-
mation).

■ Flattening all of the layers and producing the final copy to send to the client
or prepare for sending them electronically.

■ Repeating for all images going to the client.

■ Burning a CD or DVD with the images.
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Figure 3.3

Using curves in Photoshop 
to adjust an image.
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How Adobe Lightroom Works
Lightroom is different from programs that are designed to do one or two things.
It attempts to do most of the tasks that photographers need to perform on their
images—a complete workflow. It uses a series of modules including Library,
Develop, Slideshow, Print, and Web (see Figure 3.4). Instead of using many pro-
grams, with each doing one thing, Lightroom attempts to do everything but pixel
editing. This includes organizing your images, sorting them, cataloging them,
adjusting them until they look their best, sending them out to Photoshop if
detailed retouching is needed, preparing slideshows, preparing Web galleries, and
printing directly to your printer.

There are several key differences in the way that Lightroom operates compared to
a program such as Photoshop. The first is that it uses non-destructive editing. It
never touches your original image file. The next is that it incorporates a database
system. This means that images must be imported or referenced in the form of
folders before anything can be done with them. Another feature is the ability to
organize groups of images into collections to make it easier to work on groups
throughout the program. In addition, you don’t save images, you export them in
Lightroom. You can have multiple libraries with Lightroom as well. These features
are described in more detail below.

Non-Destructive Editing
Lightroom uses non-destructive editing. This is a key difference to understand. A
program such as Photoshop (pixel editor) makes adjustments to the individual
pixels. Once the image is saved or closed, there is often no going back to the orig-
inal. In Lightroom (metadata editor), changes to the image are stored as instruc-
tions, called metadata. The original image is always left untouched and a set of
instructions is saved in the internal database. These instructions are applied on
output to a copy of your original to create the final image. You can also have the
program save these instructions as a “sidecar,” or XMP file. This file will have the
same name as the original, except for ending in .xmp, instead of one of the raw
file formats. Sidecars are used only for the raw files. The metadata is stored within
the image file for JPG, TIFF, and PSD images. The sidecar file only contains the
instructions and not the image itself, so the extra file is very small. This is impor-
tant to remember if you decide to move any of your images around outside of
Lightroom. You have to move both files and not just the image file. At any time,
you can undo the changes you made in Lightroom and start over (see Figure 3.5).

Figure 3.4

The top header shows the
various steps in the workflow.



Multiple Libraries
You can set up separate libraries in Lightroom (see Figure 3.6). Why would you
want to do this? You might want to do it for organizational purposes. Or, if you
have a large number of images, you might want to keep different groupings on
different disks. For example, you could set up a library for your wedding photog-
raphy, another one for your portraits, and another one for a school contract that
you have. That way you don’t have to worry about outgrowing your hard drive
space. It is easy to set up additional libraries.

To set up a new library, quit the program. On the main hard drive, go to the user
(for example, johnblair)/Pictures folder and change the name of your existing
Lightroom library. You can also find the Pictures folder by opening a new Finder
window and clicking on Pictures on the left side. You can even move the library
to another drive if you would like. If you want to open your old library or create
a new one, first quit the program. Press the Option key (Alt key for PC), and then
launch the program. A dialog box will pop up for you to navigate through your
folders and find your old library, or you can click on the Create New Database
box. You can name the library something like Lightroom-Weddings, Lightroom-
Portraits, or Lightroom-Stock. When you set up a new library, it will be located
in your user/Picture folder. After it is set up, it can be moved anywhere.
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Figure 3.5

All of these changes to 
the image, including the
conversion to grayscale 
(black and white), can easily
be undone at any time by
moving the sliders back.
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Figure 3.6

You can set up different
libraries in Adobe Lightroom.

Folders (Formerly Called “Shoots”)
Lightroom acts as a database for your images. Unlike Photoshop in which you can
access any image on your hard drive through the Browser or Bridge, before 
you can do anything with an image in Lightroom, you must import it. When you
import an image, it makes a set of preview images in various sizes and stores those.
This process can take a little bit of time. Once your images
have all been imported, Lightroom will operate very
quickly because it does not have to render a preview image
on the fly. You can also choose to import images without
making the previews, which will speed up importing but
slow down the operation of the program. If you used the
public beta of Lightroom that Adobe released, you used
the concept of shoots to organize your images in
Lightroom. Now with the release of version 1, the shoots
concept has been replaced by popular request with a folder
organizational system. It is very similar to shoots, except
more flexible.

You can set up folders individually by clicking on the plus
(+) sign on the Folders bar. You can organize it any way
that you like, including multiple levels of folders, as shown
in Figure 3.7. You can also let Lightroom organize your

Figure 3.7

Adobe Lightroom imports your images into different folders
that you can set up during import.



images and set up your folders based on how you have your folders organized
before you import from them. Set up a test library first so that you can see how
Lightroom will import your folders.

Experiment with a small grouping of images and folders before you jump in. Make
sure your collection will import the way that you want it to.

Collections
Collections are another new concept in Lightroom (see Figure 3.8). Collections
make it easier to find a group of images to work on them. Each image is in only
one folder, but it can be in as many collections as you would like. You could set
up a collection of your favorite images so that you can easily print a portfolio. You
can gather a bunch of images from different folders for a slideshow or to make a
Web gallery. You could use separate collections to
gather images from a wedding, such as the bride get-
ting ready, the groom getting ready, the ceremony,
the formals, the reception, and so on. It will be eas-
ier to gather the images for the wedding album using
collections. Or if you are photographing a number
of corporate executives, you could set up a collection
for that client and a subcollection for each executive.
That way you could print a separate contact sheet or
prepare a separate Web gallery for each executive.

Saving/Exporting Images
Photographers first using Lightroom are often confused when they try to save an
image. They are used to seeing Save or Save As in Photoshop and many other pro-
grams. In Lightroom, you export images instead of saving them. Click on File >
Export. You get your choice of image formats and can navigate to the location that
you want the image to go to (see Figure 3.9).
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Figure 3.8

You can create Collections of images to assist in processing or
preparing output of various kinds.

Figure 3.9

You need to export images to the location that you want.



When you open the Export function, you will see the
File Naming box (see Figure 3.10). If you click on the
small arrows on the right, you will be able to choose
from a group of different templates that are built in:
Custom Name (x of y), Custom Name—Original File
Number, Custom Name—Sequence, Custom Name,
Date—Filename, Filename—Sequence, and Filename. You can type in a custom
name or have Lightroom automatically name your images. See Figure 3.11 for
examples of some of the file naming options.

Each of these templates can be edited with the Filename Template Editor (see
Figure 3.12), or you can create new ones based on an existing template. In the
Filename Template Editor, each menu box has a number of choices for tokens,
which can be added to the naming script. Some of them include the Filename
number as a suffix. Another is using the Folder name as part of the naming
sequence. There are various options with sequence numbering and various ways
to use the date as part of the file name. There are a number of options of using
the EXIF data from the camera. See Figure 3.13 for those options. Finally, 
custom text can be used as a token as part of the export file naming process.
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Figure 3.10

File Naming section in the Export function.

Figure 3.11

Listing of Export Templates in the File Naming box.
Figure 3.12

The Filename Template Editor can be used to
edit existing templates or to create new ones.



Next, you can select from four different file formats (JPEG, PSD, TIFF, and
DNG) when you export (see Figure 3.14). Once you select the file format, you
will have a few other options, depending on the format you selected. With JPEG,
you have a choice of quality from 0 to 100. The higher the quality, the larger the
resulting size of the compressed file. PSD and DNG do not give you additional
file setting options. With TIFF, you can select no compression, LZW lossless com-
pression, or ZIP compression. The LZW file compression is not supported by all
software programs, so be sure to check if you are planning to open your TIFF-
LZW images in a particular program. Changing the file format will also affect the
next box down, called Image Settings (see Figure 3.15).
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Figure 3.13

The EXIF data from the camera can be used 
as part of the file naming process on export.

Figure 3.14

Select the file format that the image will be exported in. 
You can choose JPEG, PSD, TIFF, or DNG.

Figure 3.15

Image settings available for exported files.



Under Color Space, the sRGB format is used for the
Web, as well as by some photo labs to make digital
prints (see Figure 3.16). AdobeRGB (1998) is the stan-
dard used for many commercial applications. Finally,
ProPhoto RGB is a very wide gamut color space used
in Lightroom. It is important to select your file format
based on what the photographs will be used for.

You'll find that 8-bit files are half the size of 16-
bit files and are used for many common purposes
(see Figure 3.17). Usually, you will choose 8-bit if
you are sending your image file to a client, unless
they specify 16-bit. You will also use 8-bit for the
Web and to send your images to be printed at a
lab. Use 16-bit if you will be working on your
image in Photoshop or if you will be saving your
image for future use. The 16-bit will allow more
manipulation of the image with fewer artifacts.

You will also specify the resolution (300 pixels per inch is the default). It can be
changed to metric if desired. When exporting, the image can be enlarged or
reduced by checking the Constrain Maximum Size box, specifying the units 
(pixels, inches, or centimeters), and then giving a size in the Width and Height
boxes (see Figure 3.17). Usually, both boxes are given the same value. That way,
you can export both horizontal and vertical images at one time. As an example, 
if you are exporting horizontal and vertical 8×10s, fill in both height and width
as 10 inches, since you are setting a maximum value. The images will automati-
cally be enlarged or reduced as necessary to make that happen. Obviously, you
have to crop the images to the proper aspect ratio in the Develop Module.

After exporting, you can have the program show you where it put the file, burn
the exported images to a disc, or open them in your chosen image retouching pro-
gram (for example, Photoshop CS in Figure 3.18). It will also take you to the
Export Actions folder if you want to see which actions you have set up. This is all
done in the Post-Processing section.
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Figure 3.17

You can specify that the image be exported with 8 or 16 bits.

Figure 3.16

You will need to specify which color space you want to export
your image in.

Figure 3.18

Post-Processing section.



Raw Format
Lightroom is really designed to pull the most from your images shot in raw for-
mat. Raw format is the basic unprocessed data from your image sensor. All of the
camera settings that you made, such as white balance or color space, are saved
along with the image data, but that information has not been applied by the cam-
era’s built-in image-processing computer. It can be a long and tedious process to
convert raw images individually. Lightroom allows you to do one setting and apply
it to all images or adjust each one as you would like. The underlying raw file is
not touched (see Figure 3.19). 

Each camera manufacturer has developed its own proprietary raw file format. That
is why you see so many different names, such as NEF or RAF. Different cameras
from the same manufacturer may have different raw file formats, even if they are
named the same. This can all be very confusing, but don’t worry—Lightroom will
handle the details for you. It is not unusual for a new camera to have a new 
format. Since the files are proprietary, after a new file comes out, Adobe must often
reverse-engineer the format to make a conversion available. If you have a camera
that has just come out, go to Adobe.com and check if Lightroom has begun to
support the format.
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Figure 3.19

In the Develop Module, you
can see the results of your
image processing when you tell
Lightroom to show you before
and after images, as shown
here in this group portrait of
firefighters.
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If you shoot in raw format, you have the most available information or latitude
to make corrections and changes to your images. But Lightroom can work equally
well on images in other formats, such as DNG (Adobe’s Digital Negative raw for-
mat), JPEG, TIFF, and others. It is likely that you will be able to use Lightroom
no matter what format you have captured your images in, as well as to import your
photo archive.

Sample Workflows
It seems like nearly every photographer has a different workflow. Although there
are certain common themes, such as downloading, processing, storage, and out-
put, there are lots of different ways to accomplish those tasks. To help photogra-
phers who are just getting into digital photography or for those who are unhappy
with their current workflows, a series of different possible workflows are presented
below. There is no right or wrong way to do it. If you are happy with your cur-
rent workflow, then you can skip this section. However, you might find something
useful that you hadn’t thought of before. You could make your workflow even
more efficient than the presented examples and do nearly everything in
Lightroom. The workflows presented add an extra layer of protection against total
loss of your precious images. 

In any workflow, make sure to consider the following:

■ Download images with a card reader to protect your camera.

■ Rename your images to make them easier to find.

■ Back up copies of your images before erasing your media cards, and make sure
you have several backups on different kinds of media. Also make sure one of
your backup copies is kept offsite in case of fire, burglary, or natural disaster.

■ Reformat your media cards in your camera, not in your computer. This helps
prevent corruption of the media card file system.

■ Output your final images and save a copy of them on a backup medium such
as a CD, DVD, or a second hard drive.

■ Back up your Lightroom library on a regular basis.

■ Although Lightroom has been extensively tested, remember it is still version
1.0 software and may occasionally act in unpredictable ways. So back up!



Wedding Photographer
Here is a sample workflow for a wedding photographer.

■ Set up a folder organization on your hard drive:

❍ Weddings

■ Wedding Client 1

❍ Engagement Session

■ Originals

■ Print Orders

❍ Bridal Session

■ Originals

■ Print Orders

❍ Wedding

■ Originals

■ Album Images

■ Print Orders

■ Wedding Client 2

■ Etc.

■ Create a new folder for new wedding client. Include subfolders.

■ Download images from shoot onto hard drive (into Originals folder)
using a card reader.

■ Use Photoshop Browser or similar program to batch rename images.

■ Back up two copies onto archival gold DVDs:

❍ Copy 1 goes into client folder.

❍ Copy 2 goes offsite.

■ Back up one copy of originals onto second hard drive.

■ Reformat memory cards in camera so they are ready to use again.

■ Import images into Lightroom. Apply appropriate metadata, such as
creator and copyright information.
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■ In the Library Module, go through and delete the blinks (mistakes and bad
images). Use the Command and Delete keys to delete the images, or just the
Delete key to remove them from the library. Or, instead, you can just flag
them with the Reject flag. You can always re-import them from your Originals
folder if you need to for some reason. At the same time, using the number
keys rate the images:

❍ 5 = suggested for album.

❍ 4 = show to client for possible inclusion in album.

❍ blank = duplicates or not the best of the similar images.

■ Use Quick Develop to adjust exposure, brightness, contrast, and saturation
to taste.

■ Go into Develop, if needed, for some more detailed adjustments (such as fill
light).

■ Crop if necessary.

■ Convert to grayscale (black and white), if desired.

■ Repeat for all images.

■ In Library > Filters > Rating > Only, set to 5 and create a collection entitled
Client Album Images.

■ Repeat for Rating > Only 4, and create a collection entitled Client Additional
Images.

■ Prepare output to show client:

❍ If you show a slideshow, prepare a slideshow of each collection 
(recommended).

❍ If you show images on the Web, create a Web gallery from each 
collection.

■ Show the client the images you recommend for the album in a slideshow.

■ Show them the Additional Images slideshow.

■ Change to the Library Module and move all of the modules out of the way
so that you get a full-screen image. Go through the Additional Images 
collection one by one with your clients to see if they want to add any of those
images to the album. 

■ Change the rating from 4 to 5 on any images they want to add by using the
number 5 key.

■ In the Library Module, set Filter on 5 > Only and click on the folder of the
client’s wedding.
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■ Go through all of these images one by one. These are the images that are going
to be in their album. If there are any images that they don’t want in their
album, use the zero key to deselect them.

■ If you would like a record of their choices, print a contact sheet.

■ Check each image in the Develop Module to see if any images need fine-tuning.
Export to Photoshop for any retouching needed on individual images.

■ Export or print the images.

■ Back up the Lightroom Library.

Portrait Photographer
Here is a sample workflow for a portrait photographer:

■ Set up a folder organization on your hard drive:

❍ Portraits

■ Portrait Client 1

❍ Originals

❍ Print Orders

■ Portrait Client 2

■ Etc.

■ Create a new folder for new portrait client. Include subfolders.

■ Download images from folder onto hard drive (into Originals folder) 
using a card reader.

■ Use Photoshop Browser or similar program to batch rename images.

■ Back up two copies onto archival gold CDs or DVDs:

❍ Copy 1 goes into client folder. 

❍ Copy 2 goes offsite.

■ Back up one copy of originals onto second hard drive.

■ Reformat memory cards in camera so they are ready to use again.

■ Import images into Lightroom. Apply appropriate metadata, such as creator
and copyright information.
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■ In the Library Module, go through and delete the blinks. Use the Command
and Delete keys to delete the image, or just the Delete key to remove from
the library. Or, instead you can use the Reject flag to reject them. You can
always re-import them from your Originals folder if you need to for some 
reason. At the same time, using the number keys, rate the images:

❍ 5 = suggested for client.

❍ 4 = suggested for other groupings if there are multiple people involved.

❍ blank = duplicates or not the best of the similar images.

■ Use Quick Develop to adjust exposure, brightness, contrast, and saturation
to taste.

■ Go into Develop, if needed, for some more detailed adjustments (such as fill
light).

■ Crop if necessary.

■ Convert to grayscale (black and white), if desired.

■ Repeat for all images.

■ In Library > Filters > Rating > Only, set to 5 and create a collection entitled
Client Main Images.

■ Repeat for Rating > Only 4 and create a collection entitled Client Additional
Images.

■ Prepare output to show client:

❍ If you show them a slideshow, prepare a slideshow of each collection 
(recommended).

❍ If you show them images on the Web, create a Web gallery from each 
collection.

■ Show the client the images you recommend for the main group in a slideshow.

■ Show them the Additional Images slideshow, if appropriate.

■ Change to the Library Module and move all of the panels out of the way so
that you get a full-screen image. Go through the Main Images collection one
by one with your clients for them to choose their favorite(s). 

■ Change the rating from 5 to 0 on any images they are not interested in by
using the number 0 key.

■ Repeat for the Additional Images collection.

■ If you would like a record of their choices, print a contact sheet.

■ Check each image in the Develop Module to see if any images need fine-tuning.
Export to Photoshop for any retouching needed on individual images.
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■ Export or print the images.

■ Back up the Lightroom Library.

Stock Photographer
Here is a sample workflow for a stock photographer:

■ Set up a folder organization on your hard drive:

❍ Stock

■ YYYYMMDD-Short Description 1 (Y = Year, M = Month, D = Day)

■ YYYYMMDD-Short Description 2

■ Etc.

■ Create a new folder for each session.

■ Download images from the media card using a card reader into the new
folder that you created for the session.

■ Use Photoshop Browser or similar program to batch rename images.

■ Back up two copies onto archival gold CDs or DVDs. You may have to gather
them up into CD or DVD-sized groupings.

❍ Copy 1 goes into main stock file. 

❍ Copy 2 goes offsite.

■ Back up one copy of images onto second hard drive.

■ Reformat memory cards in camera so they are ready to use again.

■ Import images into Lightroom. Apply appropriate metadata, such as creator and
copyright information. Apply any shoot-specific keywords, such as location
or subject.

■ In the Library Module, go through and delete the blinks . Use the Command
and Delete keys to delete the image, or just the Delete key to remove from
the library. You can also use the Reject flag to reject them. You can always 
re-import them from your Originals folder if you need to for some reason. At
the same time, using the number keys rate the images:

❍ 5 = favorites for main agency, if they require exclusives.

❍ 4 = for secondary agencies.

❍ blank = duplicates or not the best of the similar images.

■ Use Quick Develop to adjust exposure, brightness, contrast, and saturation
to taste.
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■ Go into Develop, if needed, for some more detailed adjustments (such as fill light).

■ Crop if necessary.

■ Convert to grayscale (black and white), if desired.

■ Repeat for all images.

■ In Library > Filters > Rating > Only, set to 5 and create a collection entitled
Main Agency Images.

■ Repeat for Rating > Only 4 and create a collection entitled Additional Agency
Images.

■ Check each image in the Develop Module at 100 percent to see if any images
need fine-tuning. Export to Photoshop for any retouching needed on indi-
vidual images.

■ Use the Keyword function in the Library Module to add keywords

■ Export the images in the format needed for your agencies.

■ Back up the Lightroom Library.

Commercial or Editorial Photographer
Here is a sample workflow for a commercial photographer:

■ Set up a folder organization on your hard drive:

❍ Commercial

■ Commercial Client 1

❍ Originals

❍ Final Images

■ Commercial Client 2

■ Etc.

■ Create a new folder for new commercial client. Include subfolders.

■ Download images from shoot onto hard drive (into Originals folder) using 
a card reader.

■ Use Photoshop Browser or similar program to batch rename images.

■ Back up two copies onto archival gold CDs or DVDs:

❍ Copy 1 goes into client folder. 

❍ Copy 2 goes offsite.

■ Back up one copy of originals onto second hard drive.

■ Reformat memory cards in camera so they are ready to use again.
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■ Import images into Lightroom. Apply appropriate metadata, such as creator
and copyright information. Apply any shoot-specific keywords, such as loca-
tion or subject.

■ In the Library Module, go through and delete the blinks. Use the Command
and Delete keys to delete the image, or just the Delete key to remove from
the library. Or, instead, you can use the Reject flag to reject images. You can
always re-import them from your Originals folder if you need to for some 
reason. At the same time, using the number keys rate the images:

❍ 5 = your favorites suggested for client.

❍ 4 = suggested for other images for client to consider.

❍ blank = duplicates or not the best of the similar images.

■ Use Quick Develop to adjust exposure, brightness, contrast, and saturation
to taste.

■ Go into Develop, if needed, for some more detailed adjustments (such as fill light).

■ Crop if necessary.

■ Convert to grayscale (black and white), if desired.

■ Repeat for all images.

■ In Library > Filters > Rating > Only, set to 5 and create a collection entitled
Client Main Images.

■ Repeat for Rating > Only 4 and create a collection entitled Client Additional
Images.

■ Prepare output to show client:

❍ If you show them a slideshow, prepare a slideshow of each collection.

❍ If you show them images on the Web, create a Web gallery from each 
collection.

■ Show or send the client the images you recommend and the additional images.

■ Change the rating from 5 to 0 on any images they are not interested in by
using the number 0 key.

■ Repeat for the Additional Images collection.

■ If you would like a record of their choices, print a contact sheet.

■ Check each image at 100 percent in the Develop Module to see if any images
need fine-tuning. Export to Photoshop for any retouching needed on indi-
vidual images.

■ Export or print the images.

■ Back up the Lightroom Library.
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The layout of Adobe Photoshop Lightroom is different from other programs. It
is made up of modules, which lead you step by step through your workflow. Each
module has a set of panels on the sides, which has the tools necessary to accom-
plish the tasks of that module.

Main Window
Lightroom gives you a lot of options to personalize
your workspace to fit your own working needs (see
Figure 4.1). These are easy to change, so you may
find that different projects have different require-
ments. This is the way that Lightroom looks when
you first launch it. It displays all of the panels so that
you will see them. Once you start working, you will
usually find it easier to work with a number of the
panels moved out of the way so that the image is
larger or so that you can see more images at one time.

4
Desktop Layout

Figure 4.1

This is the Library Module for Adobe Photoshop Lightroom, 
set on All Photographs.



Preferences
Before starting your workflow, you must set the
preferences so that Lightroom will operate the way
that you like (see Figure 4.2).

Under the General section (see Figure
4.3), the first selections are fairly obvious.
Automatically Check for Updates is not
selected because Lightroom, used to create
the images in this book, is on a produc-
tion machine that is not regularly con-
nected to the Internet. 

The next section down in General
Preferences is the Default Library. You can
have Lightroom automatically load the
most recent library, as shown in Figure
4.4, or have it prompt you each time you
launch Lightroom. Using the Choose 
button, you can select the library that you
want Lightroom to use each time. 
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Figure 4.2

Select Preferences from the Lightroom menu.

Figure 4.3

The General section of the Preferences box.

Figure 4.4

The Default Library section.



The Default Library section is also where you select when to back up your library
(see Figure 4.5). There are a variety of choices (see Figure 4.6). Because it takes
time to back up your library, it needs to be done when you first launch Lightroom
and not when you quit the program, which might seem more logical. The amount
of time to back up your library is dependent upon how large your library is.

The next section under Preferences is External Editors
(see Figure 4.7). Here you get to choose the file 
format, color space, and bit depth of images that you
send to Photoshop (see Figures 4.8–4.10). This
machine has Photoshop CS loaded on it, so Lightroom
has selected it for the main editor automatically.
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Figure 4.5

Options for when you want to back up your library.

Figure 4.6

You can choose your favorite sounds to play to let you know
when you have finished importing or exporting files.

Figure 4.7

The External Editors section.



ProPhoto RGB is the largest color space of the three.
It is used internally in Lightroom for all processing to
keep the maximum number of colors. Adobe RGB is
a color space that is smaller than ProPhoto, but it’s a
common color space that is used commercially for
many publishing activities and is also used by stock
distributors. sRGB is a color space that is smaller still.
It is commonly used for Web sites and by some color
printing labs.

Under Bit Depth, you have a choice of 8 bits or 16
bits. Your choice will depend upon your workflow
and desired output. For example, 16 bits takes more
space, but major editing adjustments will be smoother
in 16 bits than in 8 bits. You will notice this especially
in areas of smooth color gradations, such as blue skies.

If you selected TIFF as the file format, you will be
given a choice of file compression: None, LZW, and
ZIP. Both LZW and ZIP are lossless compression
techniques in that no data is destroyed while com-
pressing (unlike JPEG, which is a lossy compression
technique). Using LZW or ZIP may actually result in
a compressed file size that is larger than the original
rather than smaller. Not all programs will support
these compression routines. Unless there is a great
need to save all possible storage space, it is usually bet-
ter to leave this set at None.
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Figure 4.8

There are two choices for file format: PSD and TIFF. 
Note the instructions about saving from Photoshop.

Figure 4.9

There are three choices for color space: ProPhoto RGB, Adobe
RGB (1998), and sRGB.

Figure 4.10

Lightroom’s Bit Depth choices.



You can add an additional external editor
so that you have another choice besides
Photoshop (see Figure 4.11). In this sec-
tion, you specify your additional editor.
You also specify the file format, color
space, and bit depths that you want for
the images that you send to the additional
external editor.

The next Preferences section is File
Management (see Figure 4.12). In this
section, you decide what you want
Lightroom to do when you insert a 
memory card from your camera. You also
decide what you want to do about pre-
views, metadata, file name generation, and
the use of import sequence numbers. The
following figures show the possibilities.

When Lightroom detects a memory card,
you can have it automatically launch to
allow you to import directly into
Lightroom. If you will be referencing files
instead of importing into Lightroom’s
files, you will want to select Do Nothing.
I prefer to download images into a file
structure before importing into Lightroom,
so I also select Do Nothing. If you wish to
import directly from the memory card,
you will also need to decide if you want to
use camera-generated folder names when
naming your shoots (see Figure 4.13).
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Figure 4.11

Additional External Editor options.

Figure 4.12

This is the File Management section of Lightroom’s Preferences box..

Figure 4.13

Options for detecting a memory card.



Lightroom creates three different sized previews, which enables it to display images
quickly, instead of having to render them from a large raw file while you are work-
ing on them. The first preview is the thumbnail size, the second preview is the
Standard preview, and the third preview is the 1:1 preview. You have control over
some of the preview process. You can set the size of the Standard preview, which
is used to display the image on your monitor (see Figure 4.14 for choices) and
set the Preview Quality level to Low,
Medium, or High. You can also decide
how long to keep the 1:1 previews. The
larger the previews and the better their
quality, the more storage space they will
take up. Using Lightroom-generated 
previews will generally provide color-
managed images that will look different
from the previews that are generated by
your camera and stored in the original file.
Consider the size of your monitor when
you select the size of the standard previews
that you want to use. If your preview file
(all previews are stored in the Lightroom
Previews/lrdata folder inside the Lightroom
Library folder) gets too large, you can
change the period of time that the 1:1 pre-
views are kept. Lightroom will generate
new 1:1 previews as needed, which saves
considerably on storage space but slows
the program down.

The next item in the File Management
section is the Metadata section (see Figure
4.15). Selecting to write your data into
XMP sidecar files will help protect your
metadata should the Lightroom file
become corrupted. Some applications
cannot yet read the Lightroom XMP files.
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Figure 4.14

Here are the choices for the Standard Preview Size setting.

Figure 4.15

The Metadata section under File Management.



If your file names have illegal characters, Lightroom will automatically correct
them for you. You have three choices for what to replace that character with, as
shown in Figure 4.16 Some workflows and computers will be confused by spaces
in a file name. The setting shown in Figure 4.17 allows Lightroom to automati-
cally fix them for you. Both of these functions will allow you to automatically cor-
rect some problems, which will be especially useful when moving existing files and
images into your Lightroom Library.

The last item in this set of Preferences is the Import Sequence Numbers section 
(see Figure 4.18). These numbers show the total number of imports and the total
number of images imported into this library. The Filename Template Editor also uses
these numbers, so they can be adjusted to change the naming values that are used.

The Interface section of the
Preferences box allows you to set up
various combinations of Lightroom’s
Panel End Mark, Panel Font Size,
Lights Out, Background features,
and Tweaks to your own liking (see
Figures 4.19–4.25).

Chapter 4 ■ Desktop Layout 39

Figure 4.16

Replacing illegal file name characters.

Figure 4.17

Lightroom will replace spaces in your file names if desired.

Figure 4.18

The Import Sequence Numbers section in the File Management Preferences box. 

Figure 4.19

The Interface section of the Preferences box.



You have three choices under the Panel End Mark setting. Shown in Figure 4.20
is the Flourish, the original one used in the public betas. You also can choose from
a small box graphic or none at all. The purpose of the
Panel End Mark is to simply show you that the panel
has ended. It is a quick and easy way to tell visually
that you don’t need to scroll down any further. You
have two choices for font size for the panels. The
small size comes as the default. Note that you will
have to quit and then relaunch Lightroom after
changing the font size before it will take effect.

The last section of the Interface Preferences is the
Tweaks. The Filmstrip images can be set very small,
and if you have several icons on an image, it may be
difficult to see the image. This will allow you to turn
some of them off. The other two preferences are based
on personal preference.
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Figure 4.20

The Flourish is the original Panel End Mark from the public
beta release.

Figure 4.21

When operating the Lights Out feature, you have a choice 
of four different dimming levels with 80% being the default
level. You can select the others to your taste.

Figure 4.22

When you dim the surrounding modules, you have a choice 
of the color that it dims to, as well as the dimming level. 
The default is black.

Figure 4.23

The Background Fill Color is the color surrounding a single
image. You have five choices, depending on personal taste 
once again.

Figure 4.24

The Overlay Texture of the background can either be plain
(none) or fine pinstripes. Experiment with all of these settings
to find the ones that work best for you.

Figure 4.25

The Tweaks section of the Interface Preferences box.



Menus
Now we will take a look at understanding the various main menus
of Lightroom. Across the top, they are Lightroom, File, Edit, Library,
Photo, Metadata, View, Window, and Help.

The first menu item is Lightroom (see Figure 4.26). It is here that
you find the credits for those who worked so hard to bring you
Lightroom. You will also find Preferences and a way to set up an
Identity Plate to personalize your program.

Moving to the right, you will see the File menu (see Figure 4.27).
Moving down the menu, the first item is Import Photos, since that
is likely to be the first thing you do before processing them. Clicking
on Import Photos gives you a chance to select from where you want
to import images to Lightroom. It is a standard folders view of your
hard drive. If you click on Auto Import, you can enable Auto
Import, which shows up with a check mark next to the command. 

In the Auto Import submenu, you can also choose
Auto Import Settings (see Figure 4.28). Using this
feature allows you to set up a Watched folder.
Anything that appears in this folder will be imported
to Lightroom using these settings. This allows you to
automatically import photographs that you create
using a tethered camera, for example. You can set up
automatic naming functions, automatic develop set-
tings, and automatically apply metadata, such as
copyright and job information. This can speed up
your workflow considerably. Set up an empty folder,
and then choose it with the first item on the list. It
must be an empty folder, or it won’t work. If you
have trouble with this feature, check your folder and
make sure there isn’t anything in it.
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Figure 4.26

Lightroom menu.

Figure 4.27

File menu.

Figure 4.28

Auto Import Settings dialog box.



The next step is choosing where you want to store your
new file and what you want to call it. This is done in the
Destination section of the Auto Import Settings box. Next
is the File Naming section, shown in Figure 4.29. You can
use an existing template or modify one.

Moving down to the Information section, you can select
specific Develop settings for the images as they are
imported (see Figure 4.30). The original images are not
touched. You could use this automatically to create black-
and-white images, for example. Shown here are the stan-
dard ones that come with Lightroom. Any other presets
or templates that you create in the Develop Module will
also be shown here.

Also in the Information section, you can create various
presets for the metadata you apply as the images are
imported (see Figure 4.31). This is useful to apply your
contact and copyright information, as well as some stan-
dard keywords for a shoot, such as the subject’s name or
client information. See Figure 4.32 for a listing of some
of the choices you have when you create a new metadata
preset template. You are allowed a huge variety of infor-
mation to add to your images as you import them auto-
matically.
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Figure 4.29

File Naming section.

Figure 4.30

Develop Settings options in the Information section.

Figure 4.31

Metadata options.

Figure 4.32

Creating a new metadata preset template.



The next item in the File menu is the Export func-
tion (see Figure 4.33). There is no Save function in
Lightroom because the images are kept in Lightroom
until you need them outside of Lightroom. You need
to export them for that to happen. Any changes that
you make to images that are in Lightroom are auto-
matically saved as you do them, so there is no need
for a Save command.

You can create a preset for the export operations that
you do frequently. Lightroom has already set up a few
common export functions to get you started: Burn
Full-Sized JPEGs, Export to DNG, or For E-Mail.
Once you fill in the rest of the Export options, you
can save it as a new preset with the Preset setting (see
Figure 4.34).

Next choose the location for where you want the images to be exported, and then
set up a template to name them the way that you would like. You can use an existing
template that you have created or edit one to 
create a new one. After that, choose the file format.
You can choose JPEG, PSD, TIFF, or DNG (see
Figure 4.35). Each file format may have additional
choices, such as Quality for JPEG. The higher the
quality, the larger the file size and more space it will
take up in storage.
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Figure 4.33

The Export dialog box.

Figure 4.34

The Export dialog box Preset menu, which shows the built-in
options and allows you to save a new preset based on your choices
in the Export box.

Figure 4.35

File Settings section of the Export box.



Under the Image Settings section, you can choose the color space, bit depth, and
resolution for the exported image. As you change the file format in the File Settings
section, notice how the section changes. For example, the JPEG format only allows
8-bit and not 16-bit, so that section is grayed out. If you select DNG for the file
format, then the entire Image Settings section will disappear, since DNG is a raw
format that saves all of the data without any options available.

One thing that confuses a number of photographers when first using Lightroom
is how to enlarge or reduce images. It is not done in the cropping function under
the Develop Module as it is in Photoshop. It is actually done in the Export box
in the Image Settings section (see Figure 4.36). First, select Constrain Maximum
Size if it is not already selected. Next, set the units (Inches, Centimeters, or Pixels).
Finally, select the maximum size width and height. For ease of use and under-
standing, make them both the same number, which is
the largest dimension. Then you can process vertical
and horizontal images without having to worry about
it. For example, if you wanted to create 8×10s, set
both width and height to 10 inches. If your image is
smaller than that, it will be enlarged. If it is larger, it
will be reduced to fit. Keep in mind that you have to
crop to the correct aspect ratio because most digital
cameras do not create images in an aspect ratio of 8×10.

After exporting your images, you have to decide what you want done to them.
You can choose to do nothing, that is, just export them to a folder and leave it at
that. You can show them in the Finder. You can burn them to a disc. You can open
them in whichever version of Photoshop that you have. Finally, the last choice
shown in Figure 4.37 allows you to set up a folder and have any executable pro-
gram run on them, such as having Photoshop actions
applied to all of the images that are exported to that
folder. To do that, create a droplet in Photoshop and
store it in the Export Actions folder. There are many
other options as well. Any program that will launch
when an image is dropped on its icon or an alias that
will launch a program can be placed in that folder to
run when the images are exported.
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Figure 4.36

Image Settings section.

Figure 4.37

Post-processing section.



Under the Edit menu, you will see some items grayed out from time to time 
(see Figure 4.38). It simply means that those commands are not available at the
moment, based on what you are doing currently.

The Spelling submenu allows you check your spelling automatically as you type
or spell check a selection (see Figure 4.39). Under the Edit menu, you can see the
Special Characters item. This is found only in the Macintosh version. This is
included as a convenience for Mac users so they can paste these special symbols
into their keywords and metadata where necessary.

There are a lot of items in the Library menu (see Figure 4.40). You can make a
new Collection of images, set up a new folder, find an image, rename a photo-
graph, convert an image to DNG (Digital Negative, the universal raw format),
work with previews, and work with the previous photo. As before, many items
have a keyword keyboard shortcut. In the Public Beta version, this section is where
you would find Photo Binders. Photo Binders
were removed from Lightroom and are not used
in Lightroom version 1.0.
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Figure 4.38

Edit menu.

Figure 4.39

Spelling submenu.

Figure 4.40

The Library menu.



The Refine Photos command in the Library menu allows
you to first select your favorite Picks, and then quickly
reject the rest (see Figure 4.41). When clicking on the
Refine button, the Picks are reset so they are not flagged as
well, allowing you to go through a new selection round if
you would like to.

The Photo menu focuses on an individual image (see
Figure 4.42). It allows you to add an image to a Quick
Collection or send the image to Adobe Photoshop or
another application (which you specified in Preferences) for
further editing. This menu is where you can create Stacking
or a Virtual Copy. You can also rotate or flip an image, set
ratings, set flags, set color labels, set keywords, change key-
words, set up Develop settings, and delete images, either
individually or as a group.

If you select the Set Rating submenu, you will be able to rate your images on a
scale of one to five stars (see Figure 4.43). This is easily done using the number
keys. You can hold down the Shift key while pressing a number key to rate an
image, and then move to the next image. This allows you to quickly go through
a batch of images.
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Figure 4.41

Refine Photos dialog box.

Figure 4.42

The Photo menu.

Figure 4.43

Set Rating submenu.



Flags (see Figure 4.44) and color labels (see Figure 4.45) are two versatile mark-
ing tools for your images. You can use flags to pick or reject images quickly and
easily. Flags are selected in the Library Module. Later you can filter the flags in the
Filmstrip so you can see all images chosen (Pick Flag), rejected images, or the ones
that you have not yet flagged. Color labels can be used in a similar manner. You
can also use them to separate images into different categories of work progress
such as edited, retouched, backed up, printed, and so forth.

Note that in the Set Keyword submenu (see Figure
4.46), you must have selected an image or the menu
will be grayed out. If you have not yet used or cre-
ated any keywords, then the Alt key option followed
by a number will be there, but the words will be
blank. The Change Keywords command takes you
to the keyword box in the Library Module to make
it quick and easy to change keywords for an image
or group of images.

Chapter 4 ■ Desktop Layout 47

Figure 4.44

Set Flag submenu.

Figure 4.45

Set Color Label submenu.

Figure 4.46

Set Keyword submenu.



The Develop Settings option allows you to copy develop
settings from other images and apply them to the one you
are working on (see Figure 4.47). You can also choose Auto
White Balance or Auto Tone, even from within the Library
Module. There is also a handy shortcut to convert a color
image to a grayscale (often called a black-and-white) image.

Moving again to the right in the top menus, next is the
Metadata menu (see Figure 4.48). This is the menu you
use for metadata, the information (such as keywords) that
you add to an image. You can set keyword shortcuts, add
keywords, enable keyword stamping, create and maintain
sets of keywords, copy groups of metadata, deal with XMP
sidecars, import and export keywords, and purge key-
words that you no longer want to have in Lightroom.

The first two items in the Metadata menu allow you to
set a keyword shortcut and then apply it with a set of 
keystrokes (Shift+Command/Ctrl+K). Notice that all 
of the keyword commands use the letter K along with a
modifier key.

Using the Keyword Set command (shown in Figure 4.49) allows you to quickly
keyword certain types of images that you create all of the time. Using this sub-
menu, you can create new keyword presets, rename the existing ones, or edit the
existing ones.

You can rename the Color Label Sets, as shown in the Edit box of the Color Label
Set submenu (see Figure 4.50). You can create different presets so you can have a
variety of different names for a specific label. For example, the colors could have
one meaning with wedding clients and a different meaning with portrait clients.
Or you could create different meanings for family photographs versus your land-
scape photographs.
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Figure 4.48

The Metadata menu.

Figure 4.47

Develop submenu.

Figure 4.50

Edit Color Label Set dialog box.

Figure 4.49

The Keyword Set submenu.



The next function in the Metadata menu is Copy Metadata, followed by Paste
and Sync Metadata. The last two are grayed out in Figure 4.48 because no meta-
data has been selected to work with.

Photographers often have trouble with the capture time of their images. Perhaps
they forgot to change the time clock on their camera to daylight savings time 
(or back again), or they are traveling across time zones and the times are wrong.
They may reset the time and do it wrong. Also
when two cameras are in use in photojournalis-
tic settings or perhaps at weddings, it is nice to
match the times of the cameras so the images are
in the proper order. The Edit Capture Time box
allows you to adjust the time in a number of
ways (see Figure 4.51). Note that Undo does not
work with this, so be careful and make sure your
images are already backed up first (which you
should do anyway, of course).

XMP sidecars are files that carry the metadata
for your raw images; that way the metadata can
be changed without altering your raw file.
Metadata for other file formats are stored within
the file itself. The reason that metadata is not added to raw files is that raw
files are proprietary and not documented. If the file is altered, there is the
possibility that the raw file could be damaged or corrupted. Adobe opted for
the conservative approach of only adding metadata to documented files.
XMP files are small files that don’t take up much space. The XMP sidecar
has the same name as your file, except that it ends in .xmp. With the XMP
submenu (in the Metadata menu), you have the option to export or import
the XMP data.

The View menu allows you to set up the various ways to view your images
(see Figure 4.52). You can look at them individually (Loupe view), in a sort
of light table manner (Grid view), or compare several images (Compare
view). You can use this to see before and after images. There are simple one-
key commands to switch between them, such as G for Grid and E for Loupe.
It is worthwhile to memorize the ones that you use frequently, or keep the
keyboard shortcut listing next to your desk.
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Figure 4.51

Edit Capture Time dialog box.

Figure 4.52

View menu.



The toolbar is the bar at the bottom of the window immediately under the image
and above the Filmstrip (if you turned it on). If there is no toolbar showing, press
the T key, and it will appear and disappear. You can use this toolbar to go to Grid
view (left button), Loupe view (next button to the right), Compare (the buttons
with X and Y on them), rate the image (the stars), rotate the image, or move 
forward or back among the images. Note that the toolbar will change depending
on which view you are in. Compare Figures 4.53 and 4.54 for the different tool-
bars available in Loupe view and Grid view, respectively

The first set of buttons is the same as in Loupe view. This time you have a choice
of how the images are sorted with a drop-down menu when you click on the small
arrow. You can also select the size that you would like the grid images to be by
moving a slider that will give you different size thumbnails. The sizing is deter-
mined somewhat by your monitor size. The final box allows you to add keywords
or tags to your images.

The small arrow on the right of the toolbar presents a submenu
that allows you to customize what you want to see in either the
Loupe view or Grid view (see Figure 4.55). Depending on the
choices that you select, some items will disappear or be com-
pressed. Play around with the different choices until you find
the information that works best with your workflow.
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Figure 4.53

The toolbar in Library Loupe view.

Figure 4.54

The toolbar in Library Grid view.

Figure 4.55

Toolbar submenu in Grid view.



Besides sorting with the toolbar buttons, you can use the Sort submenu in the
View menu (see Figure 4.56). This way, you can easily access Sort even if you have
the toolbar turned off. 

Selecting View > View Options (or using the keyboard shortcut) will bring up a
separate window in the Library Module, as shown in Figure 4.57.

This window has lots of goodies in it to allow
you to set up your Lightroom desktop exactly
as you like. The first thing to note is the Show
Grid Extras check box. Leaving it unchecked,
as shown in Figure 4.58, the images are
shown without any writing around them,
such as file names or other information.
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Figure 4.56

Sort submenu.

Figure 4.57

View Options window.

Figure 4.58

Library View Options window in Grid view with Show Grid Extras
turned off.



Checking the Show Grid Extras box allows
you to specify what information you would
like displayed with each image. Here the file
name and the index number are shown, and
the cells holding the images are in Compact
format (see Figure 4.59). Look at Figure
4.60 to see them in Expanded format.

By expanding the cells, fewer images are
shown, but there is more room for informa-
tion about each image. Compare Figures
4.59 and 4.60 to see the differences between
Compact and Expanded cells. 
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Figure 4.59

Library View Options window in Grid View with Show Grid Extras
turned on and displayed as Compact Cells.

Figure 4.60

Library View Options window in Grid View with Show Grid Extras
turned on and displayed as Expanded Cells.



There is a small dark gray circle in
the upper right on some of the
images. This denotes that the image
is part of a Quick Collection. Note
that this is different from the light
gray circle in the same place when
the cursor hovers over an image. In
Figure 4.61, the cursor is hovering
over the image next to the one in
the Quick Collection. The first check
box under the General section is the
one that you can select or unselect
to show these markers.

In Figure 4.62, the cursor is pointing to the Pick Flag.
Pick Flags are chosen by highlighting the photograph and
clicking on the Pick Flag in the toolbar. The Include Pick
Flags setting in the Library View Options window turns
them on and off.
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Figure 4.61

Quick Collection markers.

Figure 4.62

Include Pick Flags option turned on.



Thumbnail Badges are the small icons that
show in the lower-right corner of some of the
images (look at the highlighted image, for
example, in Figure 4.62 ). These badges indi-
cate if an image has been adjusted (the badge
will show a +/–), had keywords applied (the
small badge that has what looks like an angled
tag), and if the image has been cropped 
(a square badge with small dots in it). Figure
4.63 shows the Thumbnail Badges option
turned off and Figure 4.62 has it turned on.

With the Show Clickable Items on Mouse Over
Only box checked, the cursor will reveal click-
able items when it moves over them. In Figure
4.64, you can see the two Rotation buttons and
star-rating strip appear on one image with the
cursor over it. If this box is left unchecked, then
the clickable items will always show.
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Figure 4.63

Include Thumbnail Badges option turned off.

Figure 4.64

Show Clickable Items on Mouse Over Only option turned on.



With this box unchecked, all of the clickable
items are shown (see Figure 4.65). Shown here
are the two Rotation buttons and the five dots
at the bottom of the image cell (clicking on
any dot will give you that many stars). In
addition, in the upper-right corner of the
image, there is a small light gray circle. Those
that are empty (that is, they look like a trans-
parent circle) are not in the Quick Collection,
and those that are filled in with dark gray are
in the Quick Collection. Clicking on that cir-
cle will add the image to the Quick Collection
or remove it. In this figure, only the high-
lighted image to the left of the Library View
Options window is in the Quick Collection.

With Tint Grid Cells with Color Labels
turned on, the images can be shown with their
color labels (see Figure 4.66). The color labels
can be set in three ways: by selecting the
image or images and then clicking on the
color boxes in the toolbar, by going to Photo
> Set Color Label > (color), or by using the
number keys 6, 7, 8, and 9 (the color purple
does not have a shortcut key). In Figure 4.66,
a color was assigned to five images in the top
row to show what setting a color would look
like. In actual use, you can select any number
of images for each color. In both the compact
and expanded cell views, only the “slide
mount” border around the image is colored.
In the expanded view, the additional title bars
are not colored, and a small color box is added
to the lower bar.
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Figure 4.65

Show Clickable Items on Mouse Over Only option turned off.

Figure 4.66

Tint Grid Cells with Color Labels option turned on.



If the Compact Cells option is selected in the Show Grid Extras
field, then you have a choice of a top label, a bottom label, both
labels, or no labels in the Compact Cell Extras section (see Figure
4.67). Simply check or uncheck the Top Label and Bottom Label
boxes, depending on what you want. Next, go to the two drop-
down menus, as shown in Figure 4.67, and select what you would
like in each of them. If you have selected Expanded Cells in the
Show Grid Extras field instead of Compact Cells, you can choose
from up to four labels. There are four drop-down menus available
in the Expanded Cell Extras section.In both the compact and
expanded cell views, each menu is the same. With compact cells, you
can show two pieces of information, and with expanded cells, 
you can show four pieces of information because you have the
additional space.

Turning off Show Rating Footer by uncheck-
ing the box, as shown in Figure 4.68, will
make the vertical dimension of the cells
smaller in the Expanded Cells view only. The
Compact Cells view is not affected. If you 
disable the rating footer, you also lose the
Rotation buttons, which are next to them. 
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Figure 4.67

Compact Cell Extras section.

Figure 4.68

Show Rating Footer option.



Figure 4.69 shows the maxi-
mum number of thumbnails.
You can set this up in the
Library Module by clicking on
the triangles in the middle
top, bottom, and sides to
move the various panels out of
the way. Move the Thumbnails
slider to the left to show the
smallest possible thumbnail.
Go to View > Hide Toolbar
(or press the T key) to accom-
plish the same thing. Finally,
go to View > View Options
and select Compact Cells in
the drop-down menu next to
Show Grid Extras. The actual
number of thumbnails that
show on your system will
depend on the size and resolu-
tion of your monitor.

Switching to Loupe View in the Library View
Options window, you have the option of dis-
playing information so that you know which
image you are looking at or working on. You
can set up two different information overlays.
In Figure 4.70, the Show Info Overlay box is
checked, and the file name, date and time, and
size of the image are displayed in the upper-left
corner of the image. If both side panels are 
displayed, then the information will overlap
the image. If one or both of the side panels are
closed, then the information will occupy the
gray area to the upper left of the image.
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Figure 4.69

Maximum number of thumbnails.

Figure 4.70

Library View Options window in Loupe view with the Show Info
Overlay option turned on and Info 1 displayed.



Changing the Show Info Overlay option from
Info 1 to Info 2 changes the information 
displayed on the image (if you have selected
different items to display under Info 2). The
image in Figure 4.71 displays the file name,
exposure and ISO, and lens setting. 

Figure 4.72 shows the range of choices for the
Loupe Info 1 section. You can select three
items from the drop-down menu to be dis-
played on your image. By using the Info 1 and
Info 2 sections, you can set up two different
templates that you can easily switch between
by using the View > Loupe Info menu, and
then selecting Info 1 or Info 2.

Moving down to the next item in the View
menu, you can select Grid View Style (see
Figure 4.73). Selecting Grid View Style brings
up a submenu to show extras, show badges,
select the cell size, and cycle through the view
styles.
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Figure 4.71

Library View Options window in Loupe view with the Show Info
Overlay option turned on and Info 2 displayed.

Figure 4.73

View menu displaying the Grid View Style submenu.

Figure 4.72

Loupe Info 1 section options.



As mentioned earlier, you can use the Loupe
Info submenu (see Figure 4.74) to select
which information will be displayed with
your image under the Loupe (single image)
view, as well as cycle through the info 
displays.

The Window menu (see Figure 4.75) allows
you to select which panels and modules you
want displayed in your main window. There
are also a number of keyboard shortcuts,
which can be used to speed your workflow.

You can select which panels you want to 
display with the Panels submenu of the
Window menu (see Figure 4.76). You can
also use the triangles by each panel on the
sides, top, and bottom of the windows to
open and close them. There are also 
keyboard shortcuts using the function keys
along the top of your keyboard.
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Figure 4.74

View menu showing the Loupe Info submenu.

Figure 4.75

Window menu.

Figure 4.76

Panels submenu.



The Window > Screen Mode submenu (see
Figure 4.77) allows you to select a full screen
for the maximum image size or a smaller
screen with more information available. You
can also cycle through the screen modes with
this menu or by using the keyboard shortcut
of F.

The Lights Out features (see Figure 4.78) allow you
to easily darken the area of your screen all around
your image so that you can take a critical look at the
image without all of the distractions of the panels
and modules. These can easily be turned on and off
with the L key, which cycles through Lights On,
Lights Dim, and Lights Off modes with each press
of the key. Some people have found it easier to crop
images while in one of the Lights Out modes.

This menu item allows you to activate Lightroom
Help (see Figure 4.79), which lets you get help
online if your computer is connected to the Internet,
check for updates, get started with Lightroom, reg-
ister Lightroom, look at the Five Rules, and open
Library Shortcuts.
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Figure 4.77

Screen Mode submenu.

Figure 4.78

Lights Out submenu.

Figure 4.79

Help menu.



The Five Rules
Unique to Lightroom is its set of Five Rules found in the
Help menu. These rules are really just a basic set of
instructions on how to operate the program, which also
shows a bit of the developers’ philosophy (see Figures
4.80–4.84). As with any photography-related task, it is
important to always follow Rule 5: Enjoy.

The final item in the Help menu is the shortcuts listing
for whichever module you happen to be in at the time.
For a listing of all of the shortcuts, see the Appendices
and the end of each chapter on the different modules.
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Figure 4.80

Rule One: the Module Picker.

Figure 4.81

Rule Two: Panels.

Figure 4.82

Rule Three: Filmstrip.

Figure 4.83

Rule Four: Key Commands.

Figure 4.84

Rule Five: Enjoy.



Module Picker
The Module Picker is the onscreen menu header which allows you to easily and
quickly move between the Library, Develop, Slideshow, Print, Web, and any future
modules (see Figure 4.85). By clicking on the small triangle on the top center of
the Module Picker, you can hide or reveal it for use.

In Figure 4.86, the Module Picker is closed. Note the direction of the arrow to
indicate which way the action will occur. You can see the cursor arrow near the
triangle, now pointing downward, you can click on the triangle at any time to
reopen the Module Picker.

Panels
What are panels? Panels are the areas on the sides, top, and bottom of the screen
which will pop out or in when you click the little triangles or arrows on each side.
These panels contain much of Lightroom’s functionality. Each module (Library,
Develop, Slideshow, Print, and Web) has its own set of panels. The panels are used
to operate on the image or images shown in the middle of the screen.

The top panel (the Module Picker) remains the same in all modules (see Figure 4.87).
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Figure 4.85

Module Picker.

Figure 4.86

Module Picker closed.

Figure 4.87

Top panel.



The bottom panel in all modules is the Filmstrip, which is described in more detail
in the next section. It can be varied in size. Figures 4.88 and 4.89 show the
Filmstrip’s minimum and maximum sizes. It can be set at any size in between as
well. To do that, place your cursor on the top edge of the outer border between
the Filmstrip and the toolbar, if you have it on, or on the image(s) if you don’t.
When the cursor changes to a set of small double lines with a double-headed
arrow, click and drag the boundary up or down to resize the Filmstrip images.

Chapter 4 ■ Desktop Layout 63

Figure 4.88

Bottom panel minimized.

Figure 4.89

Bottom panel maximized.



The left panels in the Library include the Navigator, Library, Find, Folders,
Collections, Keyword Tags, and the Metadata Browser (see Figure 4.90).

The right panels in the Library include the Histogram, Quick Develop,
Keywording, and Metadata (see Figure 4.91). Note the flourish at the bottom of
the panel lists. They are not just for decoration—they tell you as you are scrolling
up and down when you have come to the bottom of the panels. You can turn this
off or replace it with a small box in Preferences > Interface > Panels > Panel End
Mark.

The left panels in Develop include Navigator, Presets, Snapshots, and History (see
Figure 4.92). Also, next to Navigator, note the size instructions used for Loupe
mode. If you click on FIT, the entire image will be shown. If you click on FILL,
the image will be enlarged to fill all of the image space available. In addition, you
can click on 1:1, 1:3, or a number of others using the drop-down menu (indicated
by the down arrow) as the size enlargement to be triggered when you go into
Loupe mode.
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Figure 4.90

Library left panels.

Figure 4.91

Library right panels.

Figure 4.92

Develop left panels.



The Develop right panels include Histogram, Basic (for Basic Development), Tone
Curve, HSL/Color/Grayscale, Split Toning, Detail, Lens Corrections, and Camera
Calibration (see 4.93). These will be covered in more detail in Chapter 6,
“Develop Module.”

The Slideshow left panels include Preview and Template Browser (see Figure 4.94).

The Slideshow right panels include Options, Layout, Overlays, Backdrop,
and Playback (see Figure 4.95). All of the Slideshow panels and functions
will be included in more detail in Chapter 7, “ Slideshow Module.”

The Print left panels are Preview and Template Browser (see Figure 4.96).
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Figure 4.93

Develop right panels.

Figure 4.94

Slideshow left panels.

Figure 4.95

Slideshow right panels.

Figure 4.96

Print left panels.



The Print right panels include Image Settings, Layout, Overlays, and Print Job
(see Figure 4.97). The Print Module and panels are covered in Chapter 8, “Print
Module.”

The Web left panels are Preview and Template Browser (see Figure 4.98).

The Web right panels are Gallery, Labels, Color Palette, Appearance, Output
Settings, Image Settings, and Output (see Figure 4.99). The Web Module and its
panels are explained in Chapter 9, “Web Module.”

Filmstrip
The Filmstrip runs across the bottom of all of the modules (see Figure 4.100). It
shows you all of the images that you are currently working on. You can select a
specific shoot, all images, a Collection, Quick Collection, or a group chosen by
keyword.
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Figure 4.97

Print right panels.

Figure 4.98

Web Left panels.

Figure 4.99

Web Right Panels.

Figure 4.100

The Filmstrip.



The top left of the Filmstrip has several tools, a description of which photographs
you have chosen and how you chose them, and the number of images (see Figure
101). The icon farthest to the left is a grid. Clicking on it resets the images to the
Grid format. The two gray arrows will step you through the different modules.
This is handy if you have closed the upper panel, the Module Picker.

In case you don’t remember the keyboard shortcuts for the Quick Collection, you
can display a drop-down menu in the upper left of the Filmstrip by clicking on
the down arrow (see Figure 4.102). In fact, you can click anywhere along the blank
center portion of the top bar of the Filmstrip, and the drop-down menu will
appear.

The top right of the Filmstrip is for filtering. You can filter by flags, by ratings, or
by color labels. It allows you to quickly change how you selected the images. There
is also a small switch on the far right to turn filtering on and off. This way you
can select your desired filtering, and then flick the switch on and off to see the effect.
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Figure 4.101

Filmstrip top-left toolbar.

Figure 4.102

Filmstrip left drop-down menu.



The right and left arrows on the right and
left sides of the Filmstrip allow you to
quickly scroll through the images it contains
(see Figure 4.103).

Use this bottom arrow to hide or reveal the Filmstrip (see Figure
4.104). The direction of the arrow tells you what will happen to the
Filmstrip if you click on it. Here it points down, so clicking on it will
cause the Filmstrip to move down out of sight. This is a good way to
give you the maximum amount of screen space when evaluating
images.

If you Control-click (Mac) or right-click (PC) on the down arrow,
you get the pop-up menu shown in Figure 4.105. This allows you to
lock the Filmstrip open or closed or set it to open automatically when
you move your mouse over the bottom of the screen. You can also set
it so that you have to click on the arrow to open it, but it will close as
soon as you move your mouse away.

Finally, at the bottom of the Filmstrip is a slider so that you can move
through the Filmstrip images quickly (see Figure 4.106).
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Figure 4.103

Left and right arrows.

Figure 4.104

Bottom arrow.

Figure 4.105

Control-click bottom arrow.

Figure 4.106

Filmstrip slider



Quick Collection
A Quick Collection is a temporary collection that you can set up by simply click-
ing on an image and pressing the B key, or clicking in the small circle in the upper-
right corner that appears when the cursor hovers over the image. Figure 4.107
shows the cursor arrow on the circle. That image is added to the Quick Collection.
Even if you are planning to create a regular Collection, you can select all of the
images with Quick Collection, and then drag them to the regular Collection,
which you can create by selecting Library > New Collection from the main menu.
In Figure 4.107, the only way you can tell it is a Quick Collection is by looking
for the dark gray circle in the upper-right corner of each image. You can also look
at the Filmstrip at the bottom, which gives you the Filmstrip path Quick
Collection/10 photos. If you want to remove an image from the Quick Collection,
just choose an image or images and press the B key again, or click on the dark gray
dot on the image.

There are a number of uses for Quick Collection. If you import your images and
want to make a quick slideshow, Web gallery, or proof sheets to show a client,
Quick Collection will make fast work of it. It also works well if you want to select
your best images for a project. The images you select for a Quick Collection do
not have to be from the same shoot. However, you can only have one Quick
Collection at a time. When you are finished with it, you need to clear it out
(Shift+Command+B) so that it
is available for the next use.
Quick Collection is one of the
key tools in Lightroom that
makes it possible to quickly
process images to a form of 
output.
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Figure 4.107

A Quick Collection of 10 images.





5
Library Module

Photo Library Organization
The first thing to understand before using Lightroom is how it will organize your
images. Lightroom does not have a browser as might be found in other programs,
such as Photoshop. This confuses a number of people. If you want to develop
(process) a few images, you cannot just navigate to your image folder and open
up the images to work on them like you would in Photoshop. Instead, because
Lightroom is a database system, as well as an image processor, all images must be
imported before working on them. There are three key concepts to understand:
Folders, Collections, and Quick Collections.

To get to the Library Module, you can click on Library in the Module Picker along
the top of the screen (see Figure 5.1).

Figure 5.1

Module Picker.



If the Module Picker is hidden, click on the down arrow, as shown in Figure 5.2,
so that the Module Picker will be revealed. You can also press
Option+Command+1 (PC is Alt+Ctrl+1) to go directly to the Library. The third
way is to go to the top menus and select Window > Library. One of those meth-
ods should get you into the Library.

Folders
When you import your photographs, they are put into a folder. If you used
the Public Beta of Lightroom, then you used a concept called Shoots.
However, folders have replaced the concept of Shoots. A photograph can be
in only one folder. You can create a hierarchical setup for your folders. For
example, you could set them up by subject, as shown in Figure 5.3. You can
create your folders ahead of time, and then have Lightroom import them
all, or you can create them later. When you move images inside Lightroom
from one folder to another, Lightroom will physically move your images on
your computer where they are stored as well.

You could further break those down by year (2006, 2005, 2004) or type
(family portraits, senior portraits, engagement portraits). You can have a
number of levels in your hierarchy. Some photographers like to set up their
hierarchy by year and month, and then into individual folders by date
within each month, so they will have three levels. Other photographers have
ongoing projects or clients that they continually photograph for and so they
set up their folder system as follows: 

■ Client-1

❍ Commercial Client 1

■ Session 1

■ Session 2

■ Client-2

■ Session 1

■ Session 2
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Figure 5.2

Module Picker hidden.

Figure 5.3

Folders organized by subject.



It really depends on how you work and how many sessions you have. If you have
400 sessions, then you will want a more refined organizational scheme than a pho-
tographer with 10. When you are setting up your folders, you can allow Lightroom
to import your existing structure, or you can set one up manually and then import
selected sessions to each hierarchy. You can also just import all of your sessions
and then organize them after being imported. You can create new, blank folders
or master folders by simply pushing the plus (+) sign on the title bar to the right
of Folders. Double-click on a title to change the name. To rearrange the folders,
just drag them from one spot to another. Within a master folder, they are organ-
ized alphabetically. Next to each folder is a number, which tells you how many
images are in that folder.

If you highlight a folder in the Folders Panel, Lightroom will show you just the
contents of that folder in Library Grid view. You can see how many images are in
each folder, as shown in the Folders Panel. Folders that are empty are shown, but
they are gray instead of white. To remove a folder from Lightroom, simply click
on it and then click on the minus sign (–) in the Folders title bar. When you delete
a folder, the folder and its images are removed from the Lightroom Library, but
are not deleted from your hard drive at their original location.

Collections
Collections are similar to Shoots, except that each photograph can be in as many
Collections as you would like. What would you use Collections for? You could set
up a Collection for each stock distributor that you send your images to so you
could easily track which images went where. If you are a wedding photographer,
you could set up a Collection for the client’s wedding album images. You could
set up a Collection of your favorite images or even a number of Collections: one
for favorite portraits, one for favorite commercial images, and one for favorite wed-
ding images. There is no limit to what you can do with Collections.

When you press the plus sign (+) sign in the Collections title bar, a box  pops up
(shown in Figure 5.4) for you to type in the name of the Collection. Here you can
see that the Create as Child of Collection 3 box has been checked so that the new
Collection will fall under the existing Collection 3. Notice that Collection 3 is
highlighted under Collections. You can easily move Collections to reorganize them
or double-click on the name to rename them. If you want to remove a Collection,
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Figure 5.4

Collections set up
hierarchically.
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highlight it by clicking on it, and then click on the minus sign (–) in the
Collections title bar. The Collections title bar also tells you the total number 
of Collections folders that you have. Since your images are in a folder as well as a
Collection, when a Collection is deleted, the images remain in their original folder
and are not deleted from the Library.

To work on a Collection, just select it in the Collections Panel on the left; those
images will be shown in the Filmstrip below and in Grid view in the main viewer.
Now you can work on the images individually or as a group in the Quick Develop
and Applied Keywords Panels on the right side of the viewer. As always, if the right
or left panels are not showing, look for the small arrow on the middle of the far
left or far right and click on it to reveal the panel. Control-click to bring up the
menu to control how the panels behave.

Quick Collection
Quick Collection is a temporary Collection. You can only have one Quick
Collection. It is a great tool to quickly go through your images to show a client.
For example, you are photographing a portrait session for a client. While they are
grabbing a bite of lunch, you can import the images from their session. Then you
can go through them one by one. You add the ones you want to show them by
hitting the B key. Moving to the Library Panel on the left, click on Quick
Collection. You can see it highlighted in Figure 5.5.

That brings up your favorites to work on. You can go through them in
Quick Develop (see Figure 5.6), and then go to the Slideshow Module
and turn out a slideshow. In the 30 minutes they were gone to lunch,
you went through the 200 images you created, edited them down to 
the 40 you want to show them, quickly developed them, and created a
slideshow with music to make a good presentation.

Figure 5.5

Quick Collection is listed under the
Library Panel.



When you are finished with Quick Collection, you can create a regular Collection
and drag the photographs from Quick Collection over to it. Clear Quick Collection
by selecting File > Clear Quick Collection or using the keys Shift+Command+B
(or Shift+Ctrl+B for PC). Now Quick Collection is ready to use on your next 
project. To see if Quick Collection is empty before using it, simply open up the
Library Panel on the left side of the main window and make sure that it shows 0
next to Quick Collection.
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Figure 5.6

The 10 images in Quick Collection are ready to work on in Quick Develop.



Import
This is how it all begins—by importing your images. You do not need to use a
browser-style menu to open your images. Instead, you let Lightroom’s database
system handle your images. Lightroom can import most camera raw files, DNG,
JPEG, TIFF, and PSD (if saved in Photoshop with maximize compatibility turned
on). Check the Adobe Web site to confirm that your camera’s file format is sup-
ported. Some newer cameras may not be supported immediately. Lightroom can
only work on flattened PSD files at the moment. When you import, you have a
choice of four different methods, which are discussed later in this section.

To import your images, click on the Import button, as shown in Figure 5.7, go to
the main menu and select File > Import, or use Shift+Command+I (Shift+Ctrl+I
for PC). No matter how you do it, the Open window will pop up.

There you can specify a folder, as shown in Figure 5.8, and click the Choose
button. Or you can highlight individual images or a group of images to import.
Once you click on Choose, the  Import Photos dialog box opens up (see Figure 5.9).
This is the important one. 
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Figure 5.7

Use the Import button in the Library to import your images.

Figure 5.8

The Open window.



This is where you specify how the files are to be handled, if
you should rename your files, how they should be seg-
mented, whether you want to add metadata to all of the
images, automatically develop them a certain way, give the
Folder a custom name, or add keywords as they are
imported. These are important choices and can save you a
lot of time, especially with large numbers of images. It is
also important to note the following: Lightroom currently
has an image size limitation of 10,000 pixels in the longest
dimension. If you try to import a larger image, it will give
you an error message.

The File Handling popup menu gives you four options 
(see Figure 5.10):

■ Import Photos at Their Current Location—This
means that the Lightroom database just points at your
images wherever they are located and doesn’t change or
move them. You can use this with images on CD/DVD
to keep your images in offline storage.

■ Copy Photos to a New Location and Import—
Lightroom will make a copy of your image and put
that copy in a new location and into the Lightroom
database. It does not touch your original file.

■ Move Photos to a New Location and Import—
Lightroom will physically move your images from the
folders where you had put them to a new location on
your computer and import them into the Lightroom
database as well. Your old folders will be left empty.

■ Copy Photos as Digital Negative (DNG) and Import
—Digital Negative, or DNG, is a file format developed
by Adobe to be a universal RAW format. If you select
this, Lightroom will make a copy of your file, convert
it to DNG, and store the new DNG file in the
Lightroom database. Your original image will be left
untouched in its original location.
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Figure 5.9

The Import Photos dialog box.

Figure 5.10

File Handling popup menu.
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Changing the  File Handling choice will change which options are offered in the
rest of the menu. For example, File Naming is not offered if you select Import
Photos at their Current Location. Depending on your choice under File Handling,
you will be given the option of organizing the images by placing them in one
folder, in their original folders, or by various date configurations.

In all cases, you can tell Lightroom to ignore any duplicates or to go ahead and
import them. If you are copying or moving the photographs to a new location, you
will also be able to do an initial backup of the images that you are importing. A sep-
arate menu will pop up to allow you to select where you want your backup stored.

The next step is to decide how you want to name the images as they are imported.
You can simply leave the name the same as the current file name, as shown in
Figure 5.11. There are a number of other choices available. You can add a sequence
number, custom name, the date, the shoot name, the file name, or data from the
EXIF menu. There are a number of presets already available, but you can create
new ones. Click on Edit in the Template popup menu. 

Take a look at the various options in the  Filename Template Editor dialog box
(see Figure 5.12). Note that you can stack these up if you would like. The Example
field under the Preset list (at the top) will show you what your rename will look
like on an image. Each item you add to create the file name is called a token, and you
can have as many tokens as you would like to set up your file naming convention.

Figure 5.11

The Template popup menu in the File Naming section.

Figure 5.12

The Filename Template Editor dialog box.



The Preset drop-down list is at the top of the Filename Template
Editor (see Figure 5.13). This menu holds some file naming pre-
sets that are built into Lightroom, plus it allows you to create and
save your own. 

When you select Filename in the Image Name section (see Figure
5.14), you can choose Filename or Filename Number Suffix. Click
on Insert to add either token to your naming preset.
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Figure 5.13

The Preset drop-down menu.

Figure 5.14

The  Image Name section drop-down list.



You can decide to rename your images with a number based on the import num-
ber, the image number, the sequence number, or the total number. If you select
any of these numbers, you can choose how many digits
it will be, as shown in Figure 5.15. Remember you can
add this to your file name or custom name, or leave it
just by itself. For example, if you were doing a wedding,
you could name the images Susan-John (Custom Name)
0001 Sequence # (0001). So an example image would be
Susan-John0238.raf (where .raf is the name of the raw
file on your camera).

Moving down to the Additional section, there are tokens
for Date and the EXIF information available in the image
from the camera.

As with the other tokens, you can select one for the date in various combinations
(see Figure 5.16). You can also use multiple date tokens. For example, if you
wanted MMDDYY, you could first put in a token for MM, then DD, and then
YY. There are also tokens for hour, minute, and second. It is a very flexible system.
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Figure 5.15

Numbering section tokens.

Figure 5.16

The Additional section Date drop-down list.



The bottom list in the Additional section is the information from
the camera (see Figure 5.17). EXIF is the data from your camera that
is stored within the image file when you take your photographs. It is
possible that your camera does not insert all of this information or
that the raw processor, if the images are raw, can decode it properly.
If it does, then you can create a token for any of this data. You can
add multiple tokens if you want multiple information as part of the
file name. Once you have imported the files, you can look at the
Metadata Panel to check the EXIF information as well. The Metadata
Panel is discussed in more detail throughout this chapter.

The Example field below the Preset list is very powerful. Combine 
it with Sequence #, as in the above example, and you have a lot of 
possibilities. In Figure 5.18, I have added the custom text
“StateUniversity-” to the beginning of the existing file as I import it.
To do this, go down to the Custom section, click on Insert, and a
Custom Text token will appear in the Example field. After the Custom
Text token in the Example field, I have typed in “StateUniversity-.”
Next to the word Example, you will see that Class-2912.jpg is the
original file name, and StateUniversity-Class-2912.jpg will be the
new file name given as the image is imported. You will also have a
chance to fill in custom text in the File Naming portion of the
Import Photos dialog box, as seen in Figure 5.19.
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Figure 5.17

The Additional section EXIF list.

Figure 5.18

The Rename Custom menu.

Figure 5.19

The Custom Text field in the Import Photos dialog box.



Back in the Import Photos dialog box, drop down to the Information to Apply
section. Here you’ll find the Develop Settings, Metadata, and Keywords lists (see
Figure 5.20).

To speed up your processing, you can set it up to automatically develop your
images as you import them. This is great if you want only black-and-white
(grayscale) or sepia images, for example (see Figure 5.21). Remember that you are
not changing the original file. You can always go back and turn it off or change it
if you like. This is just the initial develop when you import to get you close to
what you want. You can create custom presets in the Develop Module to add 
to these.
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Figure 5.20

The Information to Apply section includes Develop Settings,
Metadata, Keywords, and Render Standard-Sized Previews
options.

Figure 5.21

Develop Settings list.



You can set up a metadata template to automatically fill in
the metadata as you import images. To do this, create a new
metadata template (see Figure 5.22). Figure 5.23 shows the
blank template.

You can see in Figure 5.23 that there are a lot of fields in
the metadata template, which you can choose to fill in. The
Copyright and Creator sections should be filled in as a min-
imum if you have any plans of sending images to anyone
in electronic form. Once you create a preset, you can auto-
matically add it to all of your images as you upload them
and not have to worry about it again.
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Figure 5.22

Metadata list.

Figure 5.23

The New Metadata Preset dialog box.



Underneath the Metadata list is the Keywords field where you can enter keywords,
also called tags. This section relates to information specific to this session. You can
go ahead and enter keywords here to be added to all images that you are import-
ing. This will speed up your workflow later by reducing or eliminating those steps.

The metadata is saved in the file itself for JPEG, TIFF, DNG, and PSD files.
Because Lightroom does not change raw files, it creates a sidecar file (an XMP file)
to store this information. 

You also need to decide how you want to handle preview images. Lightroom can
save time by creating previews (already developed versions) of your images and
saving them in sidecar files or embedding them. However, this takes longer on
import and uses up more hard drive space, though it does make running the 
program quicker as you are looking at and developing images. You do this by
checking the Render Standard-Sized Previews box. 

You select the size of the previews in the following menus: For the Mac, prefer-
ences are found in the main menu Lightroom > Preferences; preferences for the
PC are under Edit > Preferences. If you check the Render Standard-Sized Previews
box in the Information to Apply section of the Import Photos Menu (see Figure
5.22), Lightroom will create the previews upon import. Lightroom renders these
previews. If you don’t check the box, Lightroom will use the previews that are
embedded in the image by the camera. These will be the camera’s interpretation
rather than Lightroom’s. If you are importing images on CD/DVDs, make sure
to create the previews upon import, since you will be removing the CD/DVDs
once you have added them to your library, and the original image files will not be
quickly accessible. Notice that the folder containing images where you have
removed the referenced originals is shown in red to remind you that the originals
are not immediately accessible by Lightroom. See Figure 5.24 for an example.
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Figure 5.24

A red folder title indicates that the originals are not currently online.



Go to the Show Preview check box at the bottom and check it. Now previews are
seen in a new box on the right (see Figure 5.25). Now move to the right side of
the Import Photos dialog box. There you should see the first of the images you
are planning to import. Underneath the photograph is a slider. By moving the
slider you change the size of the preview images. That way you can quickly view
all of the images.

The Windows version of Lightroom can import images from Photoshop Elements
or Photoshop Album 2.0. It will automatically detect if you have either of these
two catalogs. This is found  by selecting File > Import from Elements or File >
Import from Album. You can also import from a backed up catalog.

A final way to import is to use Auto Import to set up a watched folder. After it is
set up, any image put into that folder is automatically imported into Lightroom.
This is useful if your camera allows for tethered shooting. You can set up your
camera’s tethered shooting software to have it place each image from the camera
into the watched folder as you shoot it. To set up this feature, go to File > Auto
Import > Enable Auto Import. There you will specify which folder will be
watched. Note that it must be empty when you set it up, or the Auto Import fea-
ture will not work. Then you tell Lightroom where to put the images, how to name
them, and whether to apply any special development, metadata, or keywords as
you import them.
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Figure 5.25

Import Photos 
Preview display.



Grid, Loupe, and Compare Views
Figure 5.26 is the Library Module in Grid view with the two side panels closed
and out of the way. To get to the Grid view, use the far left button on the toolbar
that looks like a grid. You can also get to Grid view by pressing G or by selecting
View > Grid View. In the Grid view, you can control the size of the thumbnails.
On the toolbar, you can see the Thumbnails slider (refer to Figure 5.25). If you
can’t see the toolbar, you can toggle it on and off by pressing the T key. If you want
to rearrange your images, you can simply click on the Sort menu in the toolbar
(see Figure 5.27). Clicking on the staircase icon reverses the order of the sort.
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Figure 5.26

Grid view in the Library Module.
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Figure 5.27

Sort popup menu.

Figure 5.28

Loupe view.

After selecting the image that you would like to see larger, move to the Loupe view
by pressing the second icon from the left on the toolbar (see Figure 5.28). It looks
like a blank gray box. You can also get there by pressing E or by selecting View >
Loupe View. The easiest way is to simply double-click on the image that you
would like to see larger or hit the spacebar.



If you would like to compare two images at a time, click each image in Grid view
while holding down the Command key (Ctrl key for PC), if the images are not
located next to one another (or holding down the Shift key if they are). Then move
to Compare view by clicking on the third icon from the left on the toolbar. It is
two gray boxes, one with an X in it and the other with a Y in it. If you want to
compare more than two images, use the next button to the right (three rectangles
and three dots within a larger rectangle).

If you move the side panels out of the way by clicking on their arrows, it will give
you more screen space to see the images. Figures 5.29 and 5.30 show a compari-
son of two images and four images, respectively. Clicking on the X at the bottom
right of any image will remove that image from the screen (and it will also set the
Reject Flag). This way, if you are trying to decide which of the images you like the
best, you can remove one at a time until your favorite is left.
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Figure 5.29

Comparing two images.



Once you have two images in Compare view, clicking on either image will enlarge
both images, and the enlarged view will be centered on the spot that you clicked.
If you want to move just one image over while they are enlarged, click on the small
lock icon in the toolbar. This will unlock the two images from one another, and
you can drag one of them so you can line up the enlarged view the way you want
to see it. Click on the lock icon again, and they will be locked back together in
the new relationship. If the images are locked together, you can use the cursor to
drag the images around to look at the enlarged view. Both images, if locked, move
in unison. Clicking on either image will enlarge the images to the setting that you
have selected in the left Navigator Panel. You can also use the Zoom slider (to the
right of the Lock icon) in the toolbar to enlarge the images.
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Figure 5.30

Comparing four images.



In Compare view, you can click on the rating flags, the color labels (a popup color
menu will appear if you click on the small gray box next to the rating flags), the
rating stars, or the X that deselects the photograph from the group that you are
working on. You also can click on the Sync button to sync the two images so that
changes will apply to both (refer to Figure 5.29).

The toolbar can be toggled on and off by pressing the T key. If you forget the key
command, you can select View > Show Toolbar or View > Hide Toolbar from the
main menu bar. It also shows the keyboard shortcut. In Grid view, the left side of
the toolbar shows the icons for (left to right) Grid view (a button that looks like
a grid), Loupe view (a blank gray box), Compare view (two gray boxes that have
X and Y in them), Survey view (displays multiple images), Sort Direction (looks
like a staircase), Sort By (with a drop-down menu to allow sorting by Capture
Time, Import Order, Rating, or several other choices), flags to accept or reject
images, colored labels, and a Thumbnails slider to choose the size of thumbnail
images (see Figure 5.31).

In Loupe view, the toolbar is slightly different, as seen in Figure 5.32. Besides the
buttons to jump between Grid view, Loupe view, Compare view, and Survey view,
there are a series of stars for rating purposes, the same two flags for selecting or
rejecting images, and two arrow icons to rotate the image. You can also choose to
add other features and customize your toolbar (see Figures 5.33 and 5.34).
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Figure 5.31

Left side of toolbar in Grid view.

Figure 5.32

Left side of toolbar in Loupe view.



In any of the Library Module views, you can rotate the images, flip them, or show
them as a mirror image. The rotation is done by clicking on the individual rota-
tion arrows on each image in Grid view or by enabling rotation on the toolbar.
Flipping is done by selecting one of the Flip options from the Photo menu. Mirror
image is set in the View menu with Enable Mirror Image Mode. This will show
the mirror image of all images. The primary purpose of mirror image is to show
portraits to a client or to family members. Most people are used to seeing them-
selves in a mirror and a mirror image looks more natural to them. Clicking on it
again returns all images to the regular view.

In Grid view, you may see a question mark (?) in the corner of your images. This
means that Lightroom has lost track of the location of the original images. You
may have moved the originals, or you may have referenced them on a CD/DVD.
In any case, click on the question mark, click on Locate in the popup menu, and
then navigate to the location of the image(s).
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Figure 5.33
Toolbar drop-down menu showing all of the toolbar options checked. 

Figure 5.34

This is the toolbar with all options selected in the drop-down menu in the previous figure.



Navigator Panel
The Navigator Panel is located in the upper left of the Library Module. Opening
it up, it will show you the selected image in a small box. If it is blank in Grid view,
it simply means that you haven’t selected an image yet. Click on an image in Grid
view, and you should see what is shown in Figure 5.35.

If you click once on the image showing in the Navigator Panel, the main 
window will switch from Grid view to Loupe view, as shown in Figure 5.36.
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Figure 5.35

Navigator Panel.

Figure 5.36

Navigator Panel and Loupe view.



Clicking again on the image, either in the Navigator Panel or the Loupe view
image, will enlarge it to either 1:1 or another view, depending on which option
you had set in the Navigator title bar and its drop-down menu. You can also set
FIT or FILL. If you set FIT, the longest dimension of your image will fit into the
Loupe view so you can see the entire image. If you select FILL, it will use all of
the space available to show your image. Click on the down arrow at the right of
the Navigator title bar and a drop-down menu will appear, giving you a choice of
different size views. There are eight choices in all, from 1:4 to 11:1. Figure 5.37
shows the 1:1 view.

The other thing to notice in Figure 5.37 is the small white outline box on the
Navigator Panel preview. The box shows the area of the image you are viewing in
the Loupe view; you can easily drag the white box where you would like. Thus we
have the term “Navigator.”
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Figure 5.37

Navigator showing 1:1 image in Loupe view.



In Figure 5.38, everything is the same, except the 4:1 view is selected on the
Navigator title bar, rather than 1:1. Notice how the corresponding box has got-
ten much smaller on the Navigator preview image. When you are moving the
small box around, the cursor will change to a plus sign (+) to show you where the
cropped view will be centered. When you move the cursor to the edge of the box
so you can drag it around, it changes to a hand.

There is yet another function for the Navigator. If you drop your cursor down
over the Filmstrip images at the very bottom of the screen and move it along (no
clicking required), you will see an enlarged version of the image in the Navigator.
This way you can maximize the screen real estate, keeping the Filmstrip very small,
and yet be able to see a larger view of the image easily and quickly. If you move
your cursor back to the main window, the Navigator returns to show the image
highlighted in Grid view or on display in Loupe view. 
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Figure 5.38

Navigator with 4:1 image in Loupe view.



Toolbar
The toolbar is found at the bottom of the main window (see Figure 5.39). It can
be toggled on and off by using the T key. If you forget the key command, you can
select View > Show Toolbar or View > Hide Toolbar from the main menu bar. It
also shows the keyboard shortcut. 

If you close both side panels, then the toolbar becomes longer, as shown in Figure
5.40. You can use the toolbar’s drop-down menu by clicking on the down arrow
on the far right of the toolbar to select the items you want to show in the toolbar.

In Grid view, the left side of the toolbar shows the icons for (left to right) Grid
view (a button that looks like a grid), Loupe View (a gray box with a darker gray
box in the center), Compare View (two gray boxes that have X and Y in them),
Survey View (several darker gray boxes inside a gray box), Sort Direction (looks
like a set of stairs), Sort By (with a drop-down menu to allow sorting by Capture
Time, Rating, Import Order, or a number of other options), Keyword Stamper
(looks like a rubber stamp), a box to type the keywords in, rating stars, selection
flags, color labels, rotation arrows, select arrows, and a slider to choose the size of
the thumbnails (see Figure 5.41). Note the slightly different functions available,
depending on if you are in Loupe view or Grid view. 
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Figure 5.39

Toolbar in Loupe view set small with the two side panels open.

Figure 5.40

Toolbar in Loupe view set large with the two side panels closed.

Figure 5.41

Toolbar in Grid view set large with the two side panels open.



Using the Sort By drop-down menu, you have the
option of sorting by Capture Time, Import Order,
Edit Time, Edit Count, Rating, Pick, Color Labels,
File Name, File Extension, File Type, or Aspect Ratio
(see Figure 5.42). The staircase icon to the left of Sort
By displays the sort order. You just have to click on the
icon to change the sort direction (see Figures 5.43 
and 5.44). 

Go to the far right of the toolbar and click on the small down arrow. Here is where
you select the items to be included in your toolbar (see Figure 5.45). You can
choose from Sorting, Keyword, Rating, Pick, Color Label, Rotate, Navigate,
Slideshow, Thumbnail Size, and Info. Note how the toolbar changes based on 
your selections. 
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Figure 5.42

Toolbar Sort By menu.

Figure 5.43

Sort Direction tool tip showing ascending order.
Figure 5.44

Sort Direction tool tip showing descending order.

Figure 5.45

Toolbar menu.



The toolbar shown in Figure 5.46 has the minimum selections. All of the choices
have been turned off, leaving only the first four icons for selecting the view of the
Library.

With the Thumbnails slider, you can vary the size of thumbnail images shown in
Grid view of the Library Module. The thumbnails are enlarged to fill the space
evenly. The number of images you can see in a row are determined, in part, on
the size and resolution of your monitor. The monitor shown here is a 22 LaCie
electron 22 blue IV with its resolution set at 1152 x 864. At the slider’s minimum
setting, this shows 10 images in one row of the main window with the two side
panels closed for more space (see Figure 5.47).
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Figure 5.46

Toolbar with minimum selections.

Figure 5.47

Grid view Thumbnail size at minimum.



When the slider is moved to the maximum value, notice that there are only two
images showing (see Figure 5.48). If you close one of the side panels, and the image
is a horizontal image, then the size of the thumbnail image will be larger than if
the panel is opened up. In that case, it will reduce the size of the horizontal image
enough so that two images will fit. Experiment with these settings until you get
your workspace set up the way that you like it. You may have different settings
that you use for different types of work or at different points in your workflow.
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Figure 5.48

Grid view Thumbnail size at maximum.



Keywords and Tags
Keywords, sometimes called tags, are a way to quickly find the photographs you
are looking for out of many thousands in your system. You can assign keywords
as you upload your images. This works easily if all of the images are of the same
thing. You can specify the location if you are visiting one spot. Or you can key-
word all of the images with the name of the bride and groom for a wedding or the
subject’s name in a portrait session. You can also assign keywords later, either indi-
vidually or in a group. 

The Keyword Panel is in the left panel collection of the Library Module. All
of your keywords are listed there in alphabetical order. In Figure 5.49, notice
that it doesn’t matter if the keywords begin with a capital letter or a lower-
case letter, they are still in alphabetical order.

Next, open the Keywording Panel on the right side of the Library Module
(see Figure 5.50). There you will see a listing of the keywords applied to any
image that is highlighted. In this example, you can see a highlighted image
of a dog and the keywords are “Belgian Malinois” (the breed of dog) and
“dog.” To create a new keyword, you can simply type it in the Keyword Tags
text box. You can also use the Keyword Tags Panel on the left side of the
screen. Click on the plus sign (+) sign and a Create Keyword Tag dialog box
pops up. Type in the keyword tag and include any synonyms to be added.
The synonyms will be included in the Implied Keywords text box in the
Keywording Panel. Check the appropriate boxes to indicate which keyword
tags are to be included with the image when exporting, and then click on
Create. You can also rename keyword tags by Control-clicking (Mac) or
right-clicking (PC) on the keyword tag in the Keyword Tags Panel and
choosing Rename. Then type in the new word and click outside the box to
finalize the change.

Another way to create keyword tags is to use a
word processing (or similar) program to create text
files. You can import these text files using the main
menu Metadata > Import Keywords. Then use the
resulting dialog box to navigate to the text file loca-
tion and import them. You can export the keyword
tags from Lightroom in a similar manner.
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Figure 5.49

Keyword Tags Panel.

Figure 5.50

Keywording Panel on the right side of the Library Module.



In Figure 5.51, three highlighted images are sitting next to each other. The first
image is the most selected so it is the lightest color. The other two images are
slightly darker gray, but are selected also. If there were any non-selected images (as
in Figure 5.52), they would have been a still darker gray.

In Figure 5.51, one image is of two
firefighters and the others are images
of a dog. Now look at the Keyword
Tags box. You see the keywords
“Belgian Malinois*,” “dog*,” and “Fire
fighting*.” The asterisk (*) displays
the following comment in the yellow
tool tip: “An asterisk (*) means a tag is
applied to only some of the selected
photos.” This lets you know that all of
the keywords do not apply to all of the
images.

How do you apply keywords to your images? Like many things in Lightroom,
there are several ways:

■ Assign keywords on import with the File > Import Photos menu. 

■ Click on the images that you want to assign Keywords to Grid view in the
Library Module. Type the keyword in the Keyword Tags text box on the right
side of the screen. As you start to type the keyword, if it is already in your key-
word list, Lightroom will fill it in. This also helps to keep you from making
an error. If you are not watching and type the keyword incorrectly, it will add
the misspelling to your keyword list.

■ You can highlight the images you want to keyword and then drag the key-
words from the Keyword Tags Panel on the left side directly onto one or a
selected group of the images.

■ You can copy and paste keywords from a spreadsheet, word processing docu-
ment, or keywording program directly into the Keywording Panel on the right
side of the screen.

■ You can set up a Preset (called a Keyword Set) for keyword groupings that you
often use. This is done by using the Set function in the Keywording Panel.

■ You can use the Keyword Stamper function in the toolbar to stamp a keyword
shortcut on images. Make sure that Keyword is checked in the toolbar drop-
down menu and then click on the rubber stamp icon. The keyword tag shown
in the box next to the icon will be used, or you can fill in the popup menu
that appears if that box is empty. Put the tool back into the toolbar when you
are finished by clicking on the empty circle where it resides.
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Figure 5.51

Keywording Panel with multiple images highlighted.



In Figure 5.52, the word “deer” is dragged to the three highlighted images. Even
though only the middle image has a black box around it, all three images are 
highlighted and the keyword “deer” has been added to all three images. The image
count in the Keyword Tags Panel went from 1 to 4, showing that it worked.
Unfortunately, you can only drag one keyword at a time, but it does go very
quickly to drag and drop.

As a test, this manuscript and Lightroom were both open on the same computer.
The following words—run, blurred—were copied from this manuscript and
pasted directly into the Keywording Panel. In the
Keyword Tags text box, click at the end of the list of
existing words (Belgian Malinois, dog), and the list
will be highlighted. If you click again, you can add
a comma and either start typing your new keywords
or paste any keywords you have copied from another
program. Figure 5.53 shows the results. You can see
that the two new keywords were successfully added
to the images by comparing Figure 5.50 before past-
ing in the words, and Figure 5.53 after pasting in the
new words. All of the keywords are still highlighted
in the example.
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Figure 5.52

Dragging a keyword from the Keyword Tags Panel to three highlighted images.

Figure 5.53

Keywords pasted into the Keywording Panel.
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Lightroom also added blurred and run to the Keyword Tags Panel on the left, as
shown in Figure 5.54. Note the keywords that apply to the image highlighted in
Figure 5.53 (do00575.jpg), including the two new keywords that have just been
added, have check marks by them. This copy and paste allows you to keep an
organized, controlled vocabulary so that you always use the same words. You can
also keep synonyms, which are added automatically by copying them from your
spreadsheet or a hierarchical keywording program. This makes the Lightroom 
keywording function very powerful. When you hover your cursor over the list of
keyword tags (without clicking on one) all of the images that have that keyword
tag will have a thin white line around the image, as shown in Figure 5.55.

Keyword tags can be children of other keyword tags (similar to the nested folders
concept). When you apply one of the child keywords, the parent keyword is also
applied. The parent keyword doesn’t show in the Keywording Panel. It is just
added to the file on export. As an experiment, export an image that you have key-
worded with parent and child keywords (be sure not to check Minimize
Embedded Metadata in the Export dialog box that comes up after clicking on the
Export button), and then open the image in Photoshop. After it is open, in
Photoshop choose File > File Info, and look at the keywords that are included with
the exported image.

The Macintosh version of Lightroom
has the ability to spell-check the 
keywords. This is reached through
the Edit > Spelling menu. You can
ask it to check spelling as you type
or check a particular selection of
keywords. You can add or remove
words to or from the Lightroom 
dictionary as necessary through the
dialog box that pops up when
Lightroom finds a word it doesn’t
have in its dictionary.

Figure 5.54

Keyword Tags Panel showing 
new keywords added.

Figure 5.55

When you hover your cursor over a keyword in the Keyword Tags Panel, images that
contain that keyword appear with a thin white line around them.



Search and Find
Now that you have been keywording your images, how do you use
them to find the right image? That is what searching is all about.
The search function in Lightroom is called Find, which is located
in the Find Panel on the left side of the Library Module (refer to
Figure 5.5). This Find Panel works in conjunction with the Library
Panel right above it and the Folders Panel right below. First, you
need to decide if you want to search in All Photographs, in Quick
Collection, or in Previous Import. Once you highlight your selec-
tion in the Library Panel, move down to the Find Panel (see Figure
5.56; if the panel is not open, click on the triangle on the left to
open it). Decide if you want to search in Any Text or just in spe-
cific locations, such as File Name, Title, Caption, Keywords, IPTC,
EXIF, or Any Metadata. You do this by using the first drop-down
menu on the left (in Figure 5.56, it is showing as Any Text). Type
your keyword in the text box with the magnifying glass. Specify
how you want it to search in the Containing drop-down menu
(that is, Containing, Containing All, Not Containing, and so on)
You can also select a folder in the Folders Panel, and Lightroom
will only look in that folder (see Figure 5.55). You can select a date
or date range by selecting the With Capture Date  check box. You
can use the date or date range by itself or together with the 
text search.

Note that in this example, I have typed the word “dog” in the Find
Panel’s Any Text box. At the same time, I have highlighted the 
WEDDINGS folder. There are no dog images in that folder, so 
a zero is shown at the right of that line (see Figure 5.57). (There 
are also no images showing in the Library Module’s Grid view.) If
you look at the rest of the folders, it shows that there are several
folders that have dog images in them, as shown by the non-zero
image counts (see Figure 5.58). This is a helpful way to check
which folders have images with those keywords in them.
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Figure 5.56

Type your search term in the Find Panel. 
A tool tip pops up to remind you what to do.

Figure 5.57

Using keywords with the Folders Panel.



In the text box, you can type just part of a term and Lightroom will look for that
also. You can type more than one term and Lightroom will look for both terms.
It assumes “and” as a Boolean operator if you select Containing All in the drop-
down menu at the top right of the Find Panel. So, for example, if you type “John,”
Lightroom will find all of the photographs with the term “John.” If you type “John
Susan,” it will look for all of the images with both terms. They don’t necessarily
have to be together. It assumes you want to find “John” and “Susan.”

The images will appear in grid format if you are in Library Grid view. If you 
happen to be in Loupe view, no images will appear, but they will appear in the
Filmstrip if you have that displayed.
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Figure 5.58

Find has selected all images with dog in them.



Besides using Containing All, which implies “and,” you can select Containing
from the right drop-down list, which implies “or” (see Figure 5.59). In the previous
case, if you selected Containing and then typed “John Susan,”
Lightroom would look for all of the images that had either
“John” or “Susan” in them, not just the ones that had both
names in them. You can also select Not Containing,
Starting With, or Ending With as your search criteria.

When you are searching, if you have selected Any Text,
Lightroom will look for the terms in keywords, in your
IPTC data caption, in the folder name, in the file name,
and practically everywhere. Thus if you fill in a caption,
either when you import or at a later time, you do not need
to also put the word in keywords to have them searchable
in Lightroom. Figure 5.60 shows how you can limit your
search to only certain fields.

A fast way to search for images with only one keyword or tag is to use the Keyword
Tags Panel. Simply open the panel and click on one of the keyword tags. Make
sure that All Photographs has first been selected in the Library Panel. All of the
images with that keyword tag will appear in Grid view and in the Filmstrip. You
can then refine the search by using the Find Panel text field and With Capture
Date option.

Find goes hand in hand with filtering. Part of the search
or filtering is done in the Filmstrip at the bottom of the
window. This is where you can filter your images by using
the rating stars, Pick Flags, and color labels. Click on any
one of the dots to change it to a star. You can see in Figure
5.61 that I have clicked on the third dot at the bottom of
the window, and it has changed to three stars. To remove
all stars, click twice on the first star. The first click sets one
star. The second click removes the first star. You can click
on the dots in the individual images (if you have that fea-
ture turned on) or in the toolbar by clicking on the light
gray stars. You can use the rating flags in the toolbar to
select or reject images as well. There are also color labels to help you sort your
images. All of these can be set using the Photo menu: Photo > Set Rating, Photo
> Set Flag, or Photo > Set Color Label. There are keyboard shortcuts as well, which
are shown in the Photo menu and under the Help menu. See Figure 5.98 at the
end of this chapter for a listing of most of the keyboard shortcuts for the Library
Module. To see any of these, make sure that you have set the appropriate settings
in the Library Module options by selecting View > View Options > Grid View >
General.
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Figure 5.59

Find Panel search criteria drop-down menu.

Figure 5.60

Find search limit menu.



Now only the three images with the keyword “dog” in them and that are rated
three stars or greater are shown in both the Filmstrip and Grid view (see Figure
5.61). This acts as an additional “and” for your search. So in our previous search,
typing “Susan John” in the text box and clicking on the third dot makes Lightroom
search for all images rated three stars or more that also have Susan and John (not
Susan or John) in the keywords or caption information. You can change “and
higher” by clicking on the drop-down menu, as shown in Figure 5.62.

Now you can choose from And Higher, And Lower, and Only. This helps you nar-
row down your search. To get rid of the stars altogether and search on all images
no matter what their rating is, click on the first star twice. The first click will drop
the rating down to one star. Another click will remove that one star. If one star is
already chosen, then only one click is necessary.
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Figure 5.61

Clicking on the third dot in the Filmstrip changes the dots to three stars and filters the images in the Find Panel based 
on the rating you have given.

Figure 5.62

The Star Ratings drop-down menu.



The search options (Hidden Photos and Photos from Sub Items) from the Public
Beta  have been replaced by the rejection flag (keyboard shortcut is the X key). To
display those rejected images, use the Filter in the Filmstrip (not the toolbar) and
click on the flag with the X on it.

Figure 5.63 shows the right side of the Filmstrip bar. Notice the double arrows to
the left of Filters. If you don’t see anything after the word Filters, as shown in
Figure 5.64, then click on the double arrows to reveal the filters. In Figure 5.64,
you can see the tool tip. Also pay attention to the gray box to the far right of the
Filmstrip bar. It is actually a switch. The up position means the filters are on, and
the down position means they are off.

You can also find images by using the Metadata
Browser Panel (see Figure 5.65). If you open the
Metadata Browser (on the left side of the screen
under the Keyword Tags Panel), you will see that
you can search for images by Lens, Camera,
Creator, Date, File Type, and Location. Clicking
on the arrows on the left will open up these meta-
data groups. Under Date, for example, you can open up subfolders of year, month,
and day. In some cases, the information is added by you (Creator and Location).
In other cases, the camera will have already saved information in the Metadata
Browser before you import the photographs. These are very powerful options that
will help in the organization and operation of your images, especially as the num-
ber increases to thousands of images. You can first select keyword tags and then
use the Metadata Browser. Suppose you wanted to find all wedding images that
you created in 2003. First use the Find Panel and type in “wedding” (assuming
that you already keyworded all of your wedding images with “wedding” or
imported them in a folder that had “wedding” in its name). Find also searches the
folder name as well as the Keyword Tag field, which will allow you to search for
clients’ names or subject matter (if you use those in the folder names), even if you
haven’t keyworded the individual images.
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Figure 5.63

Filters on the Filmstrip bar.

Figure 5.64

Clicking on the double arrows
will reveal the filters on the
Filmstrip bar.

Figure 5.65

Metadata Browser Panel.



Library Module View Options
There are a number of ways for you to customize the way your Library Module
functions. To make changes, select View > View Options from the main menu.
There are different options for both Grid view (see Figure 5.66) and Loupe view
(see Figure 5.67). The following sections discuss the options for these two views.
For detailed information on what the various selections will do, please see Chapter 4,
“Desktop Layout.”
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Figure 5.66

Library View Options: Grid view.

Figure 5.67

Library View Options: Loupe view.



Quick Develop
The Quick Develop Panel lets you quickly get images ready to view. Although you
can do more detailed processing in the Develop Module, Quick Develop is the
only way to process a group of images at once. In the Develop Module, you can
work on only one at a time.

Any changes you make to the image will be shown in the Histogram Panel above
the Quick Develop Panel (see Figure 5.68). It is recommended that you start at
the top with your adjustments, adjusting Exposure first, then Recovery (to recover
some lost highlights), then Fill Light (to fill in some of the shadow areas), and so
on. The single arrow moves the control just a little, the double arrow moves it a
greater amount. If you want to reset all of the settings, click on the Reset button
at the bottom of the panel. If you wish to reset only one setting, click on the con-
trol’s name (such as Exposure or Recovery). You can also try Auto Tone to see how
it works on a particular image. Sometimes it will work great, and other times you
will need to tweak each image individually.

Clicking on the double arrows to the right of Preset and WB (White Balance)
either opens or closes those sections to show or hide more information and 
controls (see Figure 5.69).
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Figure 5.68

Histogram and Quick Develop Panels.

Figure 5.69

Quick Develop Panel with all sections open.



You can set the white balance using the drop-down menu shown in
Figure 5.70. This menu is probably similar to the one on your digital
camera. You can also just tweak it a bit to get it very close to what you
need without having to move to the Develop Module. Using the left
arrows in the Temp (temperature) control under the WB makes your
image “cooler” by adding more blue, while using the right arrows makes
your image “warmer” by adding more red/yellow to your image(s).

To create a quick black-and-white (grayscale) image or other toned
images, click on the Preset down arrow. This will give you a drop-down
menu, as shown in Figure 5.71. Clicking one of these options will give
you a quick idea of what a black-and-white image will look like. For more
detailed work, go to the Develop Module by clicking on the Module
Picker at the top or pressing D. You can create custom presets in the
Develop Module.

The Crop Ratio setting allows you to see how a different cropping
ratio will affect your images (see Figure 5.72). For example, using an
8×10 crop will cause you to lose some of the image, resulting in a
much more squat or square image than the regular format that a typ-
ical digital camera uses. Choosing 8 x 10 will crop equally off the top
and bottom of your image. Of course, you may want to move the
crop around to exactly suit your image, which you can do in the
Develop Module (click on the Crop Overlay icon, it is the one to the
left of the eyeball, in the toolbar once you are in the Develop Module;
see Chapter 6 for more information on the Develop Module). Using
the Crop Ratio options just gives you a quick idea.
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Figure 5.70

White Balance drop-down menu.

Figure 5.71

Preset drop-down menu.

Figure 5.72

Crop Ratio drop-down menu.



If you want to apply one image’s settings to a group
of other images, Lightroom has a feature to do this.
First, select the images you want to apply the settings
to, and then click on the image you wish to use the
settings from without deselecting the other images.
The last one selected will have a lighter border (slide
mount) than the others. This is the one that the 
settings will be taken from. Clicking on the Sync
Settings button (on the bottom of the right side 
panels next to the toolbar) brings up the Synchronize
Settings dialog box, shown in Figure 5.73. You can
select from many of the Develop settings to copy them,
and then use the Sync Settings button to apply 
them to another image. You can highlight more than
one image and paste the settings into any number of
images at the same time. 

The Paste Settings from Previous option (see Figure 5.74) allows you to reuse the
settings you previously selected. To get to that function, select Photo > Develop
Settings > Paste Settings from Previous, or you can use the key commands
Option+Command+V (Mac) or Alt+Ctrl+V (PC). You can also just copy 
the settings in the same Develop Settings menu or by using the shortcut
Shift+Command/Ctrl+C and then paste them with Shift+Command/Ctrl+V. You
don’t have to reselect the items, as Lightroom remembers the settings. If you still
have more work to do on an image, you can easily move to the Develop Module
by pressing D, or using the Module Picker. You can also use
Command (Mac) or Ctrl (PC) plus a number to move
between modules. Command/Ctrl+1 takes you to the Library
Module, Command/Ctrl+2 takes you to the Develop Module,
and so on. There are many ways to do the same thing in
Lightroom!

What is metadata? Metadata is the information that is added
to an image. It includes things such as keywords, copyright
information, color space, resolution, information about the
camera and exposure, and many other items. All of this
information is stored in XMP sidecars (files with the same
name as the original but with the .xmp extension) for raw
files and within the file format for JPEG, TIFF, PSD, and
DNG file formats. You can specify that the metadata be 
written to XMP or just to the Lightroom database. (See the
“Metadata” section later in this chapter.)
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Figure 5.73

Synchronize Settings dialog box.

Figure 5.74

Photo > Develop Settings submenu.



Metadata can be synced or copied and pasted in the same way as the Develop set-
tings can be. After the images are selected, click on the Sync Metadata button to
the right of the toolbar (see Figure 5.75). The Synchronize Metadata dialog box
will appear, as in Figure 5.76, and you can fill in information and specify which
items are to be copies. You can also select Metadata > Copy Metadata or Metadata
> Paste Metadata from the main menu or use the keyboard shortcuts
(Option+Shift+Command/Ctrl+C or V). The entire menu does not fit on the
screen at once, so you will need to scroll down to see the rest of it. Note that in
the case of both Sync buttons (Sync Settings and Sync Metadata), you need to
have two or more images selected or the buttons will be grayed out.
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Figure 5.75

Sync Metadata button.

Figure 5.76

Synchronize Metadata dialog box.



Info Overlay
There is a way to display information about an image that Lightroom calls Info
Overlay (see Figure 5.77). You can choose three information items from a num-
ber of choices to show with your image while you are working on it in Loupe view.
It does not work in Grid view. Info Overlay is accessed from the main menu View
> View Options > Loupe View > Show Info Overlay. You can make up two image
presets and switch between them as needed. You can leave it on all of the time in
Loupe view or only have it come on for a few seconds as you change images. See
Chapter 4 for more specifics on the settings. The figure shows what the overlay
looks like in the upper left.

Besides the Info Overlay, there are icons available in Grid view and on the
Filmstrip (if the images are large enough) to show you the state of your images.
Three icons are used. A series of lines in a diagonal figure that looks like a tag indi-
cates that you have added keyword tags to your image. A series of dots in a square
means that the image has been cropped. The +/– indicates that the image has been
adjusted with Quick Develop or Develop settings. Take a look at Figure 5.78 to
see an image with the three icons.
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Figure 5.77

Info Overlay example.

Figure 5.78

From left to right, the image icons indicate that
keyword tags have been added, cropping has been
done, and Develop settings have been adjusted.



Metadata
Metadata is information stored either within the image file (for JPEG, TIFF, PSD,
and DNG files) or in a separate XMP sidecar with the same name except for an
.xmp extension (for all camera raw formats). Going into metadata completely could
warrant a book of its own. Here, we are concerned with the EXIF information
that your camera records with your image. This includes things such as focal
length, ISO, shutter speed, and f-stop. We are interested in the IPTC information
that you can add, such as a caption, copyright information, contact
information, and URL. Underneath the Keywording Panel is the
Metadata Panel. Clicking on the down arrow to the left of Metadata
will produce a drop-down menu (see Figure 5.79).

The Metadata drop-down menu is used to select which of the metadata
fields you want to display in the Metadata Panel. Figures 5.80 through
5.85 give you an idea of the various types of information, as well as the
groupings that can be displayed.
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Figure 5.79

Metadata Drop-down menu.

Figure 5.80

Metadata: Default. 

Figure 5.81

Metadata: All. Only the top half 
of the menu shows. You must scroll 
down to see the rest of the metadata. 
The small triangle at the bottom 
shows that the menu continues.

Figure 5.82

Metadata: EXIF.



Note the arrows to the right of File Name and Folder. Clicking on the File Name
arrow takes you to the Rename Photo dialog box. Clicking on the Folder arrow
will open the Folders Panel on the left side and show you the folder where the
image you selected resides. A number of the fields in the Metadata Panel have
arrows to the right of them. Clicking on an arrow will either open up a submenu
or dialog box or show you information in the Metadata Browser Panel on the left
side of the screen.

Entering this information for each image can be quite cumbersome. You can use
the presets in the Import Photos dialog box (select File > Import Photos or use

the Import button in the lower left of the Library
Module) if you wish. Or if you prefer, you can
create a preset in the Library Module to add to
the metadata after import. This is accessed
through the Preset drop-down menu at the top
of the Metadata Panel.

To create a new preset, click on Save as New
Preset in the Preset drop-down menu and then
fill in the boxes, including a name for the preset.
Then you can instantly apply the information to
one or many images at the same time. It depends
on the type of photography work that you do as
to how much time this feature can save you.
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Figure 5.83

Metadata: IPTC. Only the top 
part of the menu shows. You must scroll
down to see the rest of the metadata
display. The small triangle at the
bottom shows that the menu continues.

Figure 5.84

Metadata: Minimal.

Figure 5.85

Metadata: Quick Describe.
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If you click the arrow next to the Date
Time field, as shown in Figure 5.86, an
Edit Capture Time dialog box will pop
up. This allows you to fix capture times
that are wrong due to time zone changes,
daylight savings, or other reasons. You
can also use the arrows to change the
file name, relocate the image folder, or
see the Camera, Creator, and Location
fields in the Metadata Browser Panel on
the left.

Putting information in metadata
ensures that it will always travel with
your images. It will be embedded when
you export your images. This is especially valuable if you send digital image files
to clients. They will be able to track who created the images and, if you filled out
the proper metadata fields, how to contact you.

Export
Exporting is how you get your images out of Lightroom. Some people get con-
fused because there is no way to save images in Lightroom. But you don’t need to
save images because your original images are not touched after you import them.
So there is nothing to save! When you adjust an image in some way, you are not
changing it, you are merely writing instructions so the computer can properly
adjust the image for the screen or when you export it. These instructions are saved
continuously, so you don’t need to worry about them. When you need an image
outside of Lightroom, you can export it in one of the following ways:

■ Click the Export button to the left of the toolbar in the Library Module.

■ Select File > Export from the main menu.

■ Use the keyboard shortcut Shift+Command/Ctrl+E.

The Export dialog box allows you to export your images out of Lightroom (see
Figure 5.87). You tell it the destination by clicking on the Choose button and 
navigating to that location. You can have it create a subfolder in that destination
and name it. You can name the files just like in the Import Photos dialog (see the
previous “Import” section for more details).

Figure 5.86

The Edit Capture Time dialog box.



You have a choice of four file formats: JPEG, PSD, TIFF, and DNG as shown in
Figure 5.88. Along with the file format, you can move the Quality slider from 0
to 100 for JPEGs. For PSDs you can specify a bit depth of 8 or 16 bits. With TIFF
you can specify either an 8- or 16-bit depth and the compression (none, LZW, or
ZIP). There are no additional settings for DNG.

You can also choose from three color spaces (see Figure 5.89): sRGB (used for the
Web and for some printing labs), AdobeRGB (the current defacto standard for
many purposes), or ProPhoto RGB (the color space used by Lightroom, which is
a very wide space). After choosing color space, you can constrain the size of the
output. You do this by specifying the size of a box into which you want all of your
images to fit. You can specify pixels, inches, or centimeters. Typically, you would
create a square box by setting 600 pixels by 600 pixels, for example. That way 
both horizontal and vertical images will be the same proportions. One might be
640×480 and the other 480×640. You can also set the resolution in pixels per
inch or pixels per cm. If you select the Minimize Embedded Metadata check box,
Lightroom only includes copyright information in your exported image and leaves
out the rest of the metadata. This makes the exported file slightly smaller, and 
it strips out all of the camera EXIF data, as well as any IPTC metadata that you
have entered.
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Figure 5.87

Export dialog box.

Figure 5.88

File Format choices.

Figure 5.89

Color Space drop-down menu.



After exporting, you will have a choice to perform an action. You specify this
action under the Post-Processing section. Using the After Export drop-down
menu, you can choose None, Show in Finder, Burn the Exported Images to a Disc,
Open in Adobe Photoshop, or Go to Export Actions Folder Now.

Finally, at the bottom-left corner of the dialog box, it tells you how many photo-
graphs will be exported. This is based on how many images you selected in Grid
view. It is a good idea to double-check the Grid view to make sure you selected
the images you want to export or to check that you didn’t accidentally select all of
the images in your library.

Photo Binders
In the Public Beta release of Lightroom, a feature called Photo Binders was set up
to move entire data libraries to other computers and to back them up. Sadly, this
concept did not make the cut for Lightroom version 1.0. Perhaps it will be back
in a future version.

Impromptu Slideshows
If you want to quickly set up a slideshow, there are several ways to do it (of course).

Method 1

1. Adjust your images with Quick Develop so they look pretty good.

2. Select Grid view.

3. Highlight the images you want to show. If you want to view them all, you
don’t have to highlight them.

4. In the toolbar below the window, make sure that Slideshow option has been
turned on by clicking on the far-right arrow for the popup menu and selecting
Slideshow. 

5. Click on the Play arrow in the center of the toolbar (see Figure 5.90). That’s
all you need to do. The slideshow will play based on the parameters you set
up in the Slideshow Module. Hit the Escape key to stop the show.
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Figure 5.90

Slideshow options on the toolbar.



Method 2

1. Adjust your images with Quick Develop so they look pretty good.

2. Go through your images and press the B key for each image you want in the
slideshow. If you want them all, highlight them all and press B. This places
all of your images into Quick Collection.

3. Press the Command/Ctrl key and then Return/Enter (or go to the main menu
and select Window > Impromptu Slideshow), and it will start playing. The
slideshow will play based on the parameters you set up in the Slideshow
Module. Hit the Escape key to stop the show.

Here are some simple commands to use while your slideshow is playing:

■ Press the spacebar to pause. At the lower left of the slideshow image, a small
Pause icon will appear. When you hit the spacebar again, the icon turns into
the Play icon and the show resumes.

■ Use the right and left arrow keys to cycle through the show one image at a
time after you have paused it.

■ Press the spacebar again to restart it playing.

■ Press the Delete key to remove an image from the slideshow. It is not deleted
in any other way. When you stop the slideshow, you will see all of the images
highlighted, except the ones you deleted in this way.

■ Click on the image or press Escape to cancel the show.

■ Adjustments to music, speed, and so on can be done in the Slideshow Module.

Virtual Copies
Virtual copies are a great concept, allowing you to have as many versions of your
image as you would like. Each version can be developed separately. A virtual copy,
as the name implies, is not a separate image, but metadata that tells Lightroom
how to process the original (which is always left unchanged) in a different way.
For example, you can show a client color, sepia, and grayscale versions of an image
easily, quickly, and without taking up three times as much storage space. It is easy
to create virtual copies. Simply select the image or images that you wish to copy,
and then Control-click (Mac) or right-click (PC) on one of them with all of the
images selected. A menu will pop up, as shown in Figure 5.91. 
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After the copy is created, the original, also called a master, has a number in the
upper-left corner (see Figure 5.92) to indicate how many images are in this new
stack (see the “Stacks” section later in this chapter). To the right of the image is
the virtual copy. You can tell which image is the copy by the little turned page icon
in the lower-left corner. Also notice that both images have the same name above
the image. A virtual copy can only be created in Grid view in the Library Module
or in the Filmstrip in any module.

Since virtual copies are automatically stacked with masters and originals, if you
want them to be separate, for example, to show a client all grayscale versions at
once, set up a Collection and drag the virtual copies to the Collection immedi-
ately after you have created them when just the virtual copies are highlighted. This
can save a lot of time if you have many images. Otherwise, you have to go back
and select each virtual copy and drag it into the Collection. You can also select
User Order in the toolbar Sort drop-down menu and drag the images together in
the pattern or grouping that you would like. Note that User Order will only appear
in the lowest level folders (that is, folders that have no subfolders in them) or
Collections.

You can create virtual copies in a Collection, but the copies will not be automat-
ically stacked in the Collection. If you go back to the folder that holds the original,
you will see that the virtual copy you created in a Collection has also been placed
in the same folder that holds the original and master. It has also been stacked in
the folder, even though the work was done in a Collection.
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Figure 5.91

Popup menu to create virtual copies. 

Figure 5.92

Original image and virtual copy.



Stacks
Stacks are a method of grouping images together to make it simpler to edit
and manage your library. When you create virtual copies, they are stacked
automatically. You can also manually stack images. For example you might
have a number of variations of a portrait pose or a landscape. By stacking sim-
ilar images, it can make a session of hundreds of images more manageable.
With Virtual Copies, the original is automatically the top image of a stack. To
change that, merely drag the stacked images into the order that you would
like them stacked when the stack is collapsed. The selected image will be the
top image in the stack. Hovering your cursor over the number in the upper-
left corner of the image will show you that the image is 1 of 3 total images,
for example (see Figure 5.93). Going to the other grouped images (that won’t
have numbers in the upper left) and hovering the cursor over the upper-left
corner, the numbers 2 of 3 and so on will appear (see Figure 5.94). Clicking
on that number in one of the stacked images will move it to the top of the
stack. Clicking on the number on the top image, which shows the total number
of images in the stack, will collapse or expand the stack.

Stacking can be done in Grid view in the Library Module when you are in a folder,
but it cannot be done if you are in a Collection. A virtual copy that is created in
a Collection is not automatically stacked in the Collection, but is automatically
stacked in the folder that holds the original image.

If you keyword the top image in a collapsed stack, the keywords will be added to
all images in the stack. However, any other changes, such as developing, color
labels, flags, or ratings, are only applied to the top image. If you try to add a 
collapsed stack to a Collection, only the top image will be added. To add all of the
images in a stack to a Collection, expand the stack, select the images, and then
add them to the Collection.
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Figure 5.93

A stack of three images collapsed.
The number in the upper-left
corner of the image tells how many
images are in the stack.

Figure 5.94

The same stack of three images expanded. Notice how the label shows up in the upper corner of the second 
image (2 of 3) because the cursor is hovering over that image, but in the third image there is no label.



To create a stack, select the images and Control-click (Mac) or right-click (PC) to
show a popup menu. Select Group Into Stack. Or you can select the images and
then select Photo > Stacking > Group Into Stack from the main menu. If the
option is grayed out, then it means you have either not selected the images or you
are in a Collection or other location that does not allow stacking. The main image
(most selected) that has the brightest highlighting will be the top image. This is
usually the image you selected first. Use the same menu to select a new top image,
to move an image up in a stack, or to unstack the images. You can use the same
menu to expand or collapse the stack you are working on or all stacks. You can
also use that menu to add or subtract images from a stack or to split the stack into
two parts.

The final way to stack photographs is to use the Auto-Stack feature (see Figure
5.95). This will stack your photographs based on the capture time. You can choose
a duration of zero seconds to one hour (see Figure 5.96). All images created within
that time period will be put into one stack. So, if you are doing portrait sessions,
you can automatically stack the images together that were all taken within per-
haps five minutes of each other.
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Figure 5.95

Auto-Stack menu item.

Figure 5.96

Auto-Stack dialog box.



Deleting Images
To delete photographs from Lightroom, you need to decide if you want to delete
the images entirely or just remove them from Lightroom. As with most things in
Lightroom, there are several ways to do this. First, highlight the image or images
that you want to remove. Hit Delete (Mac) or Backspace
(PC). Or you can choose Photo > Delete Photo(s) from the
main menu. The Delete/Remove dialog box will appear, as
shown in Figure 5.97. Remove will remove the image from
Lightroom, but not delete it. Delete will move the image to
the trash or recycle bin. If you select images and hit the for-
ward Delete key (Mac full-sized keyboard) or Delete key (PC),
the images will be removed from Lightroom but not deleted.

Library Shortcuts
Learning a few keyboard shortcuts can really speed up your workflow. There are
many, but you will find that in your personal workflow you will need to do the
same things over and over. Luckily, Adobe has provided a list of most of the key-
board shortcuts that apply to a particular module (see Figure 5.95). To find the
Library Module shortcuts, go to the main menu and select Help > Library
Shortcuts. Another way to bring them up is to use a keyboard shortcut (of course!):
Command (or Ctrl)+/ (Command+slash key). Play with them to find the ones
that fit best with your workflow and work style. To turn off the shortcuts, merely
click on it. Remember Rule 5 (Help > The Five Rules)!
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Figure 5.97

Delete/Remove dialog box.

Figure 5.98

Library Module shortcuts.





The Develop Module is where the processing work gets done (see Figure 6.1).
There is a huge variety of tools to help you bring your images to life quickly and
efficiently. The module is broken into various panels. Each panel has a specific
task. Panels on the left of the Develop main window include the Navigator, Presets,
Snapshots, and History. The other Develop panels are on the right, which include
Histogram, Basic, Tone Curve, HSL/Color/Grayscale, Split Toning, (and when
you scroll down) Detail, Lens Corrections, and Camera Calibration.

6
Develop Module

Figure 6.1 

Develop Module.
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Navigator Panel
The Navigator Panel shows an enlarged thumbnail of the image that you are cur-
rently working on. If you click on the image in the Navigator, a small white box
appears and the image in the main viewer is enlarged. The amount of enlargement
is determined by the setting on the Navigator title bar. There are two choices 
visible in the header, but they can be selected from eight possibilities, from: 1:4
to 11:1 (see Figures 6.2–6.5). 1:1 means that each pixel on your monitor screen
corresponds to one pixel in the image. 11:1 means that 11 pixels on your moni-
tor correspond to one pixel in your image. After enlarging the Navigator image,
it is easy to move the small white box around in the Navigator. Simply click on
the thumbnail in a new location, and the small white box centers on the plus sign
(+) cursor in the window. If you move the cursor over the white box, it changes to
a hand and you can drag the white box around. A third way to move the white box
around is to move the cursor over the image in the main viewer window. Once again,
it will change to a hand. When you click, it changes to a closed hand, and you can
drag the image around to see that portion of the image in an enlarged view.

When you first open the Navigator, you have four choices on the top bar: FIT,
FILL, 1:1, and 4:1 (or other value that you can select in the drop-down menu).
You can select FIT or FILL for displaying the image in the main viewer window.
FIT means that you can see the entire image and there is a little bit of background
showing all around (see Figure 6.6). When you change the setting to FILL, the
entire viewer window is filled with the image, and there is no border around it
(see Figure 6.7). The Navigator window shows that portion of the image shown
in the white box.

Figure 6.2 

The Develop Module with the enlargement box set to FIT.

Figure 6.3 

The Develop Module with the enlargement box for a 
1:1 enlargement showing in the Navigator window.



Once you have selected either 1:1 or a different value from the drop-down menu,
then clicking on the image will jump between the FIT or FILL setting you selected
and the 1:1 or the selected value you chose. You can tell that this will happen
because the cursor changes into a small magnifying glass with a plus sign (+) in
the center. It will look like this in the Navigator and in the main viewer window.
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Figure 6.4 

The Develop Module with the enlargement box for a 
4:1 enlargement showing in the Navigator window.

Figure 6.5 

The Develop Module with the enlargement box for an 
11:1 enlargement showing in the Navigator window.

Figure 6.6 

The Navigator is set on FIT.

Figure 6.7

The Navigator is set on FILL.



After enlarging, the cursor changes to a hand, so you can click and drag the image
around to see different areas (to look for dust or hot pixels, for example). A click
without a drag will return the image to either FIT or FILL, depending on what
you originally selected.

There are a number of ways to enlarge or zoom the image. You can click on the
image whenever you have the magnifying glass selected. You can click directly on
1:1 in the Navigator bar. Finally, you can use Command+= (Mac) or right-click+=
(PC). The equals sign (=) represents a plus sign (+) on the same key, but it means
that you don’t need to use the Shift key. So to zoom up, think + and to zoom
down, think –. All of these will do the same job, and the Navigator window will
show the area that you have enlarged.

Presets Panel 
The Presets Panel is a fast and powerful tool that can give a variety of different
looks to your images. Lightroom comes with nine presets already made for you to
use (see Figure 6.8). You can also create your own custom presets by clicking on
the plus sign (+) in the Presets bar. When you do, the New Develop Preset dialog
box pops up (see Figure 6.9). If you first use the Basic Panel (on the right of the
screen) to adjust or develop your image, your settings in the Presets Panel will sim-
ply reset them. So wait until you have applied your preset to develop your image.
Now go to the Presets Panel and click on the arrow to the left to bring up the exist-
ing presets if the panel is not open.
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Figure 6.8 

The Presets Panel showing the included presets.

Figure 6.9 

The New Develop Preset dialog box allows you to create your
own presets for the Develop Module.



Figure 6.10 shows an original image before any adjustments have been made.
Figure 6.11 shows the adjusted image. Note the changes in the Basic Panel and
Histogram compared to those for the original. Next, look at the values after the
first preset is applied.

As you hover your cursor over each preset (do not click on them), you can see what
the change will look like in the Navigator Panel while the image in the main viewer
window is unchanged (see Figure 6.12). Wait a few moments while Lightroom
renders the image in Navigator. Now you can move through them to see what
each will look like.
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Figure 6.10 

The original image before adjustments. 

Figure 6.11 

The adjusted or “developed” image. 

Figure 6.12 

Preview of the Antique Grayscale preset in the Navigator Panel. 



The image has to be adjusted or developed after the Antique Grayscale preset is
applied (see Figure 6.13). The Recovery slider is used to recover the highlights that
were lost. Fill Light is used to brighten the background a bit. Finally, Brightness
is tweaked down a bit to taste (see Figure 6.14).

In Figures 6.15 through 6.22, you can see how each of the standard presets is
applied. No matter what changes were made with the Develop Panel sliders, they
are all reset. This means that the preset should be applied before making devel-
opment changes, otherwise the development changes will need to be redone. 
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Figure 6.13 

Antique Grayscale is applied to image. Image has not yet been
adjusted.

Figure 6.14 

The image is adjusted, or developed. 

Figure 6.15 

The same image with the Cyanotype preset applied. 
Notice how all of the Basic Panel sliders have been reset.

Figure 6.16 

The Direct Positive preset is applied to give the image the more
constrast-y look of a transparency or slide.
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Figure 6.17 

Applying the Grayscale Conversion preset gives a different look
from using the Grayscale Panel, which is covered later in this
chapter. When using this preset, note that the Grayscale Mixer
Panel on the right is highlighted so that it is easy for you to do
further refinements, which this image obviously needs before
finalizing it.

Figure 6.18 

The Sepia Tone preset has been used on this image.

Figure 6.19 

The Tone Curve–Lightroom Default applied to the original image.

Figure 6.20 

The Tone Curve–Linear Contrast preset.

Figure 6.21 

The Tone Curve–Medium Contrast preset.

Figure 6.22 

The Tone Curve-Strong Contrast preset.



Some of the presets will work together. For example, in Figure 6.23, the Tone
Curve–Strong Contrast preset has been applied on top of an image with the
Cyanotype preset applied.  Another way to quickly check to see if presets will work
together is to click on one of them (for example, the Cyanotype preset), then hover
your cursor over Tone Curve–Lightroom Default, then Linear Contrast, Medium
Contrast, and Strong Contrast. Watch the image in the Navigator change so you
can quickly see which additional preset, if any, will work.

While you are playing around with your images
and presets, you may find that you want to
revert back to the original. You can do that by
simply clicking on the Zero’d preset at the 
bottom of the list. Note that you can also use 
the Reset button on the lower right of the
Lightroom main window.

To create your own preset, first develop an image
until you get the look that you would like. In
Figure 6.24, I have chosen to make some pretty
wild changes to the original image. Now to save
it as a preset, you can either click on the plus
sign (+)to the right of the word Presets, go to 
the menu Develop > New Preset, or click on
Shift+Command+N (Mac) or Shift+Ctrl+N
(PC).
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Figure 6.23 

This image has the Cyanotype preset applied followed by the Tone
Curve – Strong Contrast preset.

Figure 6.24 

This image been adjusted with wild colors.



In the New Develop Preset dialog box that pops up (see Figure 6.25), you can
select the items that you would like to be controlled by the new preset that you
are creating. The normal way to do it is to leave all options checked. In some cases,
you might have made some specialized corrections to your original, for example,
white balance, that will not be needed in all cases or might be different in some
cases. You can uncheck those items or click on the Check None button, and then
select only the functions you want to use.

Once you are done, give your preset a name and click on the Create button. Your
new preset will be added to the Your Presets list in alphabetical order. When you
want to use it, you follow the same steps as previously described for the factory
installed presets. If you want to remove a preset, highlight it and click on the minus
sign (–) on the Presets bar next to the plus sign. If you acciden-
tally erase one of your custom presets, you can go to Edit > Undo
(Command+Z/Ctrl+Z) and step back through your changes. If
it is too late (because you quit the program, for example), then
you will have to recreate it. There is no way to retrieve it unless
you back up your hard drive regularly. If you did back it up, then
it can be found (on the Mac) under User > Library > Adobe
Lightroom > Develop Presets. You can also find it by doing a
global search for its name on your backup disk drive. 

If you accidentally delete one of the original presets, you can
restore it by Control-clicking (or right-clicking for PC) on any
of the remaining presets and choosing Restore Factory Defaults
(see Figure 6.26). The confirmation message will pop up, as
shown in Figure 6.27. Click on OK and the original factory pre-
sets will be put back. This does not work if you delete any of the
custom presets that you create. You must save those. To find out
where they are stored, create a preset with a strange name, and
then do a search for it on your computer.
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Figure 6.25 

The New Develop Preset dialog box.

Figure 6.26 

Restore Factory Defaults.

Figure 6.27 

Restore Factory Defaults confirmation message



Snapshots Panel
You can save a snapshot of your image at any point by simply
clicking on the plus sign in the Snapshots Panel header. You
name them when the menu pops up, as shown in Figure 6.28.
You can delete a snapshot by highlighting it and clicking on the
minus sign in the header. Please note that snapshots are saved
in alphabetical order rather than in the order you created them.
If the order you created them is important, start off with a num-
ber, such as 1-Snapshot and then 2-Snapshot. If you hover your
cursor over each snapshot listing without clicking on it, the
Navigator will show that snapshot (see Figure 6.29). You can
change the name of any snapshot by double-clicking on the
name, and then typing in the new name.
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Figure 6.28 

Creating a new snapshot

Figure 6.29 

Hovering your cursor over the name of a snapshot previews that snapshot in the Navigator.



History Panel
The History Panel (found in the list of panels
on the left side of your screen) keeps a step-by-
step history of all adjustments performed on
your image (see Figure 6.30). You can save all of
the history states to a single snapshot by click-
ing on the plus sign next to the Snapshots Panel
header. Then double-click on the name to high-
light it, and change the name to something
more meaningful. For example, you could make
a sepia version, click on the plus sign, change
the name to “Sepia,” and then make a black-
and-white version and name it “B/W.” Now you
can easily get back to those by clicking the snap-
shot for that image style. You can also double-
click on the name in the History Panel to change
the name of that history state to something
more meaningful.

Figures 6.31 through 6.34 show a different pho-
tograph. Clicking on the history state can bring
up the image. Or you can hover the cursor over a history state and the main viewer
image will stay the same, but the preview image in the Navigator will show what
the image will look like.
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Figure 6.30 

Typical history for the image shown.

Figure 6.31 

Unadjusted image as shown upon import.

Figure 6.32 

Adjusted image.



To save any history state, simply create a snapshot. You can clear all of the history
states, but not individual ones. If you accidentally delete the history states, use
Edit > Undo or Command/Ctrl+Z to step backward until the missing history
states return. You can also click on a history state and then process from there on,
which automatically erases all history states after that point.

Histogram
The Lightroom Histogram (see Figure 6.35) is similar to the one available on the
LCD screen of most digital cameras, except that it is much more powerful. There
are individual curves shown for each of the three primary RGB colors: Red, Green,
and Blue. When the colors overlap, the summed color is displayed. Yellow repre-
sents red and green, magenta for red and blue, and cyan for green and blue, as well
as a gray one representing all three colors. Like other histograms, the left side 
represents the shadows and the right side represents the highlights. The vertical rep-
resents the number of pixels of that value. If you have the curve piled up against
one end or the other you are clipping those values. If the curve is on the left, it
means a loss of detail in the shadows. If the curve is on the right, it means a loss
of detail in the highlights (“blown out highlights” is a term often used). An ideal
image will typically use the full range of the Histogram so there are no “wasted”
tonal values.
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Figure 6.33 

The image converted to the Cyanotype preset. Note how the
earlier adjustments have been reset and that the image is now
too dark again.

Figure 6.34 

The image converted to Antique Grayscale. As in 
Figure 6.33, this image has to be readjusted, since the first
adjustments made to the image (shown in Figure 6.32) 
have been reset.



One of Lightroom’s most powerful features is the ability to
do image adjustment directly on the Histogram. If you hover
your cursor over the middle of the curve, you can see the term
Exposure brighten in the Tone/Auto area of the Basic Panel
below the Histogram, as shown in Figure 6.36. Also, you can
see the cursor change into a bar with arrows on each side (due
to limitations in the screen capture software, it shows as an
arrow in the figure). The cursor change indicates that the
curve can be adjusted by clicking and dragging it around.
This dragging will reflect in the values shown in the Develop
Panel. At the bottom of the Histogram, the name of the func-
tion you are affecting shows up. To the right of the Exposure
slider is its current value. As you move the curves, the value
will change, so you don’t have to look down in the Basic Panel. You can also see a
faint, slightly grayer box that shows the area of the curve that will be affected. Next,
move the cursor to the right and the Histogram will display Highlight Recovery
(see Figure 6.37). Move it to the middle left, and it displays the Fill Light value
(see Figure 6.38). Finally, move the cursor entirely to the left, and it will display
Blacks (see Figure 6.39). In each case, a slightly gray box will show the area you
are working with. If you hover the cursor over the curve, you can also use the up
and down arrows (but not the right and left arrow keys), which will move the value
shown in the lower right of the Histogram Panel.
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Figure 6.35 

The Develop Module Histogram. 

Figure 6.36 

Adjusting Exposure with the cursor in the Histogram. Note the
word Exposure in the lower left of the Histogram Panel.

Figure 6.37 

Adjusting Highlight Recovery in the Histogram. Note the words
Highlight Recovery in the lower left of the Histogram Panel.



As you move the curve with the cursor or arrow keys, watch how the values in
the Basic Panel change for Exposure, Recovery, Fill Light, and Blacks. Using the
Histogram is just a visual way to change your image.

You can have a visual indication of clipping, if you would like. Clipping occurs when
you are losing information in either the shadows (left side of the graph) or highlights
(right side of the graph). The curve looks like a cliff (the values piled up against one
side), rather than a smooth transition to zero (a gentle slope from the peak value to
zero rather than an abrupt drop) because you have cut it off, or “clipped” it. Figures
6.40 and 6.41 show histograms displaying a clipped shadow area, which I created
by dragging the Histogram curve to the left until the values piled up. When a value
is moved, the rest of the Histogram moves proportionately along with it.
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Figure 6.38 

Adjusting Fill Light in the Histogram.

Figure 6.39

Adjusting Blacks in the Histogram.

Figure 6.40 

Histogram with clipped shadows shown by the curves 
piling up on the left.

Figure 6.41 

Histogram with the shadows on the left side clipped 
and the cursor pointing out the clipping button.



If you click on the clipping buttons, you can turn
the clipping display on and off. Shadow clipping is
shown in blue and highlight clipping is shown in red
in the full-sized image shown Figures 6.42, 6.43, and
6.44. Figure 6.41 shows that information has been
lost in the shadow areas, represented by the blue.
The cursor is pointing at the shadow clipping but-
ton. Note that the button is white, which indicates
that all three color channels are clipped. It would be
a different color if just one or two channels were
clipped. In Figure 6.42, I have toggled the highlight
clipping display on and the shadow clip display off.
In Figure 6.44, I’ve toggled both on so you can see
highlight and shadow clipping together. Ideally, you
want to adjust the Histogram to remove clipping on
both ends so that you are not losing any information
in your images. In both cases, simply hovering the
cursor over the button will show you the blue and red areas in the main image.
You can click again on the button to leave it on or turn it off. A thin white out-
line shows around the buttons when they are turned on.
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Figure 6.42 

The blue shows the clipped shadow areas.

Figure 6.43 

The clipped highlights are shown in red.

Figure 6.44 

Shadow clipping is shown in blue and highlight clipping 
is shown in red.



If you use the Option key (Mac) or Alt key (PC) while moving the Histogram or
the sliders (Exposure, Recovery, and Blacks), then the image will show only the
clipping, identifying which channel is clipped where by color. Adjusting the shad-
ows at the left end of the Histogram will show a white image with black clipping
(see Figure 6.45). Adjusting the highlights at the right end, the image will be black
with white clipping (see Figure 6.46). If the clipping is shown in color, then the
color represents the channel (red, green, or blue) or the channels (cyan = green
and blue, magenta = red and blue, and yellow = red and green) that are clipped
and where in the image the clipping is occurring.

If you want to reset your image and start over, you can double-click on the
Histogram, use the Reset button on the bottom right of the main window, or use
Command/Ctrl+Z to move backward through your steps. You can also go back
to the History Panel to select a previous step. Even if you are used to adjusting
your images by the numbers or with sliders, try playing with the Histogram. After
a bit of practice, it becomes fun and easy as well as fast.
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Figure 6.45 

Shadow clipping with Option/Alt key pressed to show clipped
area by channel.

Figure 6.46 

Highlight clipping with Option/Alt key pressed to show clipped
area by channel.



Basic Development: Color Mode Treatment
Figure 6.47 shows the Basic Panel for Color mode. As has already been shown,
the Basic Panel and the Histogram are linked. An adjustment in either will show
on the other. Hover your cursor over a control, and you will also see that section
of the Histogram light up, as shown in Figure 6.48. You can work in either panel
or both interchangeably.

The tools are laid out in the approximate order that you would typically use them,
starting with White Balance and moving down to Exposure, Recovery, Fill Light,
and Blacks. You can also use Brightness, Contrast, Vibrance, and Saturation, if
you would like.

White Balance
Starting at the top, White Balance is the first of the adjustment, or develop, tools.
In the upper left is the eyedropper tool (see Figure 6.49). Click on the eyedropper,
and the cursor changes to an eyedropper and shows a grid of enlarged pixels (see
Figure 6.50). At the bottom, it gives three numbers: one each for Red, Green, and
Blue. The numbers are expressed in percentages, where 100.0 on all three
values indicates pure white. You use the tool to pick a neutral gray spot
(not a bright white highlight) in the image and click on it. Lightroom will
equalize the numbers to create a white balance. The values will not be
equal if there is a tint to the photograph. If you just hover the eyedropper
tool over parts of the main image, the Navigator Panel will show you what
the photograph will look like as you
move the tool around. This is a quick
way to check without confusing your
history states.
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Figure 6.47 

Basic Panel.

Figure 6.48 

With the cursor on the Exposure slider in
the Basic Panel, Exposure and its value
show up in the Histogram.



When you are finished with the eyedropper
tool, just move the eyedropper back to its
holder and click on it. It will stick and stay
there. Another way to turn the White Balance
on and off is to use the W key. Hit it once, and
the cursor turns into the eyedropper. Hit it
again, and it puts the eyedropper away. In fact,
if you press the W key while in other modules,
the module will change to the Develop Module and bring up the White Balance
tool all at once. For example, as you go through your images in Grid view in the
Library Module, pressing W will move you to the Develop Module and bring up
the White Balance tool, ready to go. This is just one of the very cool things about
Lightroom. Notice the numbers in the bottom of the grid. They are values for red,
green, and blue (RGB) and are shown in percentages. Some have asked why they
don’t use 0 to 255 numbers for each channel. 0 to 255 refers to the possible val-
ues of a single channel of color as expressed in 8 bits (28 = 256). Lightroom works
in 16 bit (216 = 65,536 values per color channel), so using 2 to 255 does not make
sense, even if that is what photographers are used to. Using percentages means
there are 1,000 different possible values (0.0 to 100.0) instead of 256 values in
the other system.

Other ways to set the white balance include moving the Temperature or Tint slid-
ers or double-clicking on the numbers to the right of the slider and typing in a
value. The white balance is stated in degrees Kelvin, a standard for color temper-
ature for raw images. If you are working in other image formats besides raw, the
temperature range is arbitrary, from –100 to +100. A Kelvin temperature value of
5,000 is used to represent sunlight. If you lower the value, you make your image
colder (more blue) because you are telling Lightroom that you photographed the
image under warmer light than daylight. If you raise the value, you are making
your image warmer (adding red). Besides those two methods, you can choose the
White Balance from its drop-down menu (see Figure 6.51). The names represent

Adobe Photoshop Lightroom: Photographers’ Guide142

Figure 6.49 

White Balance section of the Basic Panel.

Figure 6.50 

Eyedropper tool with enlarged grid of pixels. Note that the cursor shows
up as an arrow, but the actual tool will be the eyedropper tool from the
Basic Panel.



the kind of lighting that the image was shot under. Note the difference in the menu
for other types of images (see Figure 6.52), which only gives you a couple of choices.
The Tint slider is designed to remove a green or magenta tint. (See also the
Shadows Tint slider in the “Camera Calibration Panel” section later in the chapter.)

As you change the white balance in the menu or with the eyedropper, notice that
the value of both the Temperature and the Tint will change. You can move them
manually to fine-tune them by hovering your cursor over the slider and using the
up and down arrow keys to move the values. Pressing the up and down arrow keys
will move the slider a medium amount, pressing Shift+arrow will move it a larger
amount, and Alt/Option+arrow moves it a finer amount.

Tone and Auto Buttons
The next tools in the Basic Panel are the Tone and
Auto buttons (see Figures 6.53 and 6.54). The Auto
button simply applies Lightroom’s best guess as to
how it thinks the Tone sliders should be set. It affects
the Exposure, Recovery, Fill Light, Blacks Brightness,
and Contrast sliders. You will have to experiment to
see how well the Auto button will work on your
images.

If you decide that you don’t like the adjustments
after clicking on the Tone button, you can undo the
changes by pressing Command/Ctrl+Z, selecting
Edit > Undo, or clicking on the previous history
state. Simply clicking the button again will not
return you to the previous state.
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Figure 6.51 

White Balance drop-down menu for a raw image.

Figure 6.52 

White Balance drop-down menu for a JPEG image.

Figure 6.53 

Note the values before the
Tone button is clicked.

Figure 6.54

The values change just 
by clicking the button.



Exposure
From the Histogram, you know that adjusting the exposure affects mainly the
upper-middle part of the curve. Once you are happy with the white balance, expo-
sure is the place to begin. Go ahead and make adjustments until the overall expo-
sure of your image looks about right. You can adjust the exposure by moving the
curve in the Histogram (refer to Figure 6.35), by moving the sliders, or by directly
typing in values. You can also highlight the numbers next to the Exposure slider
by double-clicking on them and then using the up and down arrows to move
through the Exposure values or by hovering your cursor over the slider and using
the up and down keys. The numbers represent an f-stop increase or decrease in
exposure. Thus a value of +1.0 refers to increasing the f-stop by one (say from f8.0
to f5.6, as an example). Increasing the f-stop by one also means a doubling of the
light. Negative values work in the opposite manner.

Recovery
Once you have the exposure fairly close to looking visually appealing or having
the Histogram look smooth without cliffs on either end (clipping), use the
Recovery slider to recover detail in the highlights (see Figures 6.55 and 6.56 for
an example of how much detail can be recovered). This very powerful tool brings
detail back into the highlights, especially from raw files. It is not a miracle worker,
however. If your highlights are totally blown (they have no detail), you won’t be
able to get them back. If there is detail in one or two of your color channels, this
tool can recover it.
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Figure 6.55 

Here is an image with hot highlights (larger areas of white
highlight without detail) on the woman’s shoulder and on the
two hot spots on the bank in the upper right.

Figure 6.56 

This is the same image with the Recovery slider at maximum.
You can see that the highlights in her shoulder are totally blown
out from overexposure, but the hot spots on the bank have been
brought back into range.



Fill Light
Continuing with the same example and ignoring the blown highlights that would
have caused us to reject the photograph in the first place, I’ll move the Fill Light
until there’s some good detail in the dark clothing. The Fill Light tool is amazing
and can really bring back details in the shadows. It works by amplifying the values
in the shadows. One problem is that it also increases the noise in the dark areas at
the same time. (Noise looks like multicolored confetti if you haven’t seen it before.)
You have to watch out that you have not increased the shadow areas too much.

As you can see in Figure 6.57, although their clothing looks good, the rest of the
image looks a bit washed out. Since we are doing this in order, rather than going
back and fiddling with a control we have already set, I’ll move ahead to the 
next tool.
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Figure 6.57 

Here the Fill Light has been increased to bring back detail in the shadows and their dark clothing.



Blacks
The Blacks tool operates on the darkest tones in the image. As you move the Blacks
slider to the right, watch the Histogram move to the right as the dark tones spread
out. By doing this, you give the image the widest possible range of tones and yet
prevent clipping of highlights or shadows. Compare the Histogram in Figures 6.57
and 6.58 to see the changes.

In Figure 6.58, I moved the Blacks slider slightly to the right, which added richness
back into their clothes and also made their faces look better, though it’s difficult
to see in the screenshots. This image would still be rejected because of the blown
highlights in her shoulder, but the tools worked nicely on the rest of the tones in
the image.
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Figure 6.58 

Moving the Blacks slider to add richness.



Brightness and Contrast
The Brightness and Contrast tools are near the bottom of the panel on purpose.
They are old-style tools that you generally will not need to use once you learn the
new ways of working that Lightroom offers. If you find that you need a bit more
contrast, you will have more control by using the Tone Curve Panel (see the “Tone
Curve Panel” section later in this chapter) rather than using the Contrast slider.
Note that moving the sliders for Brightness and Contrast will affect the Histogram,
but do not have the option to make those adjustments on the Histogram itself.

Vibrance and Saturation
The last two tools in the Basic Panel are the Vibrance and Saturation sliders.
Usually, just a bit of Vibrance is needed (see Figure 6.59). Too much and the 
photograph will look unnatural. Dropping the Vibrance to its minimum value of
–100 produces a nice effect in Figure 6.60. It makes the image look a bit like 
hand-painted black and white. Vibrance saturates the colors and tries to avoid 
clipping them. It also attempts to minimize the saturation of skin tones.

Saturation operates a bit differently than Vibrance, but it too should be used in
moderation (see Figure 6.61). You can also create a grayscale image, as shown in
Figure 6.62. Saturation of –100 is equal to no color (just the grayscale image),
while Saturation of +100 doubles the saturation of all colors equally, including
skin tones.
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Figure 6.59 

Just a bit of Vibrance adds some pop to this image.

Figure 6.60 

Vibrance was dropped to the minimum value for this effect.
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Basic Development: Grayscale Mode Treatment
To activate Grayscale mode, you need to click on the Grayscale option at the top
of the Basic Panel. Switching from Color mode to Grayscale mode also replaces
the three-color Histogram with a grayscale Histogram. In addition, the Vibrance
and Saturation controls, which only affect color values, are dimmed, since they
can’t be used on a grayscale image (see Figures 6.63 and 6.64).

Figure 6.61 

Just a bit of Saturation was added to this image.

Figure 6.62 

Dropping the Saturation to its minimum value of –100 turns
the image into black and white in ways that are different from
Grayscale mode.

Figure 6.63 

Color mode.

Figure 6.64 

Grayscale mode.



Tone Curve Panel
The Tone Curve Panel is a very powerful and easy-to-use tool for developing your
image by changing the Highlights, Lights, Darks, and Shadows (see Figure 6.65).
You can do this by dragging the Tone Curve or by adjusting the sliders. Some users
find it easier to work with the Tone Curve, and others prefer to use the Histogram
and Basic Panel. As with many things in Lightroom, there are a number of dif-
ferent ways to accomplish the same task.

In the background of Figure 6.65, you can faintly see a gray version of the
Histogram graph. As you hover your cursor over each slider in the Region section,
the name of the slider pops up in the graph along with that slider’s corresponding
value. Alongside the curve itself is a lighter gray shape that shows the range of
motion allowed for the curve using that particular slider. Each slider operates on
a particular portion of the curve. See Figures 6.66 through 6.69 for an example
of each slider.
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Figure 6.65 

Tone Curve Panel. 

Figure 6.66 

Tone Curve: Highlights.

Figure 6.67 

Tone Curve: Lights.

Figure 6.68 

Tone Curve: Darks.

Figure 6.69 

Tone Curve: Shadows.



You can adjust the curve by using the sliders. You can also just grab the curve and
move it up. When you grab it, the slider that will be affected lights up and the
band of acceptable movement shows up as a light gray. A small circle on the curve
shows what will move (see Figure 6.70). You can hover your cursor over the curve,
and then use the up and down arrows to adjust the curve (see Figure 6.71). You
can also click on the numbers to the right of each slider and type in a new value.
Finally, the best feature of all is the Targeted Adjustment tool (see Figure 6.72).
Click once on the dot with the circle around it, hover your cursor over a part of
the image, and then use the arrows to adjust that value. The tool makes it fast and
easy to lighten or darken a background or a face. Just hover your cursor over the
dark part of the background and use the arrows to lighten it up. 
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Figure 6.70 

Adjusting the Tone Curve. Note that your
cursor will look like a straight line with 
a double-headed arrow through it, not a
regular pointer as shown in the figure. Figure 6.71 

Tone Curve and image after adjustment. Notice that the numbers in the 
upper-left corner of the graph show before and after values of your change.

Figure 6.72 

Targeted Adjustment tool along with the tool tip 
in the yellow box that tells you what it will do.



Figure 6.71 shows that the background can be quickly and easily lightened. To
reset any of the values, just double-click on the slider handle. The curve can be
adjusted by a preset Point Curve drop-down menu located in the bottom right of
the pane. You can choose from Linear, Medium Contrast, or Strong Contrast (see
Figure 6.73).

The split control sliders on the bottom of the Tone Curve graph can be moved to
control where the split between regions occurs. In Figure 6.74, the slider between
Highlights and Lights is being moved from 75 to 84 with the cursor.

HSL/Color/Grayscale Panel
The HSL/Color/Grayscale Panel (see Figure 6.75) allows you to adjust the vari-
ous colors in your images. There are three values that you can adjust: Hue,
Saturation, and Luminance. They are sometimes referred to as HSL. Hue refers to
a particular color on the color wheel. We are using red, green, and blue (RGB)
colors, which are shown in the figure. In addition, the complementary colors are
shown as well. For red, the complementary color is cyan (aqua is the Lightroom
equivalent). For green, it is magenta. Finally, yellow is the complementary color
for blue. Each of the values can be adjusted within each of the colors. Figure 6.75
shows all three HSL values, but you can conserve space by clicking on the indi-
vidual term at the top of the panel and displaying only one at a time, if you would
like. You can also use the Targeted Adjustment tool for each of the values (HSL)
to read the value in the image and adjust it. In Figure 6.76, I selected the Hue
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Figure 6.73 

Point Curve presets drop-down menu.

Figure 6.74 

Tone Curve graph sliders define 
where each region applies its effects. 



Targeted Adjustment tool, which lights up the circle icon and places a small arrow
on each side of it. Selecting the tool also closes the Saturation and Luminance 
sections. I have placed the cursor on a green leaf, so the Green hue slider and its
value are highlighted, showing you which value will be moved. If you look in the
toolbar, it shows the relative RGB values (R 44.3, G 50.5, and B 33.9 %). These
are using Lightroom’s 16-bit percentage scale and not the 8-bit 0 to 255 values
you may be more familiar with. 

The first slider in the Hue section is for reds. This means that moving the Red
slider or filling in a new number for the value, will change the hue of just the reds.
The colored background of the slider path shows what direction you are moving
the reds toward. Each of the colors can be adjusted individually within the ranges
shown. As with the other sliders, hovering your cursor over the slider means you
can use the up and down arrow keys to adjust the values. Using Option/Alt+arrow
allows you to make finer adjustments.

The next set of sliders is under the Saturation section. Saturation refers to the
intensity of the color. More saturation means more of that color and less of gray.
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Figure 6.75 

HSL/Color/Grayscale Panel. 

Figure 6.76 

Hue Targeted Adjustments tool. Note that the cursor pointer shown here is replaced 
by a crosshairs icon cursor in the actual program.



Each of the colors can be adjusted individually, as in the Hue section. No satura-
tion, or –100 in the case of the HSL/Color/Grayscale Panel, is the absence of that
color. Figure 6.77 shows an unadjusted image, and Figure 6.78 is the same image
with all of the reds and oranges removed. Adjusting the saturation of various col-
ors is another way to create interesting effects in your images, if you desire. You
can also set all sliders to –100 to create a grayscale image.

Luminance is the amount of light of a particular color. As the luminance of a color
is increased, it becomes brighter, not more saturated. Look at Figure 6.79 to see
what happens to the couple’s faces. As the luminance
of the reds is increased, their faces become lighter, not
redder.
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Figure 6.77 

Unadjusted image.

Figure 6.78 

Image with the Saturation of both the reds and oranges 
set to –100.

Figure 6.79 

The Red slider of the Luminance section is moved to the
maximum level.



Grayscale Mix Section
The Grayscale Mix section is selected by opening the Basic Panel and selecting
Grayscale from the two mode choices. You can also select it by choosing Grayscale
in the header of the HSL/Color/Grayscale Panel (see Figure 6.80). Grayscale is
the official and more proper term for working with what has been traditionally
called “black and white.”

Figure 6.80 shows an image without any adjustments, while Figure 6.81 shows
the same image after the Auto-Adjust function has been applied While in
Grayscale mode, most of the functions in the Basic Panel will also work on your
image. Vibrance and Saturation will be grayed out because they refer to color
rather than grayscale values. Ideally, you have gotten your image fairly close to the
proper exposure and tonality that you desire in the Basic Panel, and you are now
trying to adjust the relationship of the grayscale tones with the Grayscale Mix slid-
ers. Figure 6.81 shows the image with the just the Auto-Adjust function applied
to the sliders. Figure 6.82 shows the yellows and greens pushed to the maximum to
lighten the foliage in the background, and Figure 6.83 shows the yellows and
greens set at minimum to darken the background. The Grayscale Mix section gives
you tremendous power to easily and quickly create and adjust your grayscale
images.
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Figure 6.80 

Grayscale Mix section with no adjustments to the sliders.



Just as in other panels, you can use the Targeted Adjustment tool by clicking on
the gray circle to the left of Grayscale Mix. Putting the cursor over a spot on your
image shows which slider will adjust it. Leaving the cursor over a spot on the pho-
tograph, use the up and down keys to adjust that area as before.

You can also use the Tone Curve Panel in grayscale, as Figure 6.84 shows. The
same instructions for the color Tone Curve apply. (See the previous discussion on
Tone Curve in this chapter.)
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Figure 6.81 

Auto-Adjust function applied to the Grayscale Mix sliders.

Figure 6.82 

Yellows and greens set to maximum.

Figure 6.83 

Yellows and greens set to minimum.

Figure 6.84 

The Tone Curve Panel works with the Grayscale Mix section.



Split Toning Panel
The Split Toning Panel (see Figure 6.85) is an interesting way to apply some spe-
cial toning to your images, as well as to fix things like shadows that are too blue.
In Figure 6.87, I’ve adjusted the saturation and hue in the highlights for an inter-
esting effect. (Compare it to the original in Figure 6.86.) Figure 6.88 shows a
nicely toned grayscale image after converting Figure 6.87 to grayscale by clicking
on Grayscale in the header of the HSL/Color/Grayscale Panel. Use the Hue slid-
ers to choose the color of the toning and the Saturation sliders to choose how
much toning you want. Use the Balance slider to move the toning from highlights
to shadows to emphasize one or the other. Positive values increase the toning in
the highlight area (reducing the shadow control) and negative values affect the
shadow area (reducing the highlight value). You can accomplish the same by 
moving the two Saturation sliders back and forth, but it is easier and faster to use
the Balance slider to fine-tune things. You can easily use this to create your own
flavor of sepia, for example. This is the type of control that really needs to be
played with for the best results.
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Figure 6.85 

Split Toning Panel.

Figure 6.86 

Original color image.



Detail Panel
In the Detail Panel, shown in Figure 6.89, you can adjust the sharpening, smooth
rough images, and apply noise correction. Figures 6.90 through 6.93 show some
of what you can do with these controls.

The image shown in Figure 6.90, like many digital images, is a bit soft, or lacking
in sharpness. I want to increase the apparent sharpness by adding various levels of
sharpness, as shown in Figures 6.91 and 6.92.
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Figure 6.87 

Color image with split toning applied.

Figure 6.88 

Image converted to grayscale with the same split toning applied.

Figure 6.89 

Detail Panel.

Figure 6.90 

The 1:1 view of an image with no sharpening.



Figure 6.94 is an image of two firefighters fighting a training burn. This image
has lots of noise because it was shot at ISO 1600 using only the light of the fire
to light the image. Figure 6.95 shows a close-up of the noise. Setting Lightroom’s
Noise Reduction section to maximum does an okay job of removing the noise (see
Figure 6.96). There are some third-party noise reduction plug-ins or programs to
be used with Photoshop that may do a better job with some difficult images, but
as these examples show, Lightroom will be able to handle much of the work. If
more noise reduction is needed, simply export the image or edit in Photoshop and
use the other tools available.
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Figure 6.91 

The same image with sharpening of 50.

Figure 6.92 

The same image with maximum sharpening turned on.

Figure 6.93 

The same image with some Luminance added from the Noise Reduction
section to smooth out some of the over-sharpening in Figure 6.92.



When using the Noise Reduction function, be sure to zoom in to see its effect.
Usually, you will have to zoom in by using 1:1 or even 2:1 to be able to see the
reduction. It will not properly show up at lower magnifications.
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Figure 6.94 

The original image.

Figure 6.95 

Close-up of the noise with the image at 2:1.

Figure 6.96 

Noise Reduction set to maximum for both Luminance and Color.



Lens Corrections Panel
The Lens Correction Panel (see Figure 6.97) is designed to
help correct chromatic aberration and vignetting. 

Reduce Fringe
Fringe or chromatic aberration is the coloration that occurs on edges of images.
This is more frequent on ultra wide-angle lenses and on less expensive lenses.
Figure 6.98 shows an example of both: a photograph taken with an inexpensive
(cheap!) add-on type fisheye lens. The edge suffers from chromatic aberration as
can be seen in the 1:1 enlargement of one edge in the image. By playing with the
Chromatic Aberration sliders for both of the two types (Red/Cyan and
Blue/Yellow), it has been reduced considerably, as shown in Figure 6.99.
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Figure 6.97 

Lens Correction Panel.

Figure 6.98 

1:1 enlargement of an image showing chromatic aberration.



Lens Vignetting
Some lenses produce a darkening or vignetting near the edges of images due to
light falloff. The Lens Vignetting tool allows you to correct for that. In the case
of this particular photograph, I will add vignetting because of the internal reflec-
tions (see Figure 6.100). The black border around the lens should be darker.
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Figure 6.99 

Using the two sliders, the chromatic aberration has been reduced.

Figure 6.100 

Edges of this image are not black because of internal reflections.



In the corrected image (see Figure 6.101), I have increased vignetting by moving
the Amount slider to –100, which darkens the edges. A positive value reduces
vignetting by adding positive corrections, which lightens the edges. I also moved the
Midpoint slider, which reduces the width of the correction to keep it out of 
the image.

Camera Calibration Panel
The Camera Calibration Panel (see Figure 6.102) is used to correct for a coloration
bias in your particular camera. It also shows the profile it is using to convert your
raw images. In Figure 6.103, the top line reads  Profile: ACR 2.4. ACR refers to
Adobe Camera Raw, which is the conversion routine that is being used. 2.4 refers
to the version of ACR being used. Don’t worry if it is not the most current one
(currently 3.7 for Photoshop CS2 and 4.0 for Photoshop CS3, which is still in
beta testing). It shows the version being used for your camera, which is usually the
first version that supported your camera. Adobe usually just adds new cameras to
later versions and does not update earlier ones. The Profile drop-down menu gives
you more choices for RAW conversion. If the word Embedded appears, it means
Lightroom will use the profile embedded in your file. This is usually the case with
TIFF, JPEG, PSD, and DNG file formats. Use the Shadows Tint slider to correct
any shadows that are not neutral in color.
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Figure 6.101 

Fisheye Image corrected with Lens Vignetting sliders.



To use the Camera Calibration Panel, simply adjust the sliders and those values
will be used for imports. Here I used a mixed lighting source with a lot of red in
it. You can also use this panel to adjust
your image after import. By reducing
the Red Primary Saturation, you get a
much more natural-looking image in 
a few seconds of effort (see Figure 6.104).

Once you have created a correction for
your camera under a particular lighting
condition, you can save this as a Develop
preset. You do this by using the Presets
Panel on the left of the window and
pressing the plus sign (+). For more
detailed information, see the “Presets
Panel” section earlier in this chapter.
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Figure 6.102 

The Camera Calibration Panel from 
a JPEG image that shows it is using an
embedded profile.

Figure 6.103 

An original image that is using ACR 2.4.

Figure 6.104 

Image after adjusting the Camera Calibration Panel.



Toolbar and Panel Buttons
In this section, I am going to cover the entire bottom of the screen above the
Filmstrip. This will include the buttons on each side of the toolbar. The toolbar
itself can be toggled on and off with the T key. This allows you to maximize your
vertical space in your monitor. The buttons on each side of the toolbar are not
affected because they are not part of the toolbar. If you have all of the possible
options selected for the toolbar (using the drop-down menu on the right end of
the toolbar), then you may need to close one or both of the side panels to be able
to see all of the functions. If you have a wide-format monitor, you may not need
to. Figures 6.105 and 6.106 show the toolbar with all options selected and the
side panels both open and closed. Note that the buttons on each side disappear
because they are part of the side panels and not the toolbar.
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Figure 6.105 

The bottom of the screen showing the toolbar in the middle with sets of buttons on each side. 
The buttons are in the side panels and disappear when the panels are closed, as shown in Figure 6.106.

Figure 6.106 

The bottom of the screen with the two side panels closed so the entire toolbar can be seen. 



Add and Remove Buttons
To add or remove buttons from the toolbar, simply use the plus (+)  or minus signs
(–) on each panel. The minus sign (–) button only appears when you have high-
lighted a preset or snapshot that you can remove. If you accidentally remove one
of the standard presets, you can add it back by Control-clicking (right-clicking for
PC) on any of the remaining presets. Choose Restore Factory Defaults in the
menu. The confirmation menu will pop up. Click on OK, and the original fac-
tory presets will be restored.

Copy, Paste, Previous, Sync, Auto Sync, 
and Reset Buttons
Use the Copy button  to copy the settings from one image and apply them to 
others. This Copy function is different than Copy in the Library Module. In the
Library Module, you can only copy text and metadata with the Edit > Copy menu
command. To copy settings, you have to use Photo > Develop > Copy Settings
(or Shift+Command/Ctrl+C). In the Develop Module, you can copy the Develop
settings as well by using the Copy button or Develop > Copy Settings
(Shift+Command/Ctrl + C) and not Edit > Copy (Command/Ctrl+C). Don’t get
confused between Copy Settings and Copy. To copy Develop settings in the
Develop Module, use the Filmstrip to select your main image and press the Copy
button. The Copy Settings dialog box pops up, as shown in Figure 6.107. Select
the items you wish to copy, select the image in the Filmstrip that you want to paste
to, and then press the Paste button. You can only do one image at a time using
this method.
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Figure 6.107 

The Copy Settings dialog box.



To paste settings into multiple images requires a different technique. Select the
image in the Filmstrip that you want to copy the settings from. Then Shift-click
to select the images you want to paste the settings to. Now you have several images
selected and one is the “most selected,” as shown by its lighter colored border (see
Figure 6.108). Once that happens, the Sync button replaces the Previous button
in the right panel.

Click on the Sync button. When you do, the Synchronize Settings dialog box will
pop up (see Figure 6.109). Choose the settings you want to transfer from your
most selected to the other selected images. If necessary, clear the settings by click-
ing Check None, and then check the options you want. When you are ready, click
Synchronize, and the settings will be transferred. Note that the settings you had
previously chosen in the Copy Settings dialog box will be chosen automatically in
the Synchronize Settings dialog box.
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Figure 6.108 

Three images are selected in this partial view of the Filmstrip with the first one “the most selected” because it is surrounded
by a lighter color.

Figure 6.109 

Synchronize Settings dialog box.



If you hold the Command/Ctrl key when you click on the Sync button, the but-
ton name will change to Auto Sync. Anything you do in the Develop Module to
the most selected image (with the lighter box around it) will be done to your other
selected images. No dialog box will pop up, as you are not pasting the changes,
but rather doing them in real time. If you are moving a slider, you will see the
changes appear immediately in the most selected image, but they will not be
applied to your other images until you release the mouse. Notice that the change
is not applied until the history state appears under the History Panel. To change
the Auto Sync button back to Sync, just click on it again while holding down the
Command/Ctrl key.

Use the Previous button to apply the settings of the previous image that you had
selected in the Filmstrip to the current image you have selected. You can use the
Reset button to return the image to its original state. In all cases, pressing
Command/Ctrl+Z (or selecting Edit > Undo) allows you to step backward
through your actions. A message will flash on the screen telling you what
Lightroom is undoing.

Loupe View Button
The Loupe View button is the lighter square with a darker square in the middle
on the far left of the toolbar. Pressing the Loupe View button returns you to the
Loupe view. You can also do this by pressing D.

Before/After Views Button
There are four different Before/After views, which can be selected by the drop-
down menu shown in Figure 6.110.
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Figure 6.110 

Before/After button drop-down menu.



The Left/Right view is usually used for vertical (portrait) images, and the
Top/Bottom view is usually used for horizontal (landscape) images. This maxi-
mizes the screen real estate. The Before/After button changes to show you what it
will do. The different buttons, which represent the different views, are shown in
Figures 6.111 through Figure 6.114. Figure 6.115 shows the results of using the
button shown in Figure 6.111. Figure 6.116 shows the result of using the button
in Figure 6.112. Figure 6.117 shows what happens if you press the FIT button in
the Navigator Panel to enlarge the split view. The split remains, and both sides are
enlarged, making it easy for you to look in detail at your image before and after
you have made adjustments.
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Figure 6.111 

Before/After Left/Right.

Figure 6.112 

Before/After Left/Right Split.

Figure 6.113 

Before/After Top/Bottom.

Figure 6.114 

Before/After Top/Bottom Split.

Figure 6.115 

Before/After Left/Right images are shown.

Figure 6.116

Before/After Left/Right Split images in FIT view.



With a horizontal image, you can use the other settings to conserve space. The
Split view works in any view, including the Enlarged view. In that case, the single
image is presented with a split down the center—the left side is the Before view,
and the right side is the After view.

When using the Before/After function, you can apply the settings from the Before
image to the After image, or the other way around, by using the two buttons that
show up when the Before/After button has been selected (see Figure 6.118). One
of the buttons has an arrow pointing to the right (copy the Before setting onto
the After image), and one has the arrow pointing to the left (copy the After setting
onto the Before image).
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Figure 6.117 

Before/After Left/Right Split images in 1:1 view.

Figure 6.118 

Copy Settings buttons appear after 
you click on the Before/After button.



Crop and Straighten Tools
The cropping and straightening tools are located in the toolbar. To activate them,
click on the Crop and Straighten button (shown in Figure 6.119), or you can press
the R key. A third method is to select View > Crop from the main menu. The
Crop and Straighten tools are shown in Figure 6.120. You may need to close one
or both of the side panels to see the entire toolbar, depending on the size and shape
of your monitor.

This Crop tool operates considerably differently from other ones. It takes a bit of
time to get used to, but once you do, it is very quick and easy to use. Notice how
the background color changes, as well as the Crop Overlay (see Figure 6.121). To
crop, just grab a corner or a side and drag it once the cursor changes. If you want
to use a more familiar tool, use the cropping squares shown just to the right of the
word Crop on the toolbar. Once you have laid out a rough crop, you can drag it
around as necessary (see Figure 6.122).
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Figure 6.119 

Crop and Straighten button. 

Figure 6.120 

Crop and Straighten tools on the toolbar. 

Figure 6.121 

An image shown with the Crop Overlay.

Figure 6.122 

Image cropped to a non-standard size.



You can drag the cropping lines to any layout that you want, though you may want
to use a standard proportion. To select a standard size or create your own, click on
the drop-down menu to the right of the Lock icon, as shown in Figure 6.123.

Select a cropping aspect ratio in the menu. Then when you move
one side of the image, the top and bottom also move to keep the
aspect ratio constant. In Figure 6.124, only the left edge is moved.
Note that the Lock is now closed or locked. (Compare the lock in
the toolbar below the image in Figures 6.122 and 6.124.) When
the Lock (formerly called Constrain Aspect Ratio) is deselected
(unlocked; you can alternatively press the A key or select Photo >
Constrain Aspect Ratio), when the left edge is dragged, only the
left edge will move. The top and bottom stay constant. If the Lock
is selected again so that it is locked, it maintains the new, squarer,
ratio created as you drag one side. If you want to undo the crop and
start over, press the Clear button on the right side of the toolbar.

If you select Custom in the drop-down menu, a dialog box pops
up that allows you to enter your new aspect ratio so you can select
it again in the future. Keep in mind that these are only aspect ratios,
not absolute crops. The final size is determined upon export. 
Thus a 4×5 ratio is the same as an 8×10 in Crop.
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Figure 6.123

Drop-down cropping menu.

Figure 6.124 

Grab the image and move it underneath the Crop Overlay. Note that instead of the cursor arrow shown 
in the figure, the cursor will change to a curved line with arrows on each end.



An 8×10 crop ratio has been selected in Figure 6.124. We want to adjust the loca-
tion of the crop. Here is the tricky part. Move your cursor to the inside of the
Crop Overlay and click. A hand forms when you move the cursor over the crop
and when you click, it changes to a clinched hand to show that you have grabbed
it. The “it” in this case is the underlying photograph and not the Crop Overlay.
When you move the cursor with the click on, the crop stays stationary and the
image moves underneath it. At first it seems strange, but then you get used to it.
If you move your cursor outside of the Crop Overlay, it changes into a curved line
with an arrow on each end. When you click and move the cursor, the photograph
rotates. In addition, if necessary, the Crop Overlay will shrink in size to make sure
it stays within the image. You will also see the grid to help you line up elements
as you rotate the image.

There is only one crop setting for each different aspect ratio. You don’t need a hor-
izontal and vertical (landscape and portrait) version. In fact, it doesn’t matter if
you create a 10×8 crop, it will still start out as a horizontal crop. You simply grab
the corner and move the cursor about 45 degrees offset of the corner, and the Crop
Overlay will suddenly snap into position. You will see the cursor change into an
X with arrows on two ends. The first time you try it, it will seem strange; but keep
trying, and you will soon be snapping crops away.

The next interesting feature of the Crop and Straighten tool is how simple it is to
straighten your photographs. Put the cursor inside the image, press the
Command/Ctrl key, and click. The cursor will change into a level (like the one
shown in the toolbar in Figure 6.120).
You can also just grab the level from
the toolbar by clicking on it. Draw a
line that you would like to rotate to
vertical or horizontal (see Figure
6.125). Let go of the mouse and the
image rotates for you. You can still
use all of the other tools to change
the size or shape of the Crop Overlay
or to change its orientation. To rotate
the image, you can also move the
Straighten slider or enter a numerical
value in the box. Figure 6.125 shows
the slider under the image still set at
0.00. As always, you can reset the
angle by double-clicking on the
slider, or you can click on the Clear
button on the toolbar to reset all of
your cropping for this image. 
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Figure 6.125 

A line is drawn that you want to make vertical.



However, don’t use the large Reset button on the bottom of the right panel—this
will reset all of your Develop settings. Double-clicking on the image will take off the
Crop Overlay and show you the cropped image. Notice how the cropped image
in Figure 6.126 has been reduced in size to fit within the rotated original image.

Red Eye Tool
The Red Eye tool is the little eyeball on the toolbar to the right of the Crop and
Straighten button. When you click on the eyeball, it lights up red, and the tool
adjustments appear in the right side of the toolbar, as shown in Figure 6.127. You
can also get to the tool by selecting View > Red Eye from the main menu. There
is no keyboard shortcut for this tool.
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Figure 6.126 

Rotated image.

Figure 6.127 

The Red Eye tool turns red when selected, and the redeye adjustments appear in the toolbar.



First, zoom in the image so the eyes are large enough to see. Use the tool to draw
a box around the eye, use the sliders to adjust the pupil size, and then darken the
result. Note that the tool looks for red. If you photograph pets, you know they
get “green eye” (sometimes called “pet eye”) instead of redeye, and this tool will
not work on that. If you attempt it, the box simply will not stick because there is
no red within it for it to attach to. When you are finished, click on the tool again
to turn it off. If you have redeye and the box won’t stick, then adjust the lightness
or darkness of the image and make sure the white balance has been adjusted. If
the image is too dark, Lightroom will not be able to see the redeye properly for
the tool to work.

Remove Spots Tool (Cloning/Healing)
The Remove Spots tool is great for fixing blemishes and hotspots on your image.
The Spot button is a small box with two circles in it on the toolbar. When you
click on it, the tool adjustments appear, as shown in Figure 6.128. Next, click on
either Clone or Heal to choose the type of repair you would like to make. Figure
6.129 shows the Clone tool that copies the jacket texture onto the face. Figure
6.130 shows the Heal tool with spots in the same location. In this case, it uses the
texture from the jacket but blends in the color. Note that the Clone tool has soft
edges to blend in the correction. Click on the image where you want to do the
repair, and Lightroom places a pink circle over the spot. Adjust the size by drag-
ging an edge or using the Spot Size slider. Use your cursor to move the green sam-
pling circle to a clean spot to pick up good texture.
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Figure 6.128 

The Remove Spots tool and tool adjustments on the toolbar.

Figure 6.129 

The Clone tool.



The best advice is to use the Heal tool for blemishes and the Clone tool
if you need to replace eyes or exact objects. Use the Spot Size slider to
adjust the size of the spot. You can click on a spot to go back and adjust
its size or to delete it. Just click on the spot, and when the spot and 
sampled area circles both appear, then you can work on just that spot
by dragging it to a new location, adjusting the size by moving the slider
or dragging the edge of the spot, or just press Delete/Backspace to
remove it. See Figures 6.131 through 6.133 for before and after views
of the Heal tool in operation. It took about 15 seconds to do this
retouching. It is likely with blemishes such as these on a close-up that
you will want to do some additional smoothing on the final image
before it is printed. It is so fast to do this level of retouching that you
can quickly clean up the images before you show them to the client to
give a better first impression.
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Figure 6.130 

The Heal tool.

Figure 6.131 

Before the Heal tool was used.

Figure 6.132 

After the Heal tool was used with the tool still turned
on showing the spots.

Figure 6.133 

After the Heal tool was used.



Rating Stars, Pick and Reject Flags, 
and Color Labels
Depending on what options you selected in the toolbar drop-down menu, you
can show the rating stars, Pick and Reject Flags, and the color labels (see Figure
6.134). These are quite useful for rating images, even in the Develop Module. For
more information on using them, refer to Chapter 5, “Library Module.”

Develop Shortcuts
You can access the Develop shortcuts (see Figure 6.135) by clicking on the Help
menu or by clicking on Command/Ctrl+\ (backslash). These are useful to learn
to speed up your workflow.
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Figure 6.134 

The rating stars, Pick and Reject Flags, and the color labels are seen 
in the right side of the toolbar if you choose to have them shown.

Figure 6.135 

Develop shortcuts.



What Are Those Weird Squiggly 
Things on the Bottom?
Those weird squiggly things at the bottom of the panels have raised a lot of ques-
tions. They are called glyphs. The purpose of the glyphs is to show you when you
have reached the end of the panel (see Figure 6.136). They can be customized by
the user or replaced with a simple box if you desire.
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Figure 6.136 

Glyphs.





Creating a slideshow in Lightroom is very easy. All you have to do is select your
images, either in the Library Module or Filmstrip, and click on the Slideshow
Module (see Figure 7.1) in the Module Picker. You can also go to Window >
Slideshow or press Option/Alt+Command/Ctrl+3, and your slideshow is ready.
You can choose the images from a folder, from a collection, by selecting them 
individually in the Library Module, or picking them in the Filmstrip. One of the
easiest ways is to rate your images in a
folder or session, filter for that rating, and
then move to the Slideshow Module.
Another easy way is to add images to the
Quick Collection by using the B key, and
then using the Quick Collection for the
show. If you are in a folder view or a
Collection, you can drag the images into
the order that you would like in Grid
view or in the Filmstrip. If you have
selected All Photographs in the Library,
you will not be able to drag them into 
a different order. In that case, create a
Collection first and then reorder them.

7
Slideshow Module

Figure 7.1 

Slideshow Module.



Template Browser Panel
The Template Browser Panel (see Figure 7.2) allows you to
set up the way your slideshow will look by using various
stock templates. You can also create and save your own tem-
plates. As you hover your cursor over the list of templates,
the Preview window changes to show you what it will look
like without having to change your main viewer window.
You can choose from Caption and Rating, Crop to Fill,
Default, Exif Metadata, or Widescreen. See the following
sections for what each template will do.

Caption and Rating
When you want to have your slideshow display the photo caption (entered in the
Metadata Panel of the Library Module) and the rating, choose the Caption and
Rating template (see Figure 7.3). Note that the rating is shown as stars in the upper
left of your image while the caption is shown below. You may have to change the
color of the rating stars (default is white) to another color to make them show up
better. I changed them to red and enlarged them (see the “Overlays Panel” section
later in this chapter) to make them show up better on this image with a dark back-
ground.
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Figure 7.2 

Template Browser.

Figure 7.3 

Caption and Rating template.



Crop to Fill
The Crop to Fill template fills the slideshow viewing window completely with the
image (see Figure 7.4). This may be good for some presentations, but if you are
not careful, you can cut the heads off of subjects in vertical (portrait) views.
Luckily, this is easy to fix. Just grab each image that is not placed how you like it,
and drag it until it fits better. You need to grab it in the Slideshow viewer window.
The Preview window will show the
cropped view, but the Filmstrip will show
the complete image. Lightroom will
remember how you have changed each
image.

Default
The Default template is a good standard way to create a slideshow (see Figure 7.5).
It has your name (Identity Plate) in the upper corner and the file name below the
image. You can move both of those text
fields and even change their look, size,
and the information they present. You
can also create or modify what you need
in the Default template.
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Figure 7.4 

Crop to Fill template.

Figure 7.5 

Default template.



Exif Metadata
The Exif Metadata template allows you to show metadata with your images (see
Figure 7.6). The built-in template displays the date and time of the image in the
upper-right corner, and the f-stop, ISO Speed Rating, and Focal Length are shown
in the lower-right corner. In addition, it has the rating stars on the image and your
Identity Plate in the upper-left corner. Each of these can be customized to display
what you would like. 

To change an existing text field, click on
it, and the cursor will change to a hand.
You will see the field surrounded by
boxes and dotted lines. Move your cursor
to a corner, and you can enlarge the box.
Move it to the center, and you can drag
the box around to a new location. Once
the box is selected, go to the ABC button
in the toolbar. If you don’t see the tool-
bar, press T or go to View > Show Toolbar.
After clicking on ABC, the Custom Text
box will appear on the toolbar. Click on
the down arrow on the right side, and
select Edit from the drop-down menu.
The Text Template Editor (see Figure 7.7)
will appear, and a box will appear on your
slide. You can add more tokens to the box
or highlight an existing token and delete
it. You can also reorder them if you like.
To turn on or off the Identity Plate with
your name, go to the Overlays Panel (see
the “Overlays Panel” section later in the
chapter). That is the same place to turn
off the rating stars, change their size, or
change their color. You can also choose to
turn off the Text Overlays there.
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Figure 7.6 

Exif Metadata template.

Figure 7.7 

Text Template Editor 
dialog box.



Widescreen
If you use a widescreen monitor, you
can choose to have Lightroom fill up the
entire screen with your slideshow. Note
that in Figure 7.8, the right set of panels
is closed so the entire screen will fit.

Add/Remove Buttons
You can create your own templates. Take a pre-filled template
from the Template Browser and modify it so that it has every-
thing the way you like it. Then press the Add button (at the 
bottom of the panel) and name it so that you will remember it.
If you want to remove a template, highlight it and press the
Remove button. If you accidentally delete an existing built-in
template, you can restore it by Control-clicking (right-clicking)
on a remaining template. Then choose Restore Factory Defaults
in the popup menu (see Figure 7.9).

Options Panel
The Options Panel located on the right side of the screen (see Figure 7.10),
allows you to fill the frame with your image, put a border around it, or cast a
shadow so it seems like the image floats above the screen.
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Figure 7.8 

Exif Metadata template.

Figure 7.9 

Restore Factory Defaults.

Figure 7.10 

Options Panel.



Zoom to Fill Frame
By checking the Zoom to Fill Frame box, you are asking that the image area be
filled with your image. If you need to, you can simply drag the image with your
cursor to center it better. See Figures 7.11 and 7.12, respectively, to see the slide
with and without the Zoom to Fill Frame box checked.
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Figure 7.11 

Without Zoom to 
Fill Frame selected.

Figure 7.12 

With Zoom to 
Fill Frame selected.



Stroke Border
The Stroke Border option allows you to display a border around your image.
You can also change the color of the border by double-clicking on the white
box to the right, and then choosing your color from the color wheel shown
in Figure 7.13. The default behavior is to have a white border. Drag the
slider to change the width of the line. 

Cast Shadow
Using a shadow is a popular technique to help make your image look like
it is floating. You can adjust the opacity, how much the shadow is offset from
your image, how sharply defined the shadow is, and the angle at which it is
cast. Most of the adjustments are pretty self-explanatory.

Layout Panel
The Layout Panel allows you to turn on or off the layout guides (see Figure 7.14).
If you want your image centered in the space, then you should leave the check
marks, which link them all together. Moving one slider will move all of them, 
saving you effort and time. You can set them individually as well.
The reason you would want to change them, besides aesthetics,
is to allow more space to display metadata or other information.
The numbers show how many pixels you are from the edge.
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Figure 7.13 

Colors selection wheel.

Figure 7.14 

Layout Panel.



Overlays Panel
You can control the overlays used in your slideshow by adjusting the options in
the Overlays Panel (see Figure 7.15). You can have and modify an Identity Plate,
include the rating, put text in the show, and control a shadow. Clicking on any
of the boxes with colors (default is usually white or black) will bring up the
Colors selection wheel, like the one shown in Figure 7.13.

Identity Plate
To edit or create a custom Identity Plate, click on the Identity Plate in the
Overlays Panel, and a popup menu will appear (see Figure 7.16). If you want
to create a custom Identity Plate, choose Edit and the Identity Plate Editor 
dialog box will appear (see Figure 7.17). Make your changes, then go down to
the Custom drop-down menu and select Save As to give your new plate a name.
Then click OK

You can click on the option Use a Graphical Identity
Plate and import one that you created (see Figure
7.18). Just drag a file (PDF, JPG, GIF, PNG, TIFF,
or PSD) into the space, or use the Locate File but-
ton to locate the file on your computer. Make sure
that the image is no more than 60 pixels high. 
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Figure 7.15 

Overlays Panel.

Figure 7.16 

Identity Plate popup menu.

Figure 7.17 

Identity Plate Editor dialog box.

Figure 7.18 

Graphical Identity Plate menu.



Ratings
Click on the Rating Stars check box in the Overlays Panel, and you can add rat-
ing stars, size them, and change the color. The default is small and black, as shown
in Figure 7.19. They can barely be seen in the upper-left corner of the image. Click
on the colored box (default color is black), and the Colors selection wheel will
appear. To make the stars more visible, drag the Colors slider control on the right,
and then click in and move the mouse within the color wheel. This will give you
any color that you would like, as you can see in Figure 7.20. Move the Scale slider
to enlarge or reduce the stars.
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Figure 7.19 

Rating stars in the default size
(25%)and color (black). They
can barely be seen in the
upper-left corner.

Figure 7.20 

Rating stars in 
red and at 40%.



Text Overlays
The Text Overlays section of the Overlays Panel just turns any text overlays on
and off without having to go to your template and change it. You must click on
a text overlay for these options to be changeable, except for the turning on and off
of the text. This makes sense in that you could not change the Opacity or Font
options unless you had selected what you wanted to change.

Shadow
This is a repeat of the Cast Shadow option in the Options Panel and works in the
same way (refer to the “Options Panel” section earlier in this chapter). You must
check the Shadow box for the options to become active. Otherwise, they remain
grayed out.

Backdrop Panel
The Backdrop Panel allows a great amount of variety in the coloring behind your
images (see Figure 7.21). 

Color Wash
The Color Wash option displays a gradient behind your images. You can change
the color by clicking on the Color Wash box and then choosing a color in the
Colors selection wheel and using the slider, just the same as you did with the rat-
ing stars. In Figure 7.22, I changed it to red to make the gradient more obvious.
You can adjust the maximum opacity and the direction that the gradient flows to.
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Figure 7.21 

Backdrop Panel.

Figure 7.22 

Color Wash turned on and Background Color left on the default of light gray.



Background Color
Figure 7.23 shows the difference between Color Wash and Background Color.
Color Wash has been unchecked, but Background Color has been checked and a
darker red color has been selected. Background Color is just a solid color set in
the same way as Color Wash. They can be combined for different effects, and the
effects are almost limitless. In Figure 7.24, I selected a yellow for Color Wash to
give the image an interesting pattern in only a few clicks.
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Figure 7.23 

Background Color set to red.

Figure 7.24 

Both Background Color and Color Wash are turned on.
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Background Image
In addition, you can choose an image for the background if you would like (see
Figure 7.25). You simply check the Background Image box, and then drag an
image into the Backdrop Panel. The final step is adjusting the opacity of the back-
ground image. 

Playback Panel
You can control the duration of how long your images are shown, as
well as how long each fade takes by using the Playback Panel (see Figure
7.26). You can also add music to your show. Start by clicking on
Soundtrack in the Playback Panel. If you are using a Mac, you have to
select a playlist that already exists in iTunes. If you want specific songs,
simply create a playlist and drag the songs you want to it. If you are on
a PC, you can select MP3 files to play. In any case, use the drop-down
menu by clicking on the down arrow to the right of Soundtrack. This
will have the names of your available music playlists or songs.

Figure 7.25

Background image is used instead of Color Wash or Background Color.

Figure 7.26 

Playback Panel with two monitors.



If you have multiple monitors (as shown in Figure 7.26), simply click
on the one you want the show to run on. It doesn’t effect which moni-
tor the main Lightroom window will appear on. You can also decide to
randomize the order of the images by clicking on the Random Order
box. If you only have one monitor, then the Playback Screen section
will not appear, as shown in Figure 7.27. In all cases, the settings in the
Playback Panel only apply to slideshows that you play on your monitor
and not to ones that you export.

Preview and Play Buttons
The Preview button is the Play button (right facing triangle) on the toolbar. It will
play the slideshow in the main viewer window without blacking out your monitor
(or both monitors if you have two). The Play button in the bottom of the right
panels begins the show. You must have the panel open to see the Play button, and
you must have the toolbar showing to see the Preview button. The tool tip that
pops up when you hover your cursor over it in the toolbar can identify the Preview
button. The slideshow will run continuously until you click on it with the cursor
or hit the Escape key. If you want to know where to end it, simply create a The End
slide and put it at the end of your slideshows. The Playback settings only apply to
slideshows you show live on your monitor and not on slideshows that you export.

Export
There is currently a limited ability to export your
slideshow. To do it, first create your slideshow. Then
click the Export button in the bottom of the right side 
panels, or on the main menu, go to Slideshow >
Export, or finally, use Command/Ctrl+J. The Export
Slideshow dialog box will appear, as shown in Figure
7.28. Currently, the format of the exported slideshow
is limited to PDF (Adobe Acrobat). Name your
slideshow and navigate to where you want it saved.
Specify the size of the show and the quality, and then
click on the Export button. The higher the Quality 
setting, the larger the file size of the completed show.
Notice that, for the moment, music cannot be added
to your exported slideshow. Also, the settings that you
made in the Playback Panel do not apply to slideshows
that are exported.
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Figure 7.27 

Playback Panel with one monitor.

Figure 7.28 

Export Slideshow dialog box.



Toolbar
The toolbar has some interesting features (see Figure 7.29). If you can’t see the
toolbar, hit T to turn it on and off or select it from the View menu. The first icon
on the left, the small square, takes you back to the first slide in your show. The
left and right arrows take you to the previous and next slides. The right arrow is
the Preview button. It will play your show without making your monitor go dark.
The rotation arrows are used to rotate any of the text boxes. Just click on a text
box to highlight it, and then click on a rotation arrow. In Figure 7.30, I have
rotated the rating stars to vertical rather than horizontal. You could also drag them
elsewhere if you wanted to.
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Figure 7.29 

Toolbar.

Figure 7.30 

Rotate the rating stars.



The yellow square at the top of the image in Figure 7.30 is the tether that
keeps the stars (or other text boxes) at a standard distance from the edge
of the image, no matter how the image changes in orientation or size. The
last icon is the ABC button that, when clicked, opens the Custom Text
box to allow you to change the words in any of your text boxes. There is
also a drop-down menu available, as shown in Figure 7.31, that allows
you to choose other metadata for that box. You can format that text in the
Text Overlays box in the Overlays Panel that automatically opens when
you click on the icon.

Slideshow Shortcuts
There are a number of shortcuts that can speed up your workflow in the Slideshow
Module (see Figure 7.32). Try to learn the ones you need all of the time. If you
need to see them again, they are also listed in the Help menu in the main menu.
Or you can call them up by hitting Command/Ctrl+\ (backslash).
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Figure 7.31 

Custom Settings drop-down menu.

Figure 7.32 

Slideshow shortcuts.





Preview Panel
The Preview Panel (see Figure 8.1) works in tandem with the Template Browser
(see Figure 8.2) below it. When you hover your mouse over the list of templates,
it will show you a line drawing of what the margins and borders will look like
without an image in place. Maximize Size is the default. Figures 8.3 through 8.9
show the various built-in templates. You can create your own and save those as well.

8
Print Module

Figure 8.1 

Preview Panel.

Figure 8.2

Template Browser.



Template Browser Panel
The Template Browser comes with a set of built-in templates for common uses,
such as printing contact sheets or fine art prints with large borders (see Figures 8.3
through 8.9). It is also easy to create your own and save them. In the following
sections, you will see how to make changes in the other panels, and then you can
save the template by clicking the Add button (see Figure 8.10) at the bottom left
side of Lightroom so that it shows up in the Template Browser. When you want
to use a template, select your photographs in the Library Module or Filmstrip,
and then click on the template you want to use.
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Figure 8.3 

Template Browser: 2x2 Cells.

Figure 8.4 

Template Browser: 4 Wide.

Figure 8.5 

Template Browser: 4x5 Contact Sheet.

Figure 8.6 

Template Browser: 5x8 Contact Sheet.
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To create a new template, simply design it with the controls in the panels at the
right, and then click on the Add button (see Figure 8.10). To remove a template,
highlight it and click on the Remove button. If you accidentally delete one of the
standard templates, simply Control-click (or right-click PC) on any remaining
template, and a popup menu will appear with the Restore Factory Defaults option
(see Figure 8.11). Once the images are displayed in the template, you can move
the images around with your cursor within the image cell box if you have checked
the Zoom to Fill Frame box. You cannot move the image cell box itself, however.

Figure 8.7 

Template Browser: Fine Art Mat.

Figure 8.8 

Template Browser: Maximize Size.

Figure 8.9 

Template Browser: Maximize Size Centered.

Figure 8.10 

Template Browser Add and Remove buttons. Note that 
the Remove button does not become active until a template 
is highlighted in the Template Browser.



Image Settings Panel
The Image Settings Panel is where you set gross adjustments for your printing (see
Figure 8.12). You can have the image completely fill the available printing space
(see Figure 8.14) or leave the aspect ratio the same as your image, even if you have
uneven borders (see Figure 8.15). You can also auto-rotate your images to utilize
space more efficiently (see Figure 8.13). Finally, you can fill up your template with
the same image using Repeat One Photo per Page (see Figure 8.16). 
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Figure 8.11

Control-click (right click) to restore the standard templates
if you delete or change one in error.

Figure 8.12 

Image Settings Panel.

Figure 8.13 

With Auto-Rotate to Fit selected.
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Figure 8.14 

With Zoom to Fill Frames selected.

Figure 8.15 

Without Auto-Rotate to Fit selected.

Figure 8.16 

Repeating one photo per page.



You can also add a border to your images, as well as change its size and color, by
checking or unchecking the Stroke Border box. Clicking on the color box brings
up the Colors selection wheel, and moving the slider adjusts the width of the bor-
der (see Figure 8.17). 

Layout Panel
You design the look of your printed images in the Layout Panel, as shown in Figure
8.18. When you use templates chosen from the Template Browser, Lightroom
automatically adjusts all of the settings in this panel based on your chosen tem-
plate. If you want to create your own templates, the Layout Panel is the place to
do it. The best way to see how these work is to choose a few images, and then play
with the settings as shown in Figures 8.19 through 8.21. You will quickly see what
adjustments different settings make.
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Figure 8.17 

A red border is added by adjusting the Colors selection wheel. 



Using Cell Size is another way to adjust the settings. You can see how the other
settings will move as you play with the sizes of the cells. You can constrain them
to square proportions so that horizontal and vertical images will display the same
size. You can also turn the guides on and off to see how the final piece will look.
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Figure 8.18 

Layout Panel.

Figure 8.19 

Margins: adjusting the left margin to 3 inches.

Figure 8.20 

Page Grid: here the sliders are set to display the maximum
number of images on a page.

Figure 8.21 

Cell Spacing: spacing is adjusted to give some separation
between the images.



Overlays Panel
You can place overlays on your images with an Identity Plate, information about
the photograph, or by adding page numbers, borders, page information, and
crop marks. This is done with the Overlays Panel shown in Figure 8.22. Note
that you have to check the appropriate boxes, or some of the options will be
grayed out.

To change the Identity Plate, select it by clicking in the box. Next, click on the
default Identity Plate and click on the down arrow to trigger the drop-down
menu, as shown in Figure 8.23. Once there, select Edit. The Identity Plate Editor
pops up (see Figure 8.24). Make your changes in the dialog box by choosing
your desired font and typing in any changes. Next, select Save As from the drop-
down menu in the bottom-left corner, and create a name for your new Identity
Plate. You will be able to select it in the future. You can also use the  Identity
Plate Editor to remove an Identity Plate that you no longer wish to save. 

You can create a graphical Identity Plate in another application, such as
Photoshop, and use that one as well. When you create your graphic, Lightroom
will not resize it. Keep it to 60 pixels high or less and then as wide as will fit on
your page. 
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Figure 8.22 

Overlays Panel.

Figure 8.23 

Identity Plate drop-down menu.

Figure 8.24 

Identity Plate Editor dialog box.



You can decide to print your Identity Plate on every image by checking the Render
on Every Image or place it behind your image by clicking the Render Behind
Image check box. In that case, the Identity Plate will only show up in the areas
between images in the template and will be blocked by the image itself, even in a
white area of the image. Also, you can use the rotate button in the upper right of
the Overlays Panel to rotate your Identity Plate.

If you would like to put other information on your images, use the Photo Info
check box. Next, click on the down arrow to the right of the box and click on Edit
to get the Text Template Editor (see Figure 8.25). As in similar dialog boxes, add
the tokens that you would like and create as much information as you want to add
when your image prints. You can print almost anything there. When you are done,
you can save it as a preset to use it again by selecting Save as a New Preset from
the Preset drop-down menu at the top of the Text Template Editor.

Other options in the Overlays Panel include adding
page numbers, page info, and crop marks. Page
numbers are pretty self-explanatory. Checking the
Page Info box will include the level of sharpening to
use, the profile used to print the image, and which
printer you used. This is a handy feature if you are
running tests. All of the information that you need
is printed on the page so you don’t have to write it
in by hand. Crop marks are used as a guide to trim
the images after printing,
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Figure 8.25

Photo Information in the Text Template Editor dialog
box.



Print Job Panel
The final step in the printing process is to send the image or images to your
printer. You do this in the Print Job Panel (see Figure 8.26). Draft Mode Printing
is a lower quality printing mode designed to print more quickly a rough approx-
imation of what your print will look like using the photo previews that it has
cached. In some cases, if the photographs being printed have not yet been cached,
then thumbnail previews are used to print from with the resulting lower quality.
If this is a final print, do not check this box.

Print Resolution is set by default to 240 dpi. You can change
it by double-clicking (or right-clicking) on the 240 and typing
in a different value if you would like.

The Print Sharpening options are Low, Medium, or High. You
will need to experiment a bit to see what works with any 
particular image until you get a good feel for it.

Color Management is an important selection to make for 
realistic-looking photographs. You need to decide if you will
use a printer profile or let the printer manage it. You make your
selection inform the Profile drop-down menu. Select either
Managed by Printer or Other. If you select Other, a dialog box
will pop up with a list of the profiles you have loaded so that
you can select the one you would like. There is a reminder in
Lightroom that if you select Managed by Printer, you must
turn on ColorSync color management (Mac) or ICM Method
(Windows) in the Print dialog before you begin printing. If
you have selected Other and a printer profile, then turn off color management in
your printer for best results. These profiles are purchased by you for your
printer/ink/paper combinations, obtained from your printer manufacturer for
your printer/ink/paper combination, or developed by you with special software
and hardware. If you do not have any profiles, then you will leave it set as Managed
by Printer.

After selecting the profile, you also can choose Perceptual or Relative from the
Rendering Intent drop-down menu. Rendering intent defines the method used
to fit the color in your images into the printer’s color space. The default is
Perceptual, which tries to keep everything looking the same when it maps out-of-
gamut colors into the new color space, even if it means changing In gamut colors
to make the image look as close to the same as possible. The Relative option
changes only Out gamut colors and maps them to the nearest In gamut color.
Depending on the image, one or the other may give you more pleasing results. 
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Figure 8.26 

Print Job Panel.



The toolbar at the button of the Lightroom window (see Figure 8.27) is toggled
on and off with the T key. It allows you to scroll through the images that will be
printed. The toolbar also shows you which page you are on and has left and right
arrows that move you through the different pages to see them in the window.
Clicking on the number allows you to type in the page you would like to see. This
method is faster if you have a lot of pages. You can also just click your cursor in
the numbers text box, and the numbers will increase as you drag from left to right. 

The Page Setup button on the toolbar brings up the standard Page Setup dialog
for your printers. It allows you to select which printer page setup to use, as well
as change the size of the page. Clicking the Print Settings button shows you which
printer you have selected and allows you to make changes to the settings. If you
want to save your print settings (Mac), go to Presets in the Print Settings dialog
and select Save As from the drop-down menu. Clicking on the Print button brings
up the standard Print dialog, which allows you to specify which printer to use and
how many copies to print. This allows you to make your standard selections, just
as if you were printing from Photoshop or another application. 

Here are the steps for perfect printing once you have laid out the pages (if you
have a color profile for the printer and paper/ink combination that you will use):

1. Set the Print Resolution or leave it set at the default of 240 dpi. With inkjet
printers, it is often recommended that you set it at an even fraction of 720 dpi
to minimize having to interpolate the image again. Settings of 240 to 360 will
usually work well. In any case, Lightroom will accept values of 72 to 480 dpi.

2. Select the level for Print Sharpening: None (off ), Low, Medium, or High.

3. In the Profile drop-down menu, select the paper profile you wish to use. If
none show up there, click on Other, and then select the ones you wish to add.
If the one you want is not listed, you will have to add it to the list. On a PC,
go to Printers and Faxes in the Control Panel. Right-click on your printer and
then select Properties. Next, select Color Management. Then add the profiles
that you want. Quit Lightroom and restart it. The profiles will be there for
you to select. On a Mac, simply drag your custom profiles into System/Library/
ColorSync/Profiles. They will then show up under Other where you can select
the one you want. Be sure to restart Lightroom as described above.
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Figure 8.27 

Toolbar and printing buttons.



4. Select the default Perceptual in the Rendering Intent drop-down menu.

5. Click on the Print button.

6. In the Print dialog, select the printer you want to use, the paper/media type,
ink, photo quality, and size. Select ICM or ColorSync, and turn it off. Different
printers will have different ways to specify these things. Look for Properties,
Print Settings, and Color Management. Not all printers will have these same
titles but should have something similar.

7. Click on OK or Print in the Print dialog box.

If you do not have a color profile, follow these steps:

1. Set the Print Resolution or leave it set at the default of 240 dpi.

2. Select the level for Print Sharpening: None (off ), Low, Medium, or High.

3. Under Profile, select Managed by Printer.

4. Select the default Rendering Intent of Perceptual.

5. Click on the Print button.

6. In the Print dialog, select the printer you want to use, the paper/media type,
ink, photo quality, and size. Select ICM or ColorSync and turn it on.
Different printers will have different ways to specify these things. Look for
Properties, Print Settings, and Color Management. Not all printers will have
these same titles but should have something similar. Some printers allow you
to select the printer dpi. A higher number is generally higher quality and
slower. It also uses more ink. Make your selection based upon your own needs.

7. Click on OK or Print in the Print dialog box.

Lightroom produces excellent quality prints, but it sometimes takes awhile to get
everything adjusted just right, especially if you are used to printing through other
applications. If you are having less than stellar results, recheck your settings one
by one until you get better quality. Especially, double-check that your Print dialog
box has been set properly for the profile you are using.
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Print Shortcuts
There are a number of keyboard shortcuts to speed up your workflow. They are
shown in Figure 8.28 and are also available in the Help Menu. There is a separate
table of shortcuts for each module. You need to be in the correct module before
selecting from the Help menu.
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Figure 8.28 

Print shortcuts.





Before you use the Web Module, you need to select the images that you want in
your Web gallery. This is easily done in the Grid view of the Library Module or
in the Filmstrip. You can choose a group of images or use an entire folder if you
would like. The easiest way is to select your images and create a new Collection
to put them in. It makes it much easier to add or subtract a few images and gen-
erate a new Web gallery when needed. Once you have your images selected in a
Collection, you can easily rearrange them by dragging them in the Grid view.

There are two types of galleries currently supported by Lightroom: standard
HTML and Flash, which requires the user’s computer to have the Adobe Flash
Player or other Flash viewer installed on it. The Flash version supports a slideshow
if the user has the appropriate software (the software is free to download). HTML
galleries can be seen by anyone with an Internet browser, so they are more widely
supported. Once you have decided which type of gallery you would like, you can
go to the Gallery Panel (right side of the screen) or the Template Browser (left side)
to select a gallery.

9
Web Module



Preview Panel
The Preview Panel (see Figure 9.1) works in tandem with the Template
Browser below it (see Figure 9.2). When you hover your mouse over the list
of templates, it will show you a line drawing of what the margins and bor-
ders will look like without an image in place. A preview of the Charcoal
template is the default. The figures in the following sections show the var-
ious built-in templates. You can create your own and save them by clicking
the Add button at the bottom of the left panels.

Template Browser Panel
The Template Browser (Figure 9.2) comes with a set of built-in templates
(see Figures 9.3 through 9.19) for common uses, such as displaying EXIF
metadata or setting up a Flash gallery. It is easy to create your own and save
them. In the following sections, you will see how to make changes in the
other panels, and then save the template so that it shows up the Template
Browser. When you want to use a template, select your photographs in the
Library Module or Filmstrip, and then click on the template you want to
use. If you open the Gallery Panel on the right side of your window, when
you click on a template, you will be able to see which style (Flash or
HTML) of gallery that the template is. Once you have selected your tem-
plate, you may want to close one of the side panels so there is more room
to see your complete template.
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Figure 9.1 

Preview Panel. 

Figure 9.2 

Template Browser Panel with 
built-in templates.

Figure 9.3 

Blue Sky template.
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Figure 9.4 

Charcoal template.

Figure 9.5 

Classic template.

Figure 9.6 

Dusk template.

Figure 9.7 

Earl Grey template.

Figure 9.8 

Exif metadata template.

Figure 9.9 

Flash gallery (default) template.
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Figure 9.10 

HTML gallery (default) template.

Figure 9.11

Ice Blue template.

Figure 9.12

Ivory template.

Figure 9.13 

Midnight template.

Figure 9.14 

Mossy Rock template.

Figure 9.15 

Night Life template.



The Add and Remove buttons at the bottom of the left panels are used to save
new templates you create with the panels on the right. When you have finished
creating your template, just click the Add button and name your new template.
If you want to remove a template, highlight it and then click on the Remove but-
ton. If you accidentally remove one of the standard, built-in templates, then
Control-click (or right-click) on any template that is still in the Template Browser.
Choose Restore Factory Defaults from the popup menu, and the missing standard
templates will reappear. Notice that you can also use this menu to see where
Lightroom has saved your templates so you can back them up.
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Figure 9.16 

Paper White template.

Figure 9.17 

Slideshow template.

Figure 9.18 

The Blues template.

Figure 9.19 

Warm Day template.



Gallery Panel
Lightroom comes with two gallery templates: Lightroom Flash gallery and
Lightroom HTML gallery, which are displayed in the Gallery Panel on the right
side of your screen (see Figure 9.20). After selecting a template from the Template
Browser, the Gallery Panel will display which style of gallery your chosen template
is—either Lightroom Flash gallery or Lightroom HTML gallery will be selected
automatically. If you want to do something quickly, you can just go to the Gallery
Panel and select one of the two styles of galleries, and Lightroom will automati-
cally select the default template for that style.

Labels Panel
The Labels Panel (see Figure 9.21) allows you to change the wording in your lay-
out. To change any of the wording, such as the Site Title, Collection Title,
Collection Description, or Contact Info, just click on the text box below the head-
ing, and it will change to allow you to type whatever you want instead of their
defaults see Figure 9.22). You can also click on the down arrow to select from a
drop-down menu.
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Figure 9.20 

Gallery Panel.

Figure 9.21 

Labels Panel with the defaults shown.

Figure 9.22 

Setting the titles with your own custom wording.



Color Palette Panel
The next panel is called the Color Palette Panel (see Figures 9.23 and 9.24). It
allows you to change the muted gray default colors or any of the colors in the stan-
dard templates to any color in the Colors selection wheel. Click in the small boxes
with color (or white, black, or gray, as shown in Figures 9.23 and 9.24) next to
any of the items, and the Colors selection wheel will appear. Click on the color
wheel (see Figure 9.25) and move the slider to generate different colors and tones
(see Figures 9.26 and 9.27). Notice that the color inside the boxes will change to
represent the color that you selected.
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Figure 9.23 

Color Palette Panel for the HTML galleries.

Figure 9.24 

Color Palette Panel for the Flash galleries. Note that
it has more boxes than the panel in Figure 9.23.

Figure 9.25 

Setting the Text color to red by clicking in the box and making
adjustments in the Colors selection wheel.



To match all items in the Color Palette Panel with the same color, once you have
selected a color, click inside the big block of color above the Colors wheel and drag
it to the other items’ color bars that you want to have the same color.

Appearance Panel
Underneath the Color Palette Panel is the Appearance Panel (see Figure 9.28). You
can turn the cell numbers on and off in the Rows and Columns section. This is
also where you determine the cell layout. Just click anywhere to change the pat-
tern from 3×3 to 8×5 or anywhere in between.

To change the Identity Plate (see Figure 9.29), select it by clicking in the box.
Next, click on the default Identity Plate and select Edit from the drop-down menu.
Make your changes in the dialog box by choosing your desired font and typing in
any changes. Next, select Save As from the Custom drop-down menu, and create
a name for your new Identity Plate. You will be able to select it in the future. You
can use the same menu to remove an Identity Plate that you no longer wish to save.
Also refer to the “Overlays Panel” section in Chapter 8 for more information.
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Figure 9.27 

Setting the numbers to black, but you can choose any color 
you like.

Figure 9.26 

Setting the numbers to white.



You can create a graphical Identity Plate in another application such as Photoshop.
When you create your graphic, Lightroom will not resize it. Keep it to 60 pixels
high or less and then as wide as will fit on your page. Turn your Identity Plate on
and off by clicking the little box next to Identity Plate right above the sample plate.

Output Settings Panel
You can limit the maximum size of images by using the Preview slider
shown in the Output Settings Panel in Figure 9.30. The value is in pixels.
You can also click on the number of pixels and type in the number that
you like. This is the size of the image that is shown when a visitor clicks
on the smaller thumbnail image. You can also set the quality of the JPEG
image with the Quality slider. The higher the quality, the larger the file
size will be. Finally, you can add a copyright watermark by checking the
Add Copyright Watermark box.
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Figure 9.28 

Appearance Panel.

Figure 9.29 

Identity Plate is enabled and shows up on the top of the Web page.

Figure 9.30 

Output Settings Panel.



Image Settings Panel
You can use the Image Settings Panel (see Figure 9.31) to type in a title or caption
if you select Custom Text from the Title drop-down menu (see Figure 9.32). If
you type directly in the Custom Text field (see Figure 9.33), then all of the images
on your Web gallery will have the same title or caption. If instead you select Edit
from the drop-down menu, you can choose tokens from the vast assortment in
the Text Template Editor (see Chapter 7, “Slideshow Module,” for more infor-
mation on the Text Template Editor), and each image will have its own personal
data. If you want to have text showing with your larger images, then check the
Title and/or Caption boxes. 

In Figure 9.33, a larger view is shown after
clicking on one of the images in the Web
gallery. You can see many choices of informa-
tion available to show underneath your image,
including Date, IPTC, and EXIF metadata.
You can add similar tokens to both the Title
and the Caption display.
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Figure 9.31 

Image Settings Panel.

Figure 9.32 

Selecting Custom Text in Title menu
by clicking on the down arrow.

Figure 9.33 

The larger image is shown with text after clicking on the thumbnail.



Output Panel
The Output Panel (see Figure 9.34) allows you to preview your Web gallery
in a browser by clicking on Preview in Browser, naturally enough. The
Output Panel also shows you which FTP server you will be using. You must
create a preset first before you can upload your completed Web gallery.
Click on the small down arrow to the right of FTP Server. The Configure
FTP File Transfer dialog box will pop up, as shown in Figure 9.35. You will
need to fill in the information for Server,
Username, Password, Server Path, and so
on. Name your preset, and you are ready
to upload. You can save your Web gallery
by clicking on the Export button at the
bottom of the right side panels. This will
bring up a navigator for you to specify
where you would like to save the Web
gallery. Next, click on the Upload button,
and upload your Web gallery to your
Web space.

Web Shortcuts
There are a number of keyboard shortcuts to speed up
your workflow. They are shown in Figure 9.36 and are also
available in the Help menu. There is a separate table of
shortcuts for each module. You need to be in the correct
module before selecting the Help menu.
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Figure 9.34 

Output Panel.

Figure 9.35 

Configure FTP File Transfer dialog box.

Figure 9.36 

Web Module shortcuts.





This section will provide you with a number of resources to improve
your digital photography and your use of Adobe Photoshop Lightroom.
There is a glossary, a list of suggested books to read, some Web links,
and a list of the keyboard shortcuts for each module. Use these items
also to help you advance in your education and experience.

Appendixes





A
Glossary

There are an incredible number of terms used in digital photography. Following
are the definitions of many of them.

35mm camera: A popular camera size that uses 35mm film cassettes.
Standard lenses for digital cameras are often compared to the same size lens
on a 35mm film camera and called 35mm camera equivalent.

8-Bit: A color system where each color is represented by 8 bits. This means
that each color can be 256 possible colors (28). Since there are three colors in
the RGB (red, green, blue) system, this means that there are 256×256×256
or 16,777,216 different colors available for each pixel.

16-Bit: A color system where each color (RGB = red, green, and blue) is 
represented by 16 bits. By capturing and storing images in 16-bit, there is less
chance of artifacts and banding as the image is adjusted. This produces 
the highest quality image. Note that although RAW images are represented
by 16 bits, there is often only 12 or 14 bits of real data available. For some
uses, such as the Web, there is no real advantage to having 16-bit images.

Accessory Shoe: The shoe on top of the camera that is designed to hold elec-
tronic flashes or other accessories. Most accessory shoes on modern cameras
have built-in contacts for an electronic flash. See also hot shoe.

Adobe RGB (1998): A color space that is used frequently by commercial 
photographers. It is probably one of the most popular spaces to store images in.



Alpha Software: Software where the feature set has not yet been finalized.
Although Lightroom was first issued as a public beta, it was actually alpha
software because the feature set had not yet been locked. See beta.

Ambient Light: The natural, existing light around a subject, which is available
without the photographer having to add more. It can be indoors or outdoors.
See also available light and existing light.

Aperture: The opening in the lens that light travels through on its way to the
sensor. The size of the opening is controlled by the camera settings and can
be larger or smaller to let in more or less light. A number such as f 5.6 indi-
cates the size of this opening. See also f number.

Aperture Priority: A setting on the camera where the photographer sets the
aperture desired and the camera automatically sets the shutter speed.
Photographers use this setting when they want to control the depth of field
by making it larger (more area in focus) or smaller (less area in focus).

Application: Refers to the software used on a computer. In digital photogra-
phy, it is more specifically the software used to transfer the images from the
camera to the computer to process the images and to save them in a more per-
manent form.

Artifact: An unwanted destruction or modification of a pixel or group of pixels
that shows up in an image. It is often in the form of small multicolored halos
or other patterns in a photograph.

Artificial Light: Any light that is not natural (that is, from the sun). It can
be an electronic flash, floodlights, or any other man-made light.

ASA: Stands for the American Standards Association. Although they set stan-
dards for all kinds of products and measurements, in photography it refers to
the speed or sensitivity of the film. It is no longer used and was replaced by
ISO.

Aspect Ratio: A number, such as 3:2, which represents the length of a 
photograph divided by its width. For example, 35mm film and some digital
cameras have an aspect ratio of 3:2, and other digital cameras and computer
monitors have a ratio of 4:3. 

Autofocus: A feature on most digital cameras where the camera will determine
the correct focus where its sensor is pointed and set that focus on the lens. 

Automatic Aperture: This means that the camera will determine the correct
aperture for the photograph. The aperture remains open (brighter) until the
shutter is pressed when it closes to the correct size to take the photograph. 

Automatic Camera: A camera that selects a combination of shutter speed,
aperture, and focus to produce a photograph. 
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Automatic Exposure (AE): Also called autoexposure. The camera selects a
combination of shutter speed and aperture setting based on its programming
and the settings selected by the photographer to create a proper exposure. This
proper exposure is not necessarily the best exposure in any situation. The more
expensive the camera, typically the more sophisticated the camera’s program-
ming and the more easily it can handle difficult lighting situations. Even the
most expensive and most sophisticated camera requires interpretation on the
part of the photographer to create the desired image.

Automatic Flash: An electronic flash that connects to a camera and sends
information back and forth to select the proper amount of light to match the
camera’s settings. Like automatic exposure, automatic flash needs the input
of a photographer to provide the best results.

Automatic Lens: A lens that remains open, set on its widest aperture, until
the shutter is pressed. This is important when using a lens on an SLR cam-
era. It is faster and easier to use and provides a brighter viewfinder on an SLR.
The opposite of an automatic lens is a manual lens. Manual lenses are rarely
used with digital cameras, except for special purpose lenses.

Available Light: See ambient light.

Backdrop: The scene behind a subject in a photograph. It generally refers to
man-made backgrounds in a studio, but a backdrop could be used outdoors
as well.

Background: In a studio, the background is the same as a backdrop.
Outdoors, it is whatever is behind the subject in the photograph.

Back-Lighting: Lighting coming at your subject from behind. It generally causes
a glow around them. You need to watch for flare when using back-lighting.

Beta Software: Software where the feature set has been locked, and it is being
distributed to a wider audience to check it out on a larger number of com-
puter systems under a variety of conditions to look for bugs or problems. See
alpha software.

Bit: The smallest unit in computers. A bit is either one or zero. See also byte.

Bit Depth: The number of bits of data needed to represent a pixel. A typical
digital image needs at least 8 bits for each of the three colors (RGB = red,
green, and blue), giving a total of 24 bits needed. Some higher-end digital
cameras can use 12 bits for each color.

Black and White: A term used for images without any color in them. A more
correct term is grayscale. See grayscale.

Blacks: The very darkest tones in an image.
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Blinks: A term referring to an image when the subject’s eyes are closed. It is
also used as a general term for mistakes and bad images.

Blur: When parts of a photograph are “smeared” and lacking sharply defined
edges. Camera or subject movement causes blur generally, although the 
photographer can create it with some cameras by zooming while operating
the shutter. It can be used as a creative tool. Don’t confuse it with the image
being out of focus or an undesired camera shake. To eliminate blur, it is 
necessary to use a faster shutter speed.

Brightness: Brightness, hue, and saturation make up the components of color.
Brightness refers to the intensity of the light or image.

Built-in Flash: Most digital cameras have a small flash built in to the camera.
These are often difficult to use, either overexposing or underexposing the
image. They are usually not very powerful and useful only for subjects 10 feet
away or less.

Byte: The basic unit used in computers. It is made up of 8 bits.

Calibration: The process of adjusting any digital device, such as a camera,
monitor, printer, or scanner, to reproduce color in a consistent manner. An
image file processed on a properly calibrated system will reproduce the same
on any calibrated printer or look the same on any calibrated monitor. This is
a process that all professional photographers must become proficient at. 

Camera Calibration: A tool in Lightroom used to correct for a coloration
bias in a particular camera.

Camera Shake: Movement of the camera when the shutter is pressed. It will
often cause unwanted blur. To reduce camera shake, hold the camera firmly
and hold your body against a tree, wall, or other suitable support. Increasing
the speed of the shutter or using a tripod will also help.

CCD: Stands for Charge Coupled Device. It is the light-sensitive chip used in
many digital cameras, which is used to generate the image. The small cells, or
pixels, on the CCD send electrical signals to the camera’s processor to create
the image. 

CD: An abbreviation for Compact Disc. In digital photography, CDs are often
used to store images and to transfer images from computer to computer. CDs
vary greatly in quality and can have a life expectancy of anywhere from a few
years (if you are lucky) for the really cheap CDs to 100 years or more for the
archival, more expensive ones. They typically will hold 650 to 700 MB of
images. The actual amount of storage available is somewhat due to directory
size requirements.

CD-R: Refers to a CD that can only be written to once. See CD.
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CD-RW: Stands for CD-Rewritable and can be written to many times.
Because of this capability, they are not as useful for long-term storage. See CD.

Clipping: Occurs when information is being lost in either the shadows (left
side of the histogram curve) or highlights (right side of the curve). The curve
looks like a cliff where the values pile up against one side, rather than a smooth
transition to zero (a gentle slope from the peak value to zero rather than an
abrupt drop), because it has been cut off or clipped.

Cloning: A function available in image editing programs to take a portion of
an image and place it over another part of the image. For example, a piece 
of clean skin can be cloned or stuck over the top of a blemish to remove the
blemish.

CMOS(pronounced C-moss): Stands for Complementary Metal-Oxide
Semiconductor. It is a type of image sensor used in some high-end digital cameras.

Collection: Collections are similar to Shoots, except that each photograph
can be in as many Collections as you would like. Collections take up very 
little extra space because only a reference to the original is stored there, not
another copy of the image. See shoot.

Color Balance: The relationship of the different colors to each other.
Normally, the concept is to adjust the color balance so that it reproduces the
scene that was photographed as accurately as possible.

Color Space: A combination of a color model and a color mapping function.
You can have a color model, such as RGB, and then have a number of differ-
ent color spaces, such as sRGB and Adobe RGB. RGB is a color model and
not a color space on its own. The type of RGB color space needs to be defined.
A color space is usually represented by a three-dimensional graph with x, y,
and z axes representing hue, saturation, and brightness. This is the HSB color
space. In the case of a RGB color space, the x, y, and z axes would represent
red, green, and blue (RGB).

ColorSync: A color management system developed by Apple to provide color
matching between different devices. At first, ColorSync was developed for the
Macintosh computer, but later versions were developed to be cross-platform.
The International Color Consortium was co-founded by Apple to develop
the cross-platform version of ColorSync. ColorSync utilizes device-specific
profiles to produce the color matches as images travel between devices. These
profiles are what synchronize the colors so the appearance of the image stays
as constant as possible, given the constraints of the hardware device itself.

Compact Camera: A small and usually simple camera that is often called a
“point-and-shoot” camera.
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Compact Flash: A type of memory card used in some digital cameras to store
images.

Compare View: In Lightroom, this view allows the comparison of several
images at the same time in the main viewer window.

Compression: A technique where the size of an image file is reduced through
various computational methods. The transmitting or storing of images is
either faster or takes up less room. Some methods, such as JPEG, lose data
when they compress (called lossy compression); others, such as TIFF-LZW,
do not lose data (called lossless compression), but do not compress images as
much.

Contact Information: Refers to information on how to contact the photog-
rapher and usually indicates an email, phone number, or address.

Contrast: The range of brightness in a scene or photograph. It is the amount
of difference between the brightness points, or highlights, and the darkest
points, or shadows.

Constrasty: An image that has a large amount of contrast, for example, an
image that has bright sunlight and dark, deep shadows has a lot of contrast.

Copyright: Gives the photographer the exclusive right to reproduce his
images. Copyright also refers to a formal procedure in the United States of
registering images, which will provide the greatest return in a court case.

Corrupted: Means something in the image file has changed and is “broken.”
There are software tools available to fix some types of corruption in an image
file.

Cropping: The method by which portions of an image are removed to
improve composition or remove extraneous items from the photograph. It is
also the name of a tool in Photoshop that is commonly used to accomplish
this.

Database: A way of storing information in a computer.

Depth of Field:The distance, or depth, in a photograph, which is in focus.
It is also sometimes called depth of focus.

Develop Module: The module in Lightroom where detailed adjustments are
made to an image.

Digital Camera: A camera that uses a light-sensitive image sensor instead of
film to record the image.

Digital Slideshow: A slideshow of digital images on a computer.

Digital SLR: A digital camera with interchangeable lenses that uses the same
lens for viewing and taking the photograph. See digital camera and SLR.
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Digital Zoom: A feature on some cameras that enlarges the image electroni-
cally instead of optically. It is not a true zoom and does not do anything that
cannot be done later to the image on the computer.

Dimming Levels: Refers to the different brightness levels of the Lightroom
program in the background that the user can control while viewing an image.

DNG File Format: Stands for Digital Negative. It is a universal raw file for-
mat developed by Adobe.

Download: The process of getting the images from the camera or media card
into a computer.

DPI: Stands for dots per inch. It is a term used in the printing industry and
often used incorrectly in photography to refer to the resolution of a file. See PPI.

DSLR: A digital single lens reflex camera. See SLR.

DVD: A storage medium that can currently hold up to 4.7 GB of images. 
A DVD is the same size as a CD, and often the same drive can be used to 
create (or burn) both. New technologies are coming out to allow recording
on both sides of special DVDs to double the amount of storage.

Editing: Sometimes confused with the term retouching, editing refers to the
selection of the best images.

Edit in External Editor: A function in Lightroom used to send an image out
to an external editor such as Photoshop. After adjusting an image in an exter-
nal editor, clicking Save in the editor will save an edited copy back to the
Lightroom Library.

EI: Stands for exposure index.

Electronic Flash: A device that creates a bright flash of light to add light to
a scene. Batteries often power it, although some studio units plug into the
wall. The color temperature of the light it produces is similar to daylight, so
it mixes well outdoors. Indoors, the light is colder (more blue) than the light
produced by ordinary incandescent room lights.

EXIF: Information that your camera records with your image. This includes
things such as focal length, ISO, shutter speed, and f-stop. See metadata.

Existing Light: See ambient light.

Export: How you get your images out of Lightroom. You don’t need to save
images because they are not changed after you import them. When you
export, you can specify where a copy of the image is to be sent, the color space,
file format, and size that it should have.
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Exposure: The combination of shutter speed and aperture settings allowing
light to pass onto the digital image sensor.

Exposure Compensation: An adjustment that can be set on many digital
cameras to change the automatic exposure determined by the camera to bet-
ter reflect the desires of the photographer.

Exposure Index: Also called EI, is a number reflecting how sensitive a par-
ticular setting on the camera will be to light. It is a rating used by digital cam-
eras to represent how they would act if the sensor were film instead of
electronic.

f-number: Refers to how much light a lens will let pass. The smaller the num-
ber, the more light it will let through. Usually, the smaller the number, the
larger the diameter the front glass will need to be to let in the additional light.
In addition, the smaller the number, the more expensive the lens will be. It is
a number that relates the size of the focal length of the lens to the diameter
of the lens.

f-stop: The f-number setting on the lens. The most commonly used whole 
f-stops are 1.4, 2, 2.8. 4, 5.6, 8, 11, 16, 22, and 32. There are sometimes 
numbers in between, such as f1.8, which are partial f-numbers. Note that each
f-stop provides twice as much light as the one above it. So f2.8 allows in twice
as much light as f4.

Fast Lens: A lens that has a larger aperture opening, allowing more light to
enter the camera.

File Format: The generic term for the method of storing an image in digital
form. JPEG, TIFF, and RAW are common types of file formats, but there are
many more.

Filename: The name of the image. It is usually followed by a period and a three
or four letter abbreviation (extension) of the file type, such as .jpg or .tiff.

Fill Flash: A method of using an electronic flash to add light to a scene to
reduce the contrast. It is often used outdoors to remove shadows from a face
or to brighten it.

Fill Light: A tool in Lightroom used to bring back details in the shadows. It
works by amplifying the values in the shadows. One problem is that it is also
increases the noise in the dark areas at the same time. Noise looks like multi-
colored confetti. The noise level should not be increased too much.

Fill Lighting: Similar to fill flash except that the lighting does not have to be
from a flash. It could be from a reflector or a floodlight among other kinds of
lighting.
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Film Speed: A measure of how much light is needed to provide an exposure
on film. It is also a generic term that refers to a similar amount of light falling
on a digital sensor. The “faster” the speed, or the higher the number, the less
light is needed to produce an exposure. There is usually a penalty paid, in
either increased grain (film) or increased noise (digital), when a higher speed
is selected.

Filmstrip: Runs across the bottom of all of Lightroom modules. It displays
all of the images you are currently working on. You can select a specific shoot,
all images, a Collection, Quick Collection, or a group chosen by keyword.
You can turn the Filmstrip on and off with the down arrow at the bottom of
the center window right above the Filmstrip. If you Control-click (Mac) or
right-click (PC) on the down arrow, a drop-down menu will appear. This
menu allows you to lock the Filmstrip open or closed, or set it to open auto-
matically when you move your mouse over the bottom of the screen. You can
also set the Filmstrip so that you have to click on the arrow to open it, but it
will close as soon as you move your mouse.

Filters: In Lightroom, it is a way to find images with specific keywords
assigned to them. It is located in the Library Module.

Firewire: A technical specification and type of cable used to transfer data or
images from one digital device to another. Firewire is faster than USB, another
technical specification. It is also called IEEE 1394.

Flare: The bright light hitting the camera that causes a reduction in contrast
and bright streaks or patterns in the image. Usually, shooting into the light
or having an object in the scene reflecting light directly into the lens causes
flare. The use of a lens hood or other shading device will help to reduce this,
as will moving to a different angle.

Flash: A sudden bright light used to add light to a scene. Today, it almost
always refers to an electronic flash, built in or added on, although flash bulbs
and flash powder have been used in the past.

Flash Exposure Compensation: Similar to Exposure Compensation, except
that it refers to an adjustment to increase or reduce the amount of light pro-
duced by the flash on the camera.

Flash Fill: See fill flash.

Flat Lighting: Lighting that produces very little or no shadow. This results
in an image that is lacking in light direction and contrast. Generally, some
contrast is desirable in a photograph.
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Focal Length: Tells the relative angle of view of a lens in comparison to other
lenses. With digital cameras, it is related to a 35mm equivalent, the results of
the lens if used on a 35mm film camera. The number is expressed in mil-
limeters (mm). It is calculated by setting the focus of the lens to infinity and
measuring the distance between the focal point of the lens and the film plane
or image sensor location. The focal length of a lens is usually engraved around
the end of the lens or on the lens barrel. Lenses around 50–55mm are con-
sidered “normal” lenses because they approximately reproduce the angle of
view of the human eye. Lenses smaller than that are wide angle, showing a
wider field of view in the image than the human eye. Lenses larger than that
are telephoto, magnifying the scene so that everything appears closer.

Focus: An image is said to be in focus when it is sharp and well defined. It is
also the process of adjusting the sharpness of an image.

Font Size: In Lightroom, it is the size of the font or characters used in the
various overlays that can be placed on an image.

Foreground: Everything closest to the camera or in front of the main subject
is considered to be the foreground.

Formatting: The preparation of the digital camera’s memory card to receive
images. It is similar to erasing the memory card. To avoid problems, it is best
to format the memory card in the camera and not in a computer. It should
be done every time you download images from the camera into the computer.
Be careful when you format. It essentially erases the images from your mem-
ory card, although there is some software that can reverse the process if you
have not taken any additional photographs yet. Sometimes, formatting is
also called initializing.

GB: Stands for gigabyte, which is about 1,000 megabytes, or about a billion
bytes. It is a unit of measurement used to specify the size of camera media
cards and disk drives. 

Glyph: The weird squiggly things at the bottom of each panel to indicate the
end of the panels. These can be customized by users.

Grayscale: Another term for a black-and-white image. Because there are no
colors, just shades of gray, grayscale is a way of representing a black-and-white
digital image without using RGB, thus being one-third the size. Because it
uses a bit depth of 8, there are 256 different shades of gray between pure white
and pure black.

Grid View: The view in the Library Module with multiple thumbnails of the
images. It is selected by pressing the G key.
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Guide Number: A number assigned to electronic flash units to indicate how
powerful they are. The higher the Guide Number, the more powerful the flash
is. Use this number with caution. Manufacturers have been known to exag-
gerate this number by the way they measure it. It is dependent on the sensi-
tivity setting of the camera, so the number is usually quoted, by convention,
at an ISO of 100. The Guide Number is equal to the aperture (f-stop) 
multiplied by the distance from the camera to the subject and will reference
either feet or meters. Thus a Guide Number of 40 means that you could use
f4 at 10 feet.This number is useful when purchasing different flash units as a
way to judge how powerful a flash unit is, but otherwise is not used very often
with automatic cameras.

Hard Lighting: Lighting that produces sharp shadows. It is produced when
the apparent size of the light source is small compared to the subject size. Thus
the sun produces a hard light, but a hazy day produces a soft light because the
entire sky becomes the light. 

High Contrast: The opposite of flat lighting. When an image or scene is high
in contrast, it means that there are fewer tones between black and white.

High Key: An image made up mainly of light tones. An example would be a
woman wearing a white dress against a white background. If done properly,
a high key image can be very striking because the skin tones stand out in con-
trast to everything else.

Highlight: The brightest part of an image.

Histogram: A feature available on many digital cameras, which shows a
graphical representation of how much of each tone a photograph has in it.
When an image is displayed on the camera’s LCD (or in Photoshop), there is
a button to activate and display a small graph. The graph should be a curve
starting at the left (dark tones) side, rising in the center, and falling on the
right (light tones) side. If the curve is not centered or rather is “piled up” at
one end, it often indicates an exposure adjustment would be useful.

History Panel: As you perform adjustments on your image, step-by-step
instructions are kept for you in the History Panel.

Hot Shoe: What the accessory shoe on a camera is called when it has contacts that
match up with the contacts on an electronic flash so that no cord is necessary.

Hovering: Holding the mouse or cursor over a button or listing without 
actually clicking on it.

HSB: An abbreviation for the three parts of color: hue, saturation, and 
brightness. See each term separately for more detailed information.

Hue: The representation of color, often using a color wheel.
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ICC: Stands for the International Color Consortium. It generally refers to the
color profiles used to describe the color characteristics of various devices, such
as printers, to enable software to convert colors between devices so that they
look as similar as possible. It was originated by Apple Computers.

ICM: The same as an ICC profile, except that it is used by Windows com-
puters. See ICC.

Identity Plate: A short block of text or a graphic that is placed on an image
to identify the photographer.

Illegal Characters: Any character used in a filename other than the standard
0–9, A–Z, dash (-), and underscore (_). Illegal characters should be avoided
in filenames for better operation.

Image Browser: Software or a computer program used to view images. An
image browser is usually built into each computer and usually comes with
each digital camera.

Image Editing Program: A piece of software used to make corrections to
images. Photoshop is an example of an image editing program. Digital cam-
eras usually come with an image editing program on their software CD.

Image Resolution: See resolution.

Import: The process by which images are brought into Lightroom by mov-
ing them into the Lightroom Library or by referencing them in their existing
location. Nothing can be done with an image until it has been imported.

Impromptu Slideshow: A technique to quickly set up a slideshow in the
Library Module by highlighting the images and clicking the Play arrow in the
center of the toolbar.

Initializing: See formatting.

Inkjet: A type of printer used to print images that operates by spraying tiny
droplets of ink onto the paper. It usually uses the colors of cyan, magenta, 
yellow, and black, which are the standard colors used in printing presses as well.

Interpolation: A technique used by computer programs, such as Photoshop,
to enlarge images by creating pixels in between existing pixels. If done properly,
and not to a high degree, it will result in a larger image than the original.

IPTC: Metadata that you add to your image, such as a caption, copyright
information, contact information, and URL. See metadata.

ISO: Stands for International Organization for Standardization, the replace-
ment of ASA to set standards for many businesses and technologies. Here, it
is used as a measurement of film speeds and now digital camera sensitivity.
Thus you have ISO 400.
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JPEG: A file format widely used in digital photography. The name stands for
Joint Photographic Experts Group. The file format compresses the size of digi-
tal images by throwing away data that the algorithm believes is duplicated.
The amount of the compression determines the amount of data that is thrown
away. In Photoshop, the compression can be set from 1 (most) to 12 (least).
Each time you open and resave the image, it throws away data and gets pro-
gressively worst. This should obviously be avoided. It is called a lossy format
because some data is lost. The image is named with the last three letters after
a period, indicating the file format as in sample.jpg.

Keywords: Words used to describe an image in such a way that it makes it
easy to search on the computer to find the images desired. Some people use
the term tags to mean keywords.

Lens Speed: A rating of a lens based on its widest aperture or smallest f-num-
ber. A “faster” lens has a smaller f-number.

Library Module: The first module in Lightroom used for importing, export-
ing, and sorting of images.

Lights Out: A mode where all parts of the Lightroom program interface are
turned off with the exception of the image itself. This is used to better view
the image. Use the L key to cycle through the various modes

Liquid Crystal Display (LCD): The small display screen on the back of most
digital cameras. This is one of the most powerful features of digital photog-
raphy—instant feedback. Do not use LCD screens to judge exposures. Only
histograms can help you there.

Lossy Format: Refers to a file format that compresses a file to save space by
throwing out or losing data. See JPEG.

Loupe View: An enlarged view of an image. Pressing the E key puts
Lightroom into Loupe view. The size of the enlargement is user-selectable.

Low Key: The opposite of high key. The tones in the image are usually mid-
dle or dark with no light colored objects.

Luminosity: The brightness of a color.

LZW Compression: A compression technique for TIFF images that does not
result in the loss of information when used.

Macintosh: A type of personal computer manufactured by Apple Computers that
runs the Macintosh operating system known as OS X (Operating System 10).

Managed Folders: The folders within Lightroom that Lightroom controls.
These are generated when images are copied or moved into Lightroom rather
than referenced. See referenced.
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Manual Focus: The opposite of auto focus. The focus must be done by the
photographer by hand instead of letting the camera do it automatically.
Manual focus is also a feature on some cameras that can be used in difficult
situations where the scene is changing faster than the camera can focus, where
the desired focus point is different than what the camera can select, or when
objects are moving in between the camera and the subject, fooling the auto
focus system.

Media: Where images are stored. Memory cards, CDs, and DVDs are all
examples of media. See memory card.

Megabyte (MB): A measure of how large an image is when it is opened up
or stored in an uncompressed format. Although mega means million, a
megabyte is actually 1,048,576 bytes, due to the way measurements are done
on computers.

Megapixel (MP): Refers to how many pixels a camera uses. Mega means
million, so a 3 MP camera has 3 million pixels.

Memory Card: The device inserted into a camera to store images on. It could
be considered digital “film.” See media.

Menus: In Lightroom, menus are the very top row of drop-down choices that
are always visible.

Metadata: Information that is stored with your image, either within the image
file or in a separate XMP “sidecar” with the same name except for ending in
.xmp. See EXIF and IPTC.

Metadata Editor: A generic description of the type of software that
Lightroom is. See also non-destructive editing.

Midtones: The tones in the middle between highlights and shadows. They
are also called average tones.

Modules: The main general functions of Lightroom. They consist of Library,
Develop, Slideshow, Print, and Web Modules.

Module Picker: The onscreen menu header that allows you to easily and
quickly move between the Library, Develop, Slideshow, Print, and Web mod-
ules. By clicking on the small triangle at the top center of the Module Picker,
you can hide or reveal it for use.

Natural Light: Generally refers to light outdoors, so it means sunlight or nat-
urally reflected sunlight.

Noise: Some people call noise digital grain. However, noise is rarely an attrac-
tive feature of an image, while film grain can be. It can be recognized as 
multicolored speckles throughout the image. Noise is usually caused by too
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little light so that the image has to be enhanced electronically, either in the
camera or after the fact. Noise is reduced by adding more light, increasing
exposure time, reducing the ISO sensitivity, or all of these.

Non-Destructive Editing: Adjustments made to an image only at the time
of output without changing the original file. The adjustments are stored as
metadata instructions rather than changes to pixels. This is the adjustment
method used by Lightroom.

Normal Lens: A lens, which closely approximates the view of a human eye.
The 35mm equivalent is around 50–55 mm.

Optical Zoom: A zoom lens where the focal length of the lens changes by
twisting, pulling, or pushing a button. The focal length of the lens changes
by moving the various optical glass elements in relation to each other. It is 
a useful and convenient lens to have on the camera. It is usually just called a
zoom lens.

OS X: The operating system used by Macintosh computers. It is also known
as OS 10, plus various versions, such as 10.4.8.

Overexposure: When too much light arrives on a light sensor. Usually, the
image is very light with no detail in the highlights and few or no blacks in 
the image.

Panels: The areas on the sides, top, and bottom of the screen that will slide
out or in when you click the arrows on each side. These panels contain much
of the functionality of Lightroom. Each module (Library, Develop, Slideshow,
Print, and Web) has its own set of panels. The panels are used to operate on
the image or images shown in the middle of the screen.

Photoshop: A popular and somewhat expensive photo manipulation software
made by Adobe. Professional digital photographers usually need to be famil-
iar with and use this program or else pay someone else to do it.

Pixel: The smallest digital photographic element. It stands for picture (or pix)
element. Each pixel is made of a red, green, and blue (RGB) component.

Pixel Editing: A process used by software programs, such as Photoshop,
where the individual pixels in an image change their values when the image
is adjusted. See non-destructive editing.

Pixelation: The undesirable effect where the sizes of individual pixels are
larger than the detail in the image. Enlarging an image too much usually
causes it.

Point and Shoot: Refers to a simple type of digital camera. See compact camera.
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Portfolio: A group of images, usually in a nice folder or notebook, to show
off the work of a photographer or model. It should show their style, range,
and experience. It is used to show prospective clients.

PPI: Stands for pixels per inch.

Preferences: The user-definable selections for global values to be applied to
how Lightroom operates. This allows a great deal of customization.

Preset: A way to save settings in various panels and modules in Lightroom so
that settings do not have to be re-entered continually.

Print Module: One of the main functions of Lightroom. All printing begins
by using this module.

ProPhoto RGB: A wide gamut color space used internally in Lightroom to
operate on all images.

PSD: The Photoshop file format. It allows layers when used within Photoshop.

Quick Collection: A temporary collection you can set up by simply clicking
on an image and pressing the B key. That image is added to the Quick
Collection. The images you select for a Quick Collection do not have to be
from the same shoot. You can only have one Quick Collection. When you are
finished with it, you need to clear it out (Shift+Command+B) so that it is
available for the next use. Quick Collection is one of the key tools in
Lightroom that makes it possible to quickly process images to a form of out-
put. See Collection.

Quick Develop: A way to quickly adjust images on a gross level to get them
ready for viewing. This is located in the Library Module and can be used to
develop a number of images at the same time.

Rating: A subjective quality judgment assigned to an image. In Lightroom,
this can be from five stars to blank (zero stars).

Raw: A format offered by some digital cameras that stores the unprocessed
electrical signals from the sensor in a special format. The raw format is usu-
ally different for each camera. The advantage of the raw format is that many
decisions on things like white balance or color temperature can be decided by
the photographer later and processed in the computer rather than in the cam-
era. The photographer can try a number of options until he gets the image
exactly the way he likes it. The disadvantages of the raw format is that it takes
up more storage space on the digital memory card, the camera often works
more slowly, and it takes more post-production time at the computer.
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Recovery: A tool in Lightroom used to recover highlights. This is a very 
powerful tool to use to bring highlights back, especially from RAW files. It is not
a miracle worker, however. If the highlights are totally blown, they cannot be
brought back.

Recycling Time: Refers to the period of time after an electronic flash has fired
until it is ready to be fired again. This period usually increases as the batter-
ies get weaker. 

Red Eye: When a subject’s eyes appear to be red. The irises of the eyes are red
instead of black because light from the flash is reflected back from inside of
the retina directly to the camera. It can be avoided by moving the flash head
away from the center of the lens, either to one side or higher on an arm. It is
difficult to do with many hot shoe flashes. 

Red Eye Reduction: A feature of some cameras where the flash has multiple
short bursts of light before the main flash to reduce the size of the iris so that
there is less red reflection.

Reference Files: This means that the Lightroom database just points at your
images wherever they are located and doesn’t change or move them.

Removable Media: See media and memory card.

Resolution: A measure of how much fine detail is in an image, either in a
printer or a camera. It is often measured by pixels per inch (PPI).

Retouching: Changing things in photographs to reflect what the photogra-
pher saw in his mind, rather than what was really there. Examples include the
removal of blemishes not hidden by makeup, fixing straps that should not
have been seen, or other kinds of manipulations.

RGB: Stands for Red, Green, and Blue, the three colors used to form a digital
photograph.

Rule of Thirds: A compositional technique. Dividing an image into three
equal sections vertically and three horizontally gives an image with nine 
rectangles, sort of like having tic-tac-toe inscribed on the image. The four
junctions where the lines meet are good areas for subject placement.

Saturation: One of the three components of color, it refers to the purity of
the color. When a color is saturated, then it is the most pure color possible. 

SD Memory Card: A type of memory card, just as Compact Flash is a type
of memory card. See memory card.

Search: A way to find images using keywords and the Filter function in
Lightroom.

Shadow: The darker portions of an image.
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Shadow Detail: The amount of detail that can be seen in the darkest shadow
portions of an image.

Shadowland: The code name for the project that developed what became
known as Adobe Photoshop Lightroom.

Sharpness: The amount of definition between adjacent elements of a photo-
graph. An image is said to be sharp when the edge between lighter and darker
portions is very fine.

Shoots: When you import your photographs, they are put into a shoot. A 
photograph can be in only one shoot. You can create a hierarchical setup for
your shoots by creating a folder for each year and then inside that folder 
having another folder for each month.

Shortcuts: Keystroke commands to quickly accomplish tasks in Lightroom.
They are listed in the Help menu for each module. Examples are pressing G
to go to Grid view and E to go to Loupe view.

Shutter: The part that covers the aperture and is removed to take a photo-
graph. The shutter blocks light from traveling through the lens and striking
the image sensor on a digital camera. It can be made of curtains or blades.

Shutter Lag: The amount of time between the time the shutter release is
pressed and the shutter fires. The best cameras try to make this time as short
as possible. Be sure to test any camera before you buy to make sure any 
shutter lag will work okay with your subject matter.

Shutter Priority: An automatic setting on a camera allowing the photogra-
pher to specify the shutter speed and have the camera select the aperture. It
is often used for artistic effect, when the photographer wants to use a slower
shutter speed than the camera would normally select.

Shutter Speed: The period of time that the shutter is open, allowing light to
reach the image sensor. The faster the shutter speed, the less light reaches the
sensor.

Sidecar File: A small file with a similar name to that of the image that is 
created to store the metadata. See XMP.

Side Lighting: When the subject is lit from one side.

Silhouette: When the subject is dark and has no detail, but the background
is lighter and is well exposed.

Single Lens Reflex (SLR): A type of camera where the optical viewfinder sees
through the same lens as the light sensor. This type of camera allows the pho-
tographer to see exactly what he will be photographing. It also allows the
changing of lenses. SLRs are typically more expensive than other types of 
cameras due to their greater complexities.
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Slideshow: See digital slideshow.

Slideshow Module: The module in Lightroom, which is used to create dig-
ital slideshows. See digital slideshow.

Soft Lighting: The opposite of hard lighting. It is lighting that produces shad-
ows without a sharp edge. It is generally more flattering for portraits than hard
lighting. It is produced by any light source that is large in comparison to the
subject. The larger and closer a light source is to subject, then generally, the
softer the light is.

Software: A computer application, which contains instructions to tell the
computer what to do.

sRGB: A small gamut color space that is used in many digital cameras, digi-
tal labs, and on the Web. In general, it is best to use a wider gamut color space
whenever possible. See Adobe RGB (1998) and ProPhoto RGB.

Stop: A term used to describe either doubling or halving the amount of light,
which equals one “stop.” See f-stop.

Subject: The main focus of the image.

Sync: A tool in Lightroom that is used to copy the settings from one image
and apply them to others.

Synchronize: The menu used to control the Sync function in Lightroom. 
See sync.

Tags: Similar to keywords. See keywords.

Telephoto: Has a narrower field of view than the human eye. A telephoto lens
brings everything closer.

Template: Similar to a preset. It allows the repeating of an operation without
having to re-enter the information. See preset.

Thumbnail: A small representation of an image. It is usually grouped together
with a number of other similarly sized images so that a quick glance allows
you to look at a group of images. They can be shown on a computer monitor
or printed on a sheet of paper.

Thumbnail Badges: Small icons that are placed on the thumbnails to indi-
cate if various actions, such as development, have taken place yet.

TIFF: A file format, which is very commonly used. It takes up more space
than a JPEG image, but does not lose information when it is repeatedly
opened and resaved. Any image that will be worked on should be saved in the
TIFF format rather than JPEG. TIFF stands for Tagged Image File Format,
and images are identified by the .tif extension, as in sample.tif.

Appendix A ■ Glossary 241



Tone Curve: A tool in Lightroom that allows direct manipulation to change
the tones in an image. The curve can be moved by grabbing it with the cur-
sor or by hovering over it and using the sliders. See hovering.

Toolbar: Located under the main window in all of the Lightroom modules.
It contains various tools useful in that module and sometimes changes based
on other settings. It is toggled on and off with the T key.

Tungsten Light: A type of light, usually called incandescent light, which is a
continuous light rather than a flash. Typical room lights are tungsten, but not
fluorescent lights. The color temperature is warmer (more red) than an elec-
tronic flash or daylight, and compensation must be made for that.

Ultra-Wide Angle Lens: A very wide-angle lens, usually 24 mm or wider.
The photographer needs to be careful when using such a lens to keep his feet
out of the image.

Underexposure: Occurs when the image is too dark because not enough light
reached the sensor to create a proper exposure. Although some corrections
can be made, the resulting image will not be as good as if a proper exposure
were done in the beginning. Extra noise often ends up in the darker areas of
an image.

Unsharp Masking: See USM.

USB: Another technical specification for transferring data between digital
devices. It is slower than Firewire. USB2 is an updated and faster version 
available. USB is an abbreviation of Universal Serial Bus.

USM: An abbreviation for Unsharp Masking. Although it is called unsharp, it
is actually a technique used to increase the apparent sharpness of an image by
increasing the contrast of pixels next to each other. Programs such as
Photoshop have the ability to perform USM, but Lightroom does not cur-
rently offer USM.

Vibrance: Increases saturation in a non-linear way to avoid clipping saturated
colors and works mainly on less saturated colors. In Lightroom, it also avoids
working on skin tone colors. See saturation.

Vignetting: A darkening of an image near the edges. It can be done for artis-
tic effect. It also occurs due to light falloff on certain lenses.

Watched Folder: A folder that Lightroom will automatically import from if
images are placed into it. It is designed to be used with cameras that are teth-
ered to the computer so that, as each image is shot, it shows up in Lightroom
ready for adjustment.

WB: Stands for White Balance. See white balance.
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Web Gallery: A display of smaller images that can be clicked on to display
larger versions. It is designed to be uploaded to a Web site.

Web Module: The module in Lightroom that is used to create Web galleries.
See Web gallery.

White Balance: A control on digital cameras used to adjust how colors are
recorded on a camera so that white appears white. Most digital cameras have
settings like Auto, Tungsten, Daylight, and so on. It is also abbreviated WB.

Wide-Angle Lens: A lens that has a wider field of view than the human eye
or a “normal lens.”

Wide Gamut Color Space: A color space that allows a wide range of colors.
ProPhoto RGB is an example of a wide gamut color space. See ProPhoto RGB.

Window Light: The light illuminating an indoor scene, which comes through
a window. Normally, it is not direct sunlight, but a softer light from the sky
areas.

Windows Computers: Personal computers that run the Windows operating
system.

Workflow: Everything that is done to an image from the time it is created
until it is delivered in its final form.

XMP File: A small file designed to hold metadata so that the original file does
not have to be changed. It is created by computer software with the same
name as the original image file, except that the extension is changed to .xmp.

ZIP Compression: A type of compression used to make images or a group
of images smaller without having to throw out data. It is a non-lossy form of
compression.

Zoom: See zoom lens.

Zoom Lens: A camera lens with a variable focal length. It is probably the most
popular type of lens in use today. Nearly all digital cameras with nonremov-
able lenses have a zoom lens built-in.
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Here is a listing of books that will be useful to digital photographers. It is difficult
to recommend particular books because it depends on your taste in photography,
your skill and experience level, and where you want to go next. 

Adobe Photoshop CS 2
Adobe Photoshop CS 2.0: Photographer’s Guide. David D Busch; 2005, 
1-59200-725-2; Thomson Course Technology; $39.99.

Adobe Photoshop CS2 for Photographers: A Professional Image Editor’s Guide to 
the Creative Use of Photoshop for the Macintosh and PC. Martin Evening; 2005,
0-24051-984-1; Focal Press; $44.95.

Real World Camera Raw with Adobe Photoshop CS2. Bruce Fraser; 2005, 
0-32133-409-4; Peachpit Press; $39.99.

Adobe Photoshop CS
Adobe Photoshop CS: Photographer’s Guide. David D Busch; 2005, 
1-59200-172-6; Thomson Course Technology; $39.99.

B
Suggested Reading



Adobe Photoshop Elements 
Adobe Photoshop Elements 3.0: Photographer’s Guide. David D. Busch; 2005, 
1-59200-437-7; Thomson Course Technology; $39.99.

Digital Photo Processing: A Step-By-Step Guide to Creating Perfect Photos.
Chris Tarantino; 2003, 1-59200-106-8; Thomson Course Technology; $39.99.

Color Management
Color Management for Photographers: Hands-On Techniques for Photoshop Users.
Andrew Rodney; 2005, 0-24080-649-2; Focal Press; $44.95.

Digital Asset Management
The DAM Book: Digital Asset Management for Photographers. Peter Krogh; 2005,
0-59610-018-3; O’Reilly Media, $34.95.

Digital Photography
Mastering Digital Photography: The Serious Photographer’s Guide to High-Quality
Digital Photography. David D. Busch; 2005, 1-59863-017-2; Thomson Course
Technology; $39.99.

Mastering Digital SLR Photography: The Serious Photographer’s Guide to 
High-Quality Digital SLR Photography. David D Busch; 2004, 1-59200-605-1;
Thomson Course Technology; $39.99.

Digital Scanning
Mastering Digital Scanning: The Photographer’s and Artist’s Guide to Professional
Quality Digital Photography. David D. Busch; 2003, 1-59200-141-6; Thomson
Course Technology; $39.99.

Digital Printing
Mastering Digital Printing. Harald Johnson; 2005, 1-59200-431-8; Thomson
Course Technology; $39.99.
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C
Web Links

Following is a listing of Web sites that will be useful to users of Adobe Photoshop
Lightroom. Because of the speed of change on the Web, any of these sites may
have moved or been replaced with a newer site. Use a search engine to search for
the general topic if any of them are no longer available.

www.controlledvocabulary.com
This Web site has lots of information about setting up an image numbering 
system, keywording, setting up a controlled vocabulary system, and similar topics.
It also has links to a discussion group for those tough-to-answer questions on the
same topics. It is highly recommended for all digital photographers who have to
deal with metadata.

www.adobe.com/support/forums 
This is the main location for all of the forums for Adobe products. Simply look
for Lightroom in the list of Product forums. For the latest Web site address, in
case it has been changed, go to www.adobe.com and then click on Support >
Lightroom. You will have to register (free) to be able to post questions there.

www.adobe.com
www.controlledvocabulary.com
www.adobe.com/support/forums


www.adobe.com/cfusion/webforums/forum
While Lightroom was in a public beta, this was the location of the discussions that
went on. As long as Adobe maintains this site, it will make for interesting reading
about the development of many of the features in the current version of the pro-
gram. When you get to this site, look for Lightroom Beta. There were four dif-
ferent forums that began with that title. It is unknown how long Adobe will
maintain this site or if anything will be transferred over to the regular support site.
At the time of this writing, there were over 10,000 posts to these forums.

Podcasts via iTunes
To download podcasts about the development and usage of early versions of
Lightroom, launch iTunes (available free for both Macintosh and Windows com-
puters at www.appple.com), click on Podcasts, and do a search for “Lightroom.”
You can find other Lightroom podcasts besides the ones by Adobe personnel by
just searching for Lightroom in the iTunes Store.

www.adobe.com/products/photoshoplightroom/
There are several video tutorials and other information available on this site.

www.johngblair.com
This is the author’s Web site. Besides additional information about Lightroom, there
are links there to contact the author with suggestions, comments, and questions.

www.photoshopuser.com/Lightroom/index.html
This is the location of the National Association of Photoshop Professionals, and
it has lots of information about using Photoshop. It also has some video clips on
how to use Lightroom.

www.LightroomExtra.com
This is a British Web site that has lots of information and tips generated by a large
number of power Lightroom users.
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D
Keyboard Shortcuts

Use the following keyboard shortcuts to speed up your workflow. The following
figures are available from the Help menu for each Module. They are reproduced
here (and in each module’s chapter) so that you can keep the book open to these
pages rather than having to open the Help menu while you work.

Library shortcuts.
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Develop shortcuts.

Slideshow shortcuts.
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Print shortcuts.

Web shortcuts.





A
Add button, 165, 183
adding

borders, 200, 202–203
keywords, 102
numbering, 202–203
stacks, 121

Additional section
Date drop-down list, 80
EXIF list, 81

Adjusting Blacks, Histogram, 138
Adjusting Exposure, Histogram, 137
Adjusting Fill Light, Histogram, 138
Adjusting Highlight Recovery, Histogram, 137
AdobeRGB, selecting color spaces, 117
Antique Grayscale preset, 129
Appearance Panel, Web Module, 216–217
applying

keywords, 100
split toning, 157

arrows, Filmstrip, 68
assigning keywords, 100
Auto-Adjust function, 155
Auto button, 143
Auto Import, setting up, 85
Auto Import Settings dialog box, 41
auto-rotating images, 198
Auto-Stack dialog box, 122
Auto Sync button, 165–167

B
Backdrop Panel, 188–190
Background Color option, 189
Background Fill Color section, 40
Background Image option, 190
backgrounds, Overlay Texture, 40
backing up libraries, 35
basic development

Color mode, 141–148
Grayscale mode, 148

Basic Panel, 141
Beardsworth, John, 8
Before/After Views button, 167–169
beta releases, 7–11
bias, colors, 162–163
Bit Depth, selecting, 36
black-and-white images

Antique Grayscale preset, 129
creating, 110
Grayscale Mix section, 154–155
HSL/Color/Grayscale Panel, 151–153
split toning, 157

Blacks tool, 146
blues, Split Toning Panel, 156
Blue Sky template, 210
borders

adding, 200, 202–203
Options Panel, 183–185
printing, 196
Stroke Border option, 185

Bottom panel, 63

Index



Brightness tool, 147
Browser, renaming images, 14
buttons

Add, 165, 183
Auto, 143
Auto Sync, 165–167
Before/After views, 167–169
Choose, 76
Copy, 165–167
Loupe View, 167
panels, 164–176
Paste, 165–167
Play, 191
Preview, 191
Previous, 165–167
Remove, 165, 183
Reset, 165–167
Sync, 165–167
Sync Metadata, 112
Tone, 143
toolbars, 164–176

C
calibration, 162–163
captions, 180
capturing time, 49
casting shadows, 185
Cast Shadow option, 188
cells

Compact Cell Extras section, 56
expanding, 52
layouts, 216–217
printing, 196
Tint Grid Cells, 55
turning off numbers, 216–217

centimeters, selecting, 117
changes. See modifying
characters, replacing illegally named, 39
Charcoal template, 211
check boxes

Minimize Embedded Metadata, 117
Rating Stars, 187

Choose button, 76
chromatic aberrations, 160
Classic template, 211

clipping
highlighting, 139
preventing, 146
shadows, 138
values, 136

Clone tool, 174
cloning, 174–175
collections

Library Module, 73–74
navigating, 19
Quick Collection, 53, 69
virtual copies, creating, 120

Color Labels option, Tint Grid Cells, 55
Color mode, 141–148
Color Palette Panel, Web Module, 215–216
colors

Background Fill Color section, 40
Camera Calibration Panel, 162–163
Histogram, 136
HSL/Color/Grayscale Panel, 151–153
labels, 47, 176
reduce fringe, 160–161
space

selecting, 36, 117
specifying, 22

Color Space menu, 117
Color Wash option, 188
commercial photographer workflow, 30–31
Compact Cell Extras section, 56
Compact Cells, 52
Compare view, 89
comparing images, 88
compression, files, 21
Configure FTP File Transfer dialog box, 219
configuring

Auto Import, 85
collections, 19, 73–74
colors, 47
exporting functions, 43
Flash galleries, 210
folders, 18–19
Image Settings box, 21
keywords, 47
libraries, 17
previews, 38
Quick Collection, 69
slideshows, 118–120
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templates, 200–201
white balance, 142

contact sheets, printing, 196
Contrast tool, 147
converting raw images, 162
Copy button, 165–167
copying images, 119–120
Copy Photos as Digital Negative (DNG) and Import

option, 77
Copy Photos to a New Location and Import option,

77
Copyright section, 83
Copy Settings dialog box, 165
Courvoisier, Jerry, 9
Creator section, 83
crop marks, adding, 202
Crop Ratio menu, 110
Crop to Fill template, 181
Crop tool, 170
curves

Histogram, 136
modifying, 15
Tone Curve Panel, 149–151

customizing
preferences, 34–40
presets, 128
slideshows, 118
text, 20
titles, 218
toolbars, 50

Custom Settings menu, 193
Custom Text field, 81
Cyanotype preset, 132

D
darks, Tone Curve Panel, 149
dates, selecting tokens, 80
Default Library section, 34
Default template, 181
defining workflow, 13–15
Delete/Remove dialog box, 123
deleting

images, 123
presets, 133

design. See also configuring
collections, 19
defining, 13–15
folders, 18–19
multiple libraries, 17–18
non-destructive editing, 16–17
overview of Lightroom functionality, 16–22
raw format, 23–24
samples of, 24–31
saving/exporting images, 19–22

desktop layout, 33
Five Rules, 61
main window, 33
menus, 41–60
preferences, 34–40
Quick Collection, 69

Detail Panel, 157–159
detecting memory cards, 37
development

Color mode, 141–148
Grayscale mode, 148

Develop Module, 125
Camera Calibration Panel, 162–163
Color mode, 141–148
Detail Panel, 157–159
glyphs, 177
Grayscale Mix section, 154–155
Grayscale mode, 148
Histogram, 136–140
History Panel, 135–136
HSL/Color/Grayscale Panel, 151–153
keyboard shortcuts, 176
left panels, 64
Lens Corrections Panel, 160
Navigator Panel, 126–128
panel and toolbar buttons, 164–176
Presets Panel, 128–133
raw format, 23
reduce fringe, 160–161
right panels, 65
Snapshot Panel, 134
Split Toning Panel, 156–157
submenu, 48
Tone Curve Panel, 149–151
vignetting, 161–162

Develop Settings list, 82
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Develop Settings option, 42, 48
Digital Media Lab, 8
dimming levels, 40
Direct Positive preset, 130
disabling rating footers, 56
displays, Import Photos Preview, 85
DNG file format, 21
dragging keywords, 100
duplicating images, 119–120
Dusk template, 211

E
Earl Grey template, 211
Edit Capture Time dialog box, 49, 116
Edit Color Label Set dialog box, 48
editing

Identity Plate, 186
non-destructive, 16–17

Edit menu, 45
editorial photographer workflow, 30–31
effects, Vibrance slider, 147
Eismann, Katrin, 9
Enjoy, Five Rules, 61
enlarging images, 126
Evening, Martin, 9
EXIF data, naming files, 21
Exif Metadata template, 182, 211
Expanded Cells, 52
expanding

cells, 52
image stacks, 121

Export Actions folder, 22
Export dialog box, 43, 116
Export function, 20
exporting

files, selecting sounds to play, 35
functions, 43
images, 19–22

Library Module, 116–118
specifying, 22

slideshows, 191
Export Slideshow dialog box, 191
Export Templates, 20
exposure, modifying, 144
External Editors section, Preferences box, 35
Eyedropper tool, 142

F
fields, Custom Text, 81
File Handling menu, 77
File Management section, Preferences box, 37
File menu, 41
Filename Template Editor, 20
Filename Template Editor dialog box, 78
File Naming box, 20
File Naming section, 42
files

compression, 21
formats, 21

Raw, 23–24
selecting, 36, 117

naming, 39, 79
structure of, 13
XMP sidecars, 49

File Settings section, 43
FILL, Navigator window set to, 127
filling

Background Fill Color section, 40
Options Panel, 183–185
Zoom to Fill Frame box, 184

Fill Light tool, 145
Filmstrip

arrows, 68
filters, 107
Find Panel, applying, 106
Five Rules, 61, 66–68
sliders, 68
toolbars, 67

filters, Filmstrip, 107
Find function, Library Module, 103–107
Find Panel, 103
Fine Art Mat, printing, 197
FIT, enlargement box set to, 126
Five Rules, 61
flags, 47

Include Pick Flags option, 53
Pick Flag, 176
Reject Flag, 88, 176

Flash galleries
configuring, 210
templates, 211

Flourish, Panel Mark End setting, 40
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folders
Auto Import, 85
Export Actions, 22
Library Module, 72–73
navigating, 18–19
red folder titles, 84
structure of, 13
Watched, 41

footers, disabling rating, 56
formats (files), 21

raw, 23–24
selecting, 36, 117

frames, Options Panel, 183–185
fringe, reducing, 160–161
FTP servers, selecting, 219
functionality of Lightroom, 16–22
functions

Auto-Adjust function, 155
Export, 20
exporting, 43
Find, Library Module, 103–107
Noise Reduction, 158

G
galleries

Flash
configuring, 210
templates, 211

HTML templates, 212
Web, 5

Gallery Panel, Web Module, 214
General section, Preferences box, 34
glyphs, 177
gradients, modifying, 188
Graphical Identity Plate menu, 186
graph sliders, Tone Curve Panel, 151
Grayscale Conversion preset, 131
grayscale images

Antique Grayscale preset, 129
creating, 110
HSL/Color/Grayscale Panel, 151–153
split toning, 157

Grayscale Mix section, 154–155
Grayscale mode, 148

grids
Library Grid view, 50
Tint Grid Cells, 55

Grid view
Library Module, 86
thumbnails, 97
toolbars, 90, 95

Grid View Style submenu, 58
groups, processing images, 109–112
guides, Layout Panel, 185

H
Hamburg, Mark, 8
healing, 174–175
Heal tool, 175
Help menu, 60
highlighting

clipping, 139
hot highlights, images with, 144
images, importing, 76
Tone Curve Panel, 149

Histogram
Develop Module, 136–140
Panel, 109

History Panel, Develop Module, 135–136
Hollenberg, John, 9
hot highlights, images with, 144
hot spots, overexposure, 144
HSL/Color/Grayscale Panel, 151–153
HSL (Hue, Saturation, and Luminance), 151
HTML gallery template, 212
hue

HSL/Color/Grayscale Panel, 151–153
Split Toning Panel, 156

Hue, Saturation, and Luminance. See HSL
Hue Targeted Adjustments tool, 152

I
Ice Blue template, 212
Identity Plate

creating, 186
editing, 186, 202

Image Name section, 79
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images
auto-rotating, 198
collections, 19. See also collections
comparing, 88
Detail Panel, 157–159
enlarging, 126
exporting, 19–22
Exposure values, 144
grayscale, creating, 110
History Panel, 135–136
importing, 18
information, viewing, 52
keywords, applying, 100
Library Module

deleting, 123
exporting, 116–118
importing, 76–85

managing, 2
modifying, 15
naming, creating templates, 43
Options Panel, 183–185
Playback Panel, 190–193
Presets Panel, 128–133
previews, setting up, 38
printers, sending to, 204–206
Quick Collection, 69
Quick Develop Panel, 109–112
rating, 46
raw, converting, 162
Recovery slider, 144
renaming, 14
saving, 19–22
searching, 102–107
sizing, 117, 217
Snapshots Panel, 134
split toning, 157
stacks, 121–122
tools, 146. See also tools
viewing, 49
virtual copies, 119–120

Image Settings box, 21
Image Settings Panel

Print Module, 198–200
Web Module, 218

Image Settings section, 43

importing
Auto Import, 85
files, selecting sounds to play, 35
images, 18, 76–85

Import Photos at Their Current Location option, 77
Import Photos dialog box, 77, 81
Import Photos Preview display, 85
Import Sequence Numbers section, 39
inches, selecting, 117
Include Pick Flags option, 53
Include Thumbnail Badges option, 54
Info Overlay, Library Module, 113
information, viewing images, 52
Information section, 42
Information to Apply section, 81
Interface section, 39
Ivory template, 212

J
JPEG file format, 21

K
Kelvin temperature values, 142
keyboard shortcuts

Develop Module, 176
Library Module, 123
Print Module, 207
Slideshow Module, 193
Web Module, 219

Key Commands, Five Rules, 61
keywords, 84

adding, 102
applying, 100
configuring, 47
Library Module, 99–102
pasting, 101
searching, 103
stacks, 121

Keyword Set submenu, 48
Keyword Tags Panel, 99, 105
Krogh, Peter, 9
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L
labels

colors, 47, 176
stacks, 121

Labels Panel, Web Module, 214
Lang, Karl, 9
Layout Panel, 185, 200–201
layouts

cells, 216–217
desktop. See desktop layout

left arrows, Filmstrip, 68
lens vignetting, 161–162
Lens Corrections Panel, 160
levels, dimming, 40
libraries

backing up, 35
multiple, 17–18

Library Grid view, 50
Library left panels, 64
Library Loupe view, 50
Library menu, 45
Library Module, 8, 71

collections, 73–74
Find function, 103–107
folders, 72–73
Grid view, 86
images

deleting, 123
exporting, 116–118
importing, 76–85

Info Overlay, 113
keyboard shortcuts, 123
keywords, 99–102
managing, 71–75
metadata, 114–116
Navigator Panel, 92–94
Photo Binders, 118
Quick Collection, 74–75
Quick Develop Panel, 109–112
slideshows, 118–120
stacks, 121–122
toolbars, 95–98
views, 86–91, 108
virtual copies, 119–120

Library right panels, 64
Library View Options window, 51, 57

Lightroom
functionality, 16–22
menus, 34, 41
selecting, 1–5

lights, Tone Curve Panel, 149
Lights Out feature, 40, 60
Lights Out submenu, 60
lossless file compression, 21
Loupe Info 1 section, 58
Loupe Info submenu, 59
Loupe view, 57, 87

buttons, 167
Navigator Panel, 92
toolbars, 90, 95

luminance, 151–153. See also HSL
LZW file compression, 21

M
managing

File Management section, Preferences box, 37
images, 2
Library Module, 71–75

collections, 73–74
folders, 72–73
importing images, 76–85
Quick Collection, 74–75

markers, Quick Collection, 53
marketing, 5
maximizing panels, 63
memory cards, detecting, 37
menus

Auto-Stack, 122
Color Space, 117
Crop Ratio, 110
Custom Settings, 193
desktop layout, 41–60
Edit, 45
File, 41
File Handling, 77
Filmstrip, 67
Graphical Identity Plate, 186
Help, 60
Library, 45
Lightroom, 34, 41
Metadata, 48
Photo, 46
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menus (continued)
Point Curve presets, 151
Preset, 43, 79
Profile, 162
Rename Custom, 81
Set Flag, 47
Sort, 87
Sort By, 96
Start Ratings, 106
submenus, 45. See also submenus
Template, File Naming section, 78
Toolbar, 96
View, 49, 59
White Balance, 110, 143
Window, 59

metadata
Exif Metadata template, 182, 211
Library Module, 114–116
Minimize Embedded Metadata check box, 117
New Metadata Preset dialog box, 83
non-destructive editing, 16
options, 42
overview of, 111
preset templates, creating, 42
saving, 84
Sync Metadata button, 112
virtual copies, 119–120
XMP sidecars, 49

Metadata Browser Panel, 107
Metadata list, 83
Metadata menu, 48
Metadata section, File Management box, 38
Midnight template, 212
Minimize Embedded Metadata check box, 117
minimizing panels, 63
modes

Color, 141–148
Grayscale, 148

modifying
Auto-Adjust function, 155
backgrounds, 189
colors, 188
exposure, 144
images, 15, 129
printing, 198–200
Tone Curve Panel, 149
undoing changes, 17
values, 143

Module Picker
Five Rules, 61, 62
Library Module, 71–75

modules
Develop Module, 125

Camera Calibration Panel, 162–163
Color mode, 141–148
Detail Panel, 157–159
glyphs, 177
Grayscale Mix section, 154–155
Grayscale mode, 148
Histogram, 136–140
History Panel, 135–136
HSL/Color/Grayscale Panel, 151–153
keyboard shortcuts, 176
Lens Corrections Panel, 160
Navigator Panel, 126–128
panel and toolbar buttons, 164–176
Presets Panel, 128–133
raw format, 23
reduce fringe, 160–161
Snapshot Panel, 134
Split Toning Panel, 156–157
Tone Curve Panel, 149–151
vignetting, 161–162

Filmstrip, 66–68
Library Module, 8, 71

collections, 73–74
deleting images, 123
exporting images, 116–118
Find function, 103–107
folders, 72–73
Grid view, 86
importing images, 76–85
Info Overlay, 113
keyboard shortcuts, 123
keywords, 99–102
managing, 71–75
metadata, 114–116
Navigator Panel, 92–94
Photo Binders, 118
Quick Collection, 74–75
Quick Develop Panel, 109–112
slideshows, 118–120
stacks, 121–122
toolbars, 95–98
views, 86–91, 108
virtual copies, 119–120

Adobe Photoshop Lightroom: Photographers’ Guide264



Print Module, 195
Image Settings Panel, 198–200
keyboard shortcuts, 207
Layout Panel, 200–201
Overlays Panel, 202–203
Preview Panel, 195
Print Job Panel, 204–206
Template Browser, 196–198

Slideshow Module, 179
Backdrop Panel, 188–190
keyboard shortcuts, 193
Layout Panel, 185
Options Panel, 183–185
Overlays Panel, 186–188
Playback Panel, 190–193
Template Browser Panel, 180–183

Web Module, 209
Appearance Panel, 216–217
Color Palette Panel, 215–216
Gallery Panel, 214
Image Settings Panel, 218
keyboard shortcuts, 219
Labels Panel, 214
Output Panel, 219
Output Settings Panel, 217
Preview Panel, 210
Template Browser Panel, 210–213

monitors, viewing multiple, 190
Mossy Rock template, 212
Mouse Over Only option, 54
Move Photos to New Location and Import option, 77
moving

auto-rotating images, 198
images, 19–22

exporting, 116–118
importing, 86–85

keywords, 100
slideshows, 191

multiple libraries, 17–18
multiple monitors, viewing, 190

N
Nagel, Kyoe, 8–9
naming

characters, replacing illegally named, 39
files, replacing spaces, 39

Image Name section, 79
images, creating templates, 43
libraries, 17
presets, 133
snapshots, 134

navigating
collections, 19
folders, 18–19
images, saving/exporting, 19–22

Navigator Panel
Develop Module, 126–128
Library Module, 92–94
windows, 127

New Develop Preset dialog box, 128, 133
New Metadata Preset dialog box, 83
Night Life template, 212
Noise Reduction section, 158
non-destructive editing, 16–17
numbering

adding, 202–203
section tokens, 80

O
Open window, 76
options

Background Color, 189
Background Image, 190
Cast Shadow, 188
Color Labels, Tint Grid Cells, 55
Color Wash, 188
Develop Settings, 42, 48
File Handling menu, 77
Include Pick Flags, 53
Include Thumbnail Badges, 54
libraries, backing up, 35
Library View Options window, 57
Loupe Info 1 section, 58
metadata, 42
Mouse Over Only, 54
Paste Settings from Previous, 111
Show Info Overlay, 58
Show Rating Footer, 56
slideshows, 118
Stroke Border, 185
views, Library Module, 108
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Options Panel, 183–185
organizing. See managing
Output Panel, Web Module, 219
Output Settings Panel, Web Module, 217
overexposure, hot spots, 144
Overlays Panel, Print Module, 202–203
Overlay Texture, backgrounds, 40

P
page information, adding, 202
Panel End Mark setting, 40
panels

Appearance Panel, 216–217
Backdrop Panel, 188–190
Basic Panel, 141
Bottom, 63
buttons, 164–176
Camera Calibration Panel, 162–163
Color Palette Panel, 215–216
Detail Panel, 157–159
Develop left, 64
Develop right, 65
Find Panel, 103
Five Rules, 61, 62–66
Gallery Panel, 214
Histogram, 136–140
Histogram Panel, 109
History Panel, 135–136
HSL/Color/Grayscale Panel, 151–153
Image Settings Panel, 198–200, 218
Keyword Tags Panel, 99
Labels Panel, 214
Layout Panel, 185, 200–201
Lens Corrections Panel, 160
Library left, 64
Library right, 64
Metadata Browser Panel, 107
Navigator Panel

Develop Module, 126–128
Library Module, 92–94
windows, 127

Output Panel, 219
Output Settings Panel, 217
Overlays Panel, 186–188, 202–203
Playback Panel, 190–193

Presets Panel, 128–133
Preview Panel, 195, 210
Print Job Panel, 204–206
Print left, 65
Print right, 66
Quick Develop Panel, 109–112
Slideshow left, 65
Slideshow right, 65
Snapshot Panel, 134
Split Toning Panel, 156–157
Template Browser Panel, 180–183, 210–213
Tone Curve Panel

Develop Module, 149–151
Grayscale Mix, 155

Top, 62
Web left, 66
Web right, 66

Panels submenu, 59
Paper White template, 213
Paste button, 165–167
Paste Settings from Previous option, 111
pasting keywords, 101
Peluce, Meeno, 9
Photo Binders, Library Module, 118
Photo menu, 46
Pick Flag, 176
Picks, selecting, 46
pixels

non-destructive editing, 16
sizing, 117

PixelToy, 8
Playback Panel, 190–193
Play button, 191
Point Curve presets menu, 151
portrait photographer workflow, 27–29
Post-Processing section, 22, 43
preferences, desktop layout, 34–40
Preset menu, 43, 79
presets

Antique Grayscale, 128
creating, 132
Cyanotype, 132
Direct Positive, 130
Grayscale Conversion, 131
naming, 133
Point Curve presets menu, 151
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Sepia Tone, 131
templates, creating metadata, 42
Tone Curve-Lightroom Default, 131
Tone Curve-Linear Contrast, 131
Tone Curve-Medium Contrast, 131
Tone Curve-Strong Contrast, 131

Presets Panel, Develop Module, 128–133
preventing clipping, 146
Preview button, 191
Preview Panel

Print Module, 195
Web Module, 210

previews
configuring, 38
sizing, 84
Snapshot Panels, 134

Previous button, 165–167
printing

contact sheets, 196
Fine Art Mat, 197

Print Job Panel, 204–206
Print left panels, 65
Print Module, 195

Image Settings Panel, 198–200
keyboard shortcuts, 207
Layout Panel, 200–201
Overlays Panel, 202–203
Preview Panel, 195
Print Job Panel, 204–206
Template Browser, 196–198

Print right panels, 66
processes, 14–15. See also workflow
processing groups of images, 109–112
Profile menu, 162
profiles, selecting, 204
promotion, 5
ProPhoto RGB, selecting color spaces, 117
PSD file format, 21, 36

Q
Quick Collection, 69

Library Module, 74–75
markers, 53

Quick Develop Panel, Library Module, 109–112

R
ratings

images, 46
Show Rating Footer option, 56
stars, 176
Start Ratings menu, 106
Template Browser Panel, 180

Rating Stars check box, 187
raw file format, 23–24

converting, 162
XML sidecars, 49

Recovery slider, 144
red, green, and blue. See RGB
Redefine dialog box, 46
Red Eye tool, 173–174
red folder titles, 84
Red Primary Saturation, reducing, 163
Red slider, Luminance section, 153
reducing

fringe, 160–161
Red Primary Saturation, 163

Reject Flag, 88, 176
Remove button, 165, 183
Remove Spots tool, 174–175
Rename Custom menu, 81
renaming images, 14
repeating one photo per page, printing, 198–199
replacing spaces, 39
Reset button, 165–167
Resnick, Seth, 9
Restore Factory Defaults confirmation message, 133
restoring presets, 133
RGB (red, green, and blue)

HSL, 151
values, 142

right arrows, Filmstrip, 68
Rodney, Andrew, 9
Rose, Bob, 9
rotating, auto-rotating images, 198
rough images, Detail Panel, 157–159
Rows and Column section, 216–217
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S
saturation

HSL/Color/Grayscale Panel, 151–153
Red Primary Saturation, 163
Split Toning Panel, 156

Saturation slider, 147–148
saving

images, 19–22
History Panel, 135–136
importing, 18

libraries, 35
metadata, 84
snapshots, 134

Schewe, Jeff, 9
Screen Mode submenu, 60
searching

filters, 107
Library Module, 103–107

selecting
Bit Depth, 36
color space, 36
file formats, 36, 117
FTP servers, 219
images

Filmstrip, 66–68
importing, 76

Lightroom, 1–5
Picks, 46
profiles, 204
sounds, 35

sending images to printers, 204–206
Sepia Tone preset, 131
Set Color Label submenu, 47
Set Flag menu, 47
Set Keyword submenu, 47
Set Rating submenu, 46
setting up. See also configuring

Auto Import, 85
collections, 19, 73–74
exporting functions, 43
Flash galleries, 210
folders, 18–19
Image Settings box, 21
libraries, 17
presets, 132
previews, 38

Quick Collection, 69
slideshows, 118–120, 180–183
snapshots, 134
templates, 200–201
Watched folders, 41
white balance, 142

shadows
casting, 185
clipping, 138
Fill Light tool, 145
Options Panel, 183–185
Split Toning Panel, 156
Tone Curve Panel, 149

sharpening, Detail Panel, 157–159
Shoots. See folders
shortcuts

Develop Module, 176
Library Module, 123
Print Module, 207
Slideshow Module, 193
Web Module, 219

Show Clickable Items on Mouse Over Only option, 54
Show Info Overlay option, 58
Show Rating Footer option, 56
sizing

images, 117, 217
panels, 63
previews, 84
thumbnails, 98

sliders. See also tools
Blacks tool, 146
changes, undoing, 17
Filmstrip, 68
graphs, Tone Curve Panel, 151
Recovery, 144
Saturation, 147–148
Vibrance, 147–148
white balance, configuring, 142
Zoom, 89

Slideshow Module, 179
Backdrop Panel, 188–190
keyboard shortcuts, 193
Layout Panel, 185
left panel, 65
Options Panel, 183–185
Overlays Panel, 186–188
Playback Panel, 190–193
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right panel, 65
Template Browser Panel, 180–183
templates, 213

slideshows
exporting, 191
Library Module, 118–120

smoothing, Detail Panel, 157–159
Snapshot Panel, Develop Module, 134
Sort By menu, 96
Sort Direction tool tips, 96
Sort menu, 87
Sort submenu, 51
sounds, selecting, 35
space

colors
selecting, 36, 117
specifying, 22

replacing, 39
specifying color space, 22
Spelling submenu, 45
Split Toning Panel, 156–157
stacks

Auto-Stack dialog box, 122
Library Module, 121–122

stars
ratings, 176
Rating Stars check box, 187

Start Ratings menu, 106
Steinmueller, Uwe, 9
stock photographer workflow, 29–30
Stoka, Dan, 9
Straighten tool, 170–173
Stroke Border option, 185
structure of files, 13
submenus

Develop, 48
Grid View Style, 58
Keyword Set, 48
Lights Out, 60
Loupe Info, 59
Panels, 59
Screen Mode, 60
Set Color Label, 47
Set Keyword, 47
Set Rating, 46
Sort, 51
Spelling, 45
Toolbar, 50

Sync button, 165–167
Synchronize Metadata dialog box, 112
Synchronize Settings dialog box, 111, 166
Sync Metadata button, 112

T
tags, 84. See also keywords

Keyword Tags Panel, 99
searching, 105

Tapes, Michael, 8
Targeted Adjustment tool, 150, 155
Temperature slider, white balance, 142
temperature values, 142
Template Browser, 180–183

Preview Panel, 195
Print Module, 196–198
Web Module, 210–213

Template menu, File Naming section, 78
templates

The Blues, 213
Blue Sky, 210
Charcoal, 211
Classic, 211
creating, 200–201
Crop to Fill, 181
Default, 181
Dusk, 211
Earl Grey, 211
Exif Metadata, 182, 211
Export Templates, 20
Filename Template Editor, 20, 78
Flash gallery, 211
HTML gallery, 212
Ice Blue, 212
Ivory, 212
metadata, creating, 42
Midnight, 212
Mossy Rock, 212
Night Life, 212
Paper White, 213
Slideshow, 213
Warm Day, 213

text
titles, 218
tokens, 20
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Text Overlays section, 188
Text Template Editor dialog box, 182, 203
textures, Overlay Texture backgrounds, 40
The Blues template, 213
Thumbnail Badges, 54
thumbnails

Grid view, 97
Navigator Panel, 126. See also Navigator Panel
sizing, 98
viewing, 57

TIFF file format, 21, 36
time, capturing, 49
Tint Grid Cells, 55
Tint slider, white balance, 142
titles

creating, 214
customizing, 218
red folder, 84

tokens, 20, 78
dates, selecting, 80
numbering, 80

Tone button, 143
Tone Curve-Lightroom Default preset, 131
Tone Curve-Linear Contrast preset, 131
Tone Curve-Medium Contrast preset, 131
Tone Curve Panel

Develop Module, 149–151
Grayscale Mix, 155

Tone Curve-Strong Contrast preset, 131
toning, Split Toning Panel, 156
Toolbar menu, 96
toolbars

buttons, 164–176
customizing, 50
Filmstrip, 67
Grid view, 90
Library Grid view, 50
Library Loupe view, 50
Library Module, 95–98
Loupe view, 90
Playback Panel, 192–193

Toolbar submenu, 50
tools, 2

Auto button, 143
Blacks, 146
Brightness, 147
Clone, 174

Color mode, 141
Eyedropper, 142
White Balance, 141–142

Contrast, 147
Crop, 170
Fill Light, 145
Heal, 175
Hue Targeted Adjustments, 152
Red Eye, 173–174
Remove Spots, 174–175
Straighten, 170–173
Targeted Adjustment, 150, 155
Tone button, 143

Top panel, 62
troubleshooting, Help menu, 60
Tweaks section, 40

U–V
undoing changes, 17

values
clipping, 136
Exposure, 144
Kelvin temperature, 142
RGB (red, green, and blue), 142
Tone button, 143
Tone Curve Panel, 150

versions, 7–11, 119–120
Vibrance slider, 147–148
viewing

images, 49
information, 52
Quick Develop Panel, 109–112

main window, 33
Playback Panel, 190–193
preferences, 34–40
thumbnails, 57
widescreen monitors, 182

View menu, 49, 59
View Options window, 51
views

Compare, 89
Grid

Library Module, 86
thumbnails, 97
toolbars, 90, 95
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Library Grid, 50
Library Loupe, 50
Library Module, 86–91, 108
Library View Options window, 57
Loupe, 87

Navigator Panel, 92
toolbars, 90, 95

Loupe View, 57
vignetting, 160, 161–162
virtual copies, Library Module, 119–120

W
Warm Day template, 213
Watched folders, setting up, 41
Web galleries, 5
Web left panels, 66
Web Module, 209

Appearance Panel, 216–217
Colors Palette Panel, 215–216
Gallery Panel, 214
Image Settings Panel, 218
keyboard shortcuts, 219
Labels Panel, 214
Output Panel, 219
Output Settings Panel, 217
Preview Panel, 210
Template Browser Panel, 210–213

Web right panels, 66
Web sites, 5
wedding photographer workflow, 25–27
white balance, configuring, 142
White Balance menu, 110, 143
White Balance tool, 141–142
wide images, printing, 196
widescreen monitors, 182
Window menu, 59
windows

Library View Options, 51, 57
main, 33
Navigator Panel, 127
Open, 76
View Options, 51

workflow
design

collections, 19
defining, 13–15
folders, 18–19
multiple libraries, 17–18
non-destructive editing, 16–17
overview of Lightroom functionality, 16–22
raw format, 23–24
samples of, 24–31
saving/exporting images, 19–22

overview of, 7
steps in, 16

X–Z
XMP sidecars, 49

Zoom slider, 89
Zoom to Fill Frame box, 184
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